Legal notices

The information contained in this document is subject to change without notice. The only warranties for HP products and services are set forth in the express warranty statements accompanying such products and services. Nothing contained in other sections different from the express warranty should be construed as constituting an additional warranty. HP shall not be liable for technical and editorial errors or omissions contained herein.

Trademarks

Adobe®, Acrobat®, Adobe Photoshop®, and PostScript® are trademarks of Adobe Systems Incorporated.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

PANTONE® is Pantone, Inc.'s check-standard trademark for color.
# Table of contents

## 1 Introduction
- Safety precautions ......................................................... 2
- Product models ................................................................. 2
- Use of this guide ............................................................... 3
- The printer’s main features ................................................. 4
- The printer’s main components ......................................... 4
- The Embedded Web Server’s main components ............... 10
- The HP Utility’s main features .......................................... 10
- The printer’s internal prints .............................................. 11
- Turn the printer on and off ............................................... 11

## 2 Connectivity and software instructions
- Choose which connection method to use ......................... 14
- Connect to a network (Windows) ................................. 14
- Connect directly to a computer (Windows) .................... 15
- Uninstall the printer driver (Windows) ......................... 15
- Connect to a network (Mac OS) ................................. 15
- Connect directly to a computer (Mac OS) .................... 18
- Uninstall the printer software (Mac OS) ...................... 20

## 3 Personalize the printer
- Change the language of the front-panel display ............. 23
- Access the Embedded Web Server ................................. 23
- Change the language of the Embedded Web Server ...... 23
- Access the HP Utility ...................................................... 24
- Change the language of the HP Utility ......................... 24
- Change the sleep mode setting ....................................... 24
- Turn the buzzer on and off ............................................ 24
- Change the front-panel display contrast ....................... 25
- Change the units of measurement ............................... 25
- Configure network settings .......................................... 25
- Change the graphic language setting ......................... 26
- Personalize the list of paper types ............................... 27
- Select paper mismatch action ..................................... 28

## 4 Handle the paper
- Overview .......................................................................... 30
Load a roll onto the spindle ................................................................. 33
Load a roll into the printer ................................................................. 36
Unload a roll from the printer ........................................................... 37
Use the take-up reel ........................................................................... 37
View information about the paper .................................................... 46
Perform paper advance calibration .................................................. 46
Download paper presets .................................................................. 47
Use non-HP paper ............................................................................. 48
Cancel the drying time ...................................................................... 49
Change the drying time ..................................................................... 49
Printing paper info ........................................................................... 49
Feed and cut the paper ...................................................................... 50
Store the paper ................................................................................ 50
Order paper ..................................................................................... 50

5 Handle the ink system .................................................................... 57
  Ink system components ................................................................. 58
  Ink system tips ............................................................................. 60
  Work with ink system components ................................................. 60
  Order ink supplies ........................................................................ 78

6 Print options .................................................................................. 80
  Create a print job ........................................................................... 81
  Select print quality ........................................................................ 82
  Print a draft .................................................................................. 83
  High-quality printing .................................................................... 84
  Select paper size ........................................................................... 84
  Select margins options ................................................................. 85
  Print on loaded paper .................................................................... 85
  Rescale a print .............................................................................. 86
  Preview a print ............................................................................. 87
  Print 16-bit color images ............................................................... 88
  Change the treatment of overlapping lines ..................................... 88
  Print crop lines ........................................................................... 89
  Rotate an image ........................................................................... 89
  Print in gray shades ..................................................................... 91
  Use paper economically ............................................................... 91
  Nest jobs to save paper ............................................................... 92
  Use ink economically ................................................................... 93

7 Color management ....................................................................... 94
  What is color? ............................................................................. 95
  The problem: color in the computer world ..................................... 95
  The solution: color management ................................................... 97
  Color and your printer .................................................................. 99
  A summary of the color-management process ............................. 100
13 Troubleshoot print-quality issues ................................................................. 144
   General advice ................................................................................................. 145
   Troubleshooting tools ...................................................................................... 145
   Lines are too thick, too thin, or missing ............................................................... 146
   Lines appear stepped or jagged ......................................................................... 147
   Parts of lines or text are missing ....................................................................... 147
   Lines are printed double or in the wrong colors ............................................... 148
   Lines are blurred (ink bleeds from lines) .......................................................... 148
   Lines are slightly warped .................................................................................. 149
   Dark or light horizontal lines across the image (banding) ............................... 149
   The image is grainy ........................................................................................... 150
   The image has a metallic hue (bronzling) .......................................................... 150
   The printed output is not flat ............................................................................ 151
   The print smudges when touched .................................................................... 151
   Ink marks appear on the paper ......................................................................... 151
   Defects near the top of a print ......................................................................... 152
   Colors are inaccurate ....................................................................................... 153
   The output is completely blank ....................................................................... 155
   The output contains only a partial print ........................................................... 155
   The image is clipped ....................................................................................... 156
   The image is in one portion of the printing area ................................................. 156
   The image is unexpectedly rotated .................................................................... 157
   The print is a mirror image of the original ....................................................... 157
   The print is distorted or unintelligible ............................................................. 157
   One image overlays another on the same print .............................................. 157
   Pen settings seem to have no effect ............................................................... 157
   The image has a wood-grain appearance (aeroworms) ................................... 158

14 Troubleshoot paper issues ............................................................................ 159
   The paper cannot be loaded successfully ....................................................... 160
   The paper has jammed ..................................................................................... 160
   Prints do not stack correctly in the bin ............................................................. 162
   Automatic paper-cutter does not function ....................................................... 162
   Take-up reel paper jammed ............................................................................. 162
   Take-up reel does not wind ............................................................................. 162

15 Troubleshoot ink-system issues .................................................................. 164
   Cannot insert an ink cartridge ......................................................................... 165
   Cannot insert a printhead ................................................................................ 165
   Cannot insert the maintenance cartridge ...................................................... 165
   Front panel recommends reseating or replacing a printhead ....................... 165
   Clean the printheads ...................................................................................... 165
   Align the printheads ...................................................................................... 166
1 Introduction

- Safety precautions
- Product models
- Use of this guide
- The printer’s main features
- The printer’s main components
- The Embedded Web Server’s main components
- The HP Utility’s main features
- The printer’s internal prints
- Turn the printer on and off
Safety precautions

The following precautions ensure the correct use of the printer and prevent printer damage. Use these precautions at all times.

- Use the power supply voltage that is specified on the nameplate. To avoid overloading the printer’s electrical outlet, do not use the outlet for multiple devices.
- Make sure that the printer is well-grounded. Failure to ground the printer can result in electrical shock, fire, and susceptibility to electromagnetic interference.
- Do not disassemble or repair the printer yourself, unless authorized by HP (see Customer Self Repair on page 179). Contact your local HP Service Representative for service. See HP Customer Care on page 176.
- Use only the electrical cord that HP supplied with the printer. Do not damage, cut, or repair the power cord. A damaged power cord creates a risk of fire and electric shock. Replace a damaged power cord with an HP-approved power cord.
- Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of the printer. Doing so can cause fire, electric shock, or other serious hazards.
- Turn off the printer and unplug the power cable from the power outlet in any of the following cases:
  - When you place your hands inside the printer
  - If smoke or an unusual smell emanates from the printer
  - If the printer is making an unusual noise that does not occur during normal operation
  - If a piece of metal or a liquid (not part of cleaning and maintenance routines) touches internal parts of the printer
  - During an electrical (thunder or lightning) storm
  - During a power failure

Product models

This guide covers the following product models, normally referring to them by their short names for brevity.

<table>
<thead>
<tr>
<th>Full name</th>
<th>Short name</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Designjet Z6200 1067-mm (42-in) Photo</td>
<td>Z6200 1.1m</td>
<td>CQ109A</td>
</tr>
<tr>
<td>HP Designjet Z6200 1524-mm (60-in) Photo</td>
<td>Z6200 1.5m</td>
<td>CQ111A</td>
</tr>
<tr>
<td>HP Designjet Z6200 1067-mm (42-in) Photo with PostScript/PDF upgrade</td>
<td>Z6200ps 1.1m</td>
<td>CQ109A + CQ744A/CQ745A</td>
</tr>
<tr>
<td>HP Designjet Z6200 1524-mm (60-in) Photo with PostScript/PDF upgrade</td>
<td>Z6200ps 1.5m</td>
<td>CQ111A + CQ744A/CQ745A</td>
</tr>
</tbody>
</table>
Use of this guide

The HP Start-up Kit DVD is the most complete source of information about this product and is organized into the following chapters.

Introduction

This chapter provides a brief introduction to the printer and its documentation for new users.

Use and maintenance

These chapters help you carry out normal printer procedures and include the following topics:

- Connectivity and software instructions on page 13
- Personalize the printer on page 22
- Handle the paper on page 29
- Handle the ink system on page 57
- Print options on page 80
- Color management on page 94
- Practical printing examples on page 120
- Maintain the printer on page 132

Troubleshooting

These chapters help you solve problems that might occur while printing and include the following topics:

- Troubleshoot print-quality issues on page 144
- Troubleshoot ink-system issues on page 164
- Troubleshoot paper issues on page 159
- Troubleshoot other issues on page 169
- Front-panel error messages on page 199

Support and specifications

These chapters contain reference information, including HP customer care and the specifications of the printer:

- HP Customer Care on page 176
- Printer specifications on page 203

Appendices

The appendices highlight some of the more common printing scenarios you might face as a user. Each appendix takes a step-by-step approach to working through a given printing scenario, and points you to various parts of this guide that provide more task-specific information and instruction.
Glossary

This chapter contains definitions of printing and HP terms that are used in this documentation.

Index

In addition to the table of contents, an alphabetical index is included to help you to find topics quickly.

Warnings and Cautions

Symbols are used in this manual to ensure the proper use of the printer and to prevent printer damage. Follow the instructions that are marked with these symbols.

⚠️ WARNING! Failure to follow the guidelines that are marked with this symbol could result in serious personal injury or death.

⚠️ CAUTION: Failure to follow the guidelines that are marked with this symbol could result in minor personal injury or damage to the product.

The printer’s main features

Some major features of the printer are shown below:

- Fast, high-quality printing with a resolution of up to 2400 × 1200 optimized dots per inch (dpi), from a 1200 × 1200 dpi input (using the Max. resolution for photo papers option)

- Maximum paper width of 1067 mm (42 in) or 1524 mm (60 in)

- Take-up reel supplied with the 1.5m printer, available as an accessory for the 1.1m printer

- Accurate and consistent color reproduction features:
  - Press emulations for U.S., European, and Japanese standards; and color-monitor red-green-blue (RGB) emulations
  - Automatic color calibration and profiling

- An eight-ink system that provides a wide color range on matte fine-art papers and glossy photo papers for photographic and graphic arts prints. The ink system also offers complete coverage of International Organization for Standards (ISO) and Specifications for Web Offset Publications (SWOP) gamuts for color accuracy in pre-press applications.

- An HP Embedded Spectrophotometer for consistent and accurate color, even with paper and environment changes, and easy creation of custom International Color Consortium (ICC) profiles (see HP Embedded Spectrophotometer on page 99)

- Ink and paper usage information that is available from the Web through the Embedded Web Server (see The Embedded Web Server’s main components on page 10)

- Paper flexibility and automatic easy load, including information and paper presets that are available on the front panel, or through the HP Utility

The printer’s main components

The following views illustrate the main components of the Z6200 1.1m and 1.5m Printers.
1. Ink cartridge
2. Platen
3. Printhead
4. Printhead carriage
5. Front panel
6. Maintenance cartridge
7. Paper-load lever
8. Spindle
9. Bin
Rear view 1.1m printer

1. Power switch and socket
2. Sockets for communication cables and optional accessories

Front view 1.5m printer

1. Ink cartridge
2. Platen
3. Printhead
4. Printhead carriage
5. Front panel
6. Maintenance cartridge
7. Paper-load lever
8. Spindle
9. Loading table
10. Take-up reel motor
11. Take-up reel cable and sensor housing unit
12. Take-up reel sensor
13. Take-up reel spindle hub

**Rear view 1.5m printer**

1. Power switch and socket
2. Sockets for communication cables and optional accessories

**Take-up reel motor**

*NOTE:* The take-up reel is a standard feature with the Z6200 1.5m printer. It is an optional accessory for the Z6200 1.1m printer. See [Accessories on page 143](#).
1. Take-up reel spindle lever
2. Manual winding buttons
3. Wind-direction switch

The front panel

Your printer’s front panel is located on the front of the printer, on the right-hand side. It has the following important functions:

- It is used to perform certain operations, such as loading and unloading paper
- It displays up-to-date information about the status of the printer, the ink cartridges, the printheads, the maintenance cartridge, the paper, the print jobs, and other parts and processes
- It gives guidance on using the printer
- It displays warning and error messages, when appropriate, with audible alerts to call attention
- It can be used to change the values of printer settings and the operation of the printer

**NOTE:** Settings in the Embedded Web Server or in the printer driver override front-panel settings.

The front panel has the following components, starting with the four direct-access keys:

1. **Paper loading** key starts the paper loading process: see [Load a roll into the printer on page 36](#).
2. **View paper information** key displays information about the loaded paper.
3. **Pause printing** key pauses printing after finishing the current page. Press the key again to restart printing. This can be useful, for instance, when you want to change or load a roll of a different paper type.

4. **Form feed and cut** key: see Feed and cut the paper on page 50.

5. **Front-panel display** displays errors, warnings and information on using your printer.

6. **Back** key: To go to the previous step in a procedure or interaction. To go to the upper level, or leave the option in the menu, or when given an option.

7. **Menu** key: Press to return to the main menu of the front-panel display. If you are already on the main menu it will display the status screen.

8. **Down** key: To go down in a menu or option, or to decrease a value, for example when configuring the front-panel display contrast or the IP address.

9. **Power** key: To turn the printer off or on, it also has a light to indicate the printer’s status. If the power key light is off the printer is off. If the power key light is blinking green, the printer is starting up. If the power key light is green on, the printer is on. If the power key light is amber on, the printer is in standby. If the power key light is blinking amber, the printer needs attention.

10. **Cancel** key: To abort a procedure or interaction.

11. **Up** key: To go up in a menu or option, or to increase a value, for example when configuring the front-panel display contrast or the IP address.

12. **OK** key: To confirm an action while in a procedure or interaction. To enter in a submenu in the menu. To select a value when given an option. If the status screen is displayed, this key takes you to the main menu.

13. **Status** light: Indicates the printer’s status. If the Status light is solid green, the printer is ready. If it is flashing green, the printer is busy. If it is solid amber, there is a system error. If it is flashing amber, the printer needs attention.

To **highlight** an item in the front-panel display, press the Up or Down key until the item is highlighted.

To **select** an item in the front-panel display, first highlight it and then press the OK key.

When this guide shows a series of front-panel display items like this: Item1 > Item2 > Item3, it means that you should select Item1, then select Item2, then select Item3.

For detailed information on the front-panel menus, see Front-panel menus on page 189.

For an annotated list of front-panel error messages, see Front-panel error messages on page 199.

Information about specific uses of the front panel can be found throughout this guide.

**Printer software**

The following software is provided with your printer:

- HP-GL/2 and HP RTL printer driver for Windows operating systems
- The Embedded Web Server, which runs in the printer and enables you to use a Web browser on any computer to check ink levels and printer status (see The Embedded Web Server’s main components on page 10)
- The HP Utility (see The HP Utility’s main features on page 10)
PostScript drivers for Windows and Mac OS are provided with the PostScript/PDF Upgrade Kit (see Accessories on page 143).

**The Embedded Web Server’s main components**

The Embedded Web Server is a Web server running inside the printer. Users can obtain printer information, manage the print queue and paper presets, change printer settings and troubleshoot problems through the Embedded Web Server. It also allows service engineers to retrieve internal information on printer problems.

Access the Embedded Web Server remotely by using an ordinary Web browser running on any computer (see Access the Embedded Web Server on page 23). Its features and functionality are organized within three tabs. Online help is available on every page.

**Main tab**

- Manage the print queue
- Add new jobs to the queue
- View supplies status
- Monitor paper and ink usage
- PANTONE©* emulation (with the PostScript/PDF upgrade)

**Setup tab**

- Define printer, network and security settings
- Send accounting reports and notifications of warnings and errors by e-mail
- Update firmware
- Import and export paper presets
- Set the date and time

**Support tab**

- Use the Print Quality Troubleshooting wizard to help resolve some of the most common print-quality issues
- Browse helpful information from a variety of sources
- Access HP Designjet links for technical support with your printer, driver and accessories
- Access service support pages that show current and historical data on the usage of your printer

**The HP Utility’s main features**

The HP Utility provides an easy-to-use interface that allows the user to manage and access various printer features and functionality.

- Manage the printer, including single-point color control with the HP Color Center
- Gain access to the online HP Knowledge Center
- View the status of the ink cartridges, the printheads and the paper
- Manage, install, and create International Color Consortium (ICC) profiles (with the PostScript/PDF upgrade)
- Access and use embedded profiles (with the PostScript/PDF upgrade)
- Update the printer’s firmware (see Update the printer firmware on page 138)
- Calibrate the printer and display
- Change various printer settings (on the Settings tab)
- Configure network settings

The printer’s internal prints

The internal prints provide various kinds of information about your printer. You can request these prints from the front panel without using a computer.

Before requesting any internal print, make sure that paper is loaded and that the Ready message appears on the front-panel display.

To print an internal print, select the icon, then select the type of internal print that you want.

The following internal prints are available:
- Demo: shows some of the capabilities of the printer
- Menu map: shows details of all the front-panel menus
- Configuration: shows all the current front-panel settings
- Usage report: shows estimates of the total number of prints, number of prints by paper type, number of prints by print-quality option, and total amount of ink used per color. The accuracy of these estimates is not guaranteed.
- HP-GL/2 palette: shows the color or grayscale definitions in the currently-selected color palette
- PostScript font list: lists the PostScript fonts that are installed in the printer (with the PostScript/PDF upgrade)
- Service information: provides information that service engineers require

Turn the printer on and off

**TIP:** The printer can be left powered on without wasting energy. Leaving it on improves response time and overall system reliability. When the printer has not been used for a certain period of time (the default time is determined by Energy Star), it saves power by going into sleep mode. However, any interaction with the printer’s front-panel display, or sending a new job to print, returns it to active mode, and it can resume printing immediately. To change the sleep mode time, see Change the sleep mode setting on page 24.

**NOTE:** In sleep mode, the printer performs maintenance service to the printheads from time-to-time. This avoids long preparation times after long idle periods. Therefore, it is strongly recommended to leave the printer powered on or in sleep mode to avoid wasting ink and time.
The printer has three levels of power consumption.

- Plugged in: the power cord is plugged into the back of the printer
- Switched on: the switch at the back of the printer is in the on position
- Powered on: the Power key on the front panel shows a green light

If you wish to turn the printer on or off or reset the printer, the normal and recommended method is to use the Power key on the front panel.

However, if you plan to store the printer indefinitely, you are recommended to power it off using the Power key, and then also switch off the power switch at the rear. Also, if the Power key does not seem to work, you can use the switch at the rear instead.

To turn it back on, use the power switch at the rear.

When the printer is powered back on, it takes about three minutes to initialize and check and prepare the printheads. Preparing the printheads takes about one minute and 15 seconds. However, if the printer has been off for six weeks or more, preparing the printheads could take up to 45 minutes.
2 Connectivity and software instructions

- Choose which connection method to use
- Connect to a network (Windows)
- Connect directly to a computer (Windows)
- Uninstall the printer driver (Windows)
- Connect to a network (Mac OS)
- Connect directly to a computer (Mac OS)
- Uninstall the printer software (Mac OS)
Choose which connection method to use

The following methods can be used to connect your printer.

<table>
<thead>
<tr>
<th>Connection type</th>
<th>Speed</th>
<th>Cable length</th>
<th>Other factors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gigabit Ethernet</td>
<td>Very fast; varies according to network traffic</td>
<td>Long: 100 m (328 ft)</td>
<td>Requires extra equipment (switches).</td>
</tr>
<tr>
<td>Jetdirect print server (optional accessory)</td>
<td>Moderate; varies according to network traffic</td>
<td>Long: 100 m (328 ft)</td>
<td>Requires extra equipment (switches). Use useful for wireless or AppleTalk connection, and for Novell printing.</td>
</tr>
<tr>
<td>USB 2.0 (optional accessory)</td>
<td>Very fast</td>
<td>Short: 5 m (16 ft)</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** The speed of any network connection depends on all components used in the network, which may include network interface cards, hubs, routers, switches and cables. If any one of these components is not capable of high-speed operation, you will find that you have a low-speed connection. The speed of your network connection can also be affected by the total amount of traffic from other devices on the network.

**NOTE:** There are various possible ways of connecting the printer to a network, but only one of them can be active at a time; with the exception of the Jetdirect print server, which can be active at the same time as one other network connection.

Connect to a network (Windows)

Once the network cable is connected and the printer is powered up, it automatically obtains an IP address. You need to perform the following steps to configure the printer in the network:

1. Go to your printer’s front panel and press the Menu key if necessary until you see the following screen.

   Ready for paper

   ![http://XXX.XX](http://XXX.XX)

   ![http://192.168.1.1](http://192.168.1.1)

   Press & to enter menu

   Note the IP address of your printer (192.168.1.1 in this example).

2. Insert the HP Start-Up Kit DVD into your computer. If the DVD does not autorun, run the setup.exe program in the root folder of the DVD.

3. Press the Software Installation button.

4. Press the Express Network Install button.

5. The configuration program will look for printers connected to your network. When the search has finished, a list of printers will be displayed. Identify your printer by its IP address and select it from the list.
If your printer does not appear in the list, select Help me find my network printer and click Next. In the next screen, give the IP address of your printer.

Connect directly to a computer (Windows)

You can connect your printer directly to a computer without going through a network, by using the printer's USB 2.0 socket.

1. Do not connect the computer to the printer yet. You must first install the printer driver software on the computer, as follows.

2. Insert the HP Start-Up Kit DVD into your DVD drive. If the DVD does not autorun, run the setup.exe program in the root folder of the DVD.

3. Press the Software Installation button.

4. Press the Custom Install button.

5. Follow the instructions on your screen to set up the printer. The following notes will help you to understand the screens and make appropriate choices.

   • You may see a message warning that the installer will have to communicate through the Windows Firewall to search for printers on the network. As you intend to set up a direct connection, select Continue installation without searching the network and click Next.

   • When asked how the printer is connected, choose USB cable.

   • When prompted to do so, connect your computer to the printer, using a USB cable. Ensure that the printer is switched on.

Uninstall the printer driver (Windows)

1. Insert the HP Start-Up Kit DVD into your DVD drive. If the DVD does not autorun, run the setup.exe program in the root folder of the DVD.

2. Press the Software Installation button.

3. Press the Modify Installation button, and follow the instructions on your screen to uninstall the printer driver.

Connect to a network (Mac OS)

You can connect your printer to a network under Mac OS by using the following methods:

- Bonjour
- TCP/IP

NOTE: The printer does not support AppleTalk.

Before you begin, check your equipment:

- The printer should be set up and on.
- The Ethernet hub or router should be on and functioning correctly.
• All computers on the network should be on and connected to the network.
• The printer should be connected to the network.

Now you can proceed to install the printer software and connect your printer.

**Bonjour connection**

1. Go to your printer's front panel and select the Connectivity menu icon ‒ then **Fast Ethernet** or **Gigabit Ethernet**, then **View configuration**. Note the mDNS service name of your printer.
2. Insert the **HP Start-up Kit DVD** into your DVD drive.
3. Open the DVD icon on your desktop.

4. Open the **Mac OS X HP Designjet Installer** icon.
5. Follow the instructions on your screen. You are recommended to use the **Easy Install** option.
6. The printer software is installed, including the printer driver and the HP Utility.
7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a connection to your printer. Follow the instructions on your screen.
8. When you reach the Select Printer screen, look for your printer’s mDNS service name (which you noted in step 1) in the Printer Name column.
● If you find the right printer name, scroll sideways to see the Connection Type column, and check that it shows Bonjour. Then highlight that line. Otherwise, continue searching further down the list.

● If you cannot find your printer name with a Bonjour connection type, check the box My printer is not in the list.

Click Continue.

9. Continue following the instructions on the screen. When you reach the Printer Queue Created screen, click Quit to exit, or Create New Queue if you want to connect another printer to the network.

10. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive. If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the DVD.

TCP/IP connection

1. Go to your printer’s front panel and press the Menu key if necessary until you see the following screen.

Ready for paper

http://XXX:11
http://192.168.1.1

Press \ to enter menu

Note the URL of your printer (http://192.168.1.1 in this example).

2. Insert the HP Start-up Kit DVD into your DVD drive.
3. Open the DVD icon on your desktop.

4. Open the **Mac OS X HP Designjet Installer** icon.

5. Follow the instructions on your screen. You are recommended to use the **Easy Install** option.

6. The printer software is installed, including the printer driver and the HP Utility.

7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a connection to your printer. Follow the instructions on your screen.

8. When you reach the Select Printer screen, look for your printer’s URL (which you noted in step 1) in the Printer Name column.

   - If you find the right printer name, scroll sideways to see the Connection Type column, and check that it shows **IP Printing**. Then highlight that line. Otherwise, continue searching further down the list.

   - If you cannot find your printer name with an **IP Printing** connection type, check the box **My printer is not in the list**.

   Click **Continue**.

9. Continue following the instructions on the screen. When you reach the Printer Queue Created screen, click **Quit** to exit, or **Create New Queue** if you want to connect another printer to the network.

10. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the DVD.

---

**Connect directly to a computer (Mac OS)**

You can connect your printer directly to a computer without going through a network, by using the printer’s built-in USB 2.0 socket.

1. Make sure the printer is either turned off or disconnected from the computer.

2. Insert the **HP Start-up Kit** DVD into your DVD drive.
3. Open the DVD icon on your desktop.

4. Open the **Mac OS X HP Designjet Installer** icon.

5. Follow the instructions on your screen. You are recommended to use the **Easy Install** option.

6. The printer software is installed, including the printer driver and the HP Utility.

7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a connection to your printer.

8. Make sure that the printer is turned on and connected to the computer with a certified USB cable.

   **NOTE:** The use of non-certified USB cables can lead to connectivity problems. Only cables certified by the USB Implementor’s Forum (http://www.usb.org/) should be used with this printer.

9. In the HP Printer Setup Assistant, click **Continue**.

10. In the list of printers that appears, select the entry that uses the connection type USB, and click **Continue**.

11. The following screen displays information about your printer’s installation, where the name of the printer can be modified. Make any changes you wish to make, and click **Continue**.

12. Your printer is now connected. In the Printer Queue Created screen, click **Quit** to exit, or **Create New Queue** if you want to connect another printer.

13. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the DVD.
Sharing the printer

If your computer is connected to a network, you can make your directly connected printer available to other computers on the same network.

1. Double-click the System Preferences icon on the Dock menu bar on your desktop.

2. Under Mac OS X 10.4, enable printer sharing by going to **Sharing > Services > Printer Sharing**.
   
   Under later versions of Mac OS X, go to **Sharing**, select **Printer Sharing**, and then check the printer(s) that you want to share.

3. Your printer now automatically appears in the list of shared printers displayed by any other computer running Mac OS and connected to your local network.

Any other people wishing to share your printer must install the printer software on their own computers. The PostScript driver does not support printer sharing between Mac OS X 10.4 and Mac OS X 10.5 or 10.6. It does support printer sharing between Mac OS X 10.5 and 10.6.

Anyone sharing your printer will be able to send print jobs, but will not be able to receive information from the printer—which affects printer alerts, printer status reports, paper management, printer administration and troubleshooting.

You may find that sharing your directly connected printer with other users will slow down your computer unacceptably.

**TIP:** The best way to share the printer over a network is to connect the printer not to any computer, but to the network. See [Connect to a network (Mac OS)](page) on page 15.

Uninstall the printer software (Mac OS)

1. Insert the *HP Start-up Kit* DVD into your DVD drive.

2. Open the DVD icon on your desktop.

3. Open the **Mac OS X HP Designjet Uninstaller**, and follow the instructions on your screen to uninstall the printer software.
To delete the print queue:

- Under Mac OS X 10.4 there are two ways of deleting the print queue:
  - from the system preferences, select the **Printing** pane of the **Print & Fax** dialog. Select the name of the printer and click the – button.
  - from the Print Setup utility, select the name of the printer and click the **Delete** icon.
- Under Mac OS X 10.5 or 10.6: from the system preferences, select the **Print & Fax** dialog. Select the name of the printer and click the – button.
3 Personalize the printer

- Change the language of the front-panel display
- Access the Embedded Web Server
- Change the language of the Embedded Web Server
- Access the HP Utility
- Change the language of the HP Utility
- Change the sleep mode setting
- Turn the buzzer on and off
- Change the front-panel display contrast
- Change the units of measurement
- Configure network settings
- Change the graphic language setting
- Personalize the list of paper types
- Select paper mismatch action
Change the language of the front-panel display

There are two possible ways to change the language of the front-panel menus and messages.

- If you can understand the current front-panel display language, select the Setup menu icon \(\text{.front panel options} > \text{Select language}\).
- If you cannot understand the current front-panel display language, start with the printer powered off. At the front panel, press the OK key and hold it down. While holding the OK key down, press the Power key and hold it down. Continue to hold down both keys until the green light on the right side of the front-panel display starts flashing, and then release both keys. You can expect a delay of about one second. If the green light starts flashing without any delay, you may need to start again.

Whichever method you used, the language selection menu should now appear on the front-panel display. Highlight your preferred language with the Up and Down keys, then press the OK key.

When you have selected your preferred language, turn off the printer with the Power key and then turn it on again. The front panel will appear in the selected language.

Access the Embedded Web Server

The Embedded Web Server enables you to manage your printer remotely using an ordinary Web browser running on any computer.

To access the Embedded Web Server directly, you must have a TCP/IP connection to your printer. However, you can access the Embedded Web Server indirectly through the HP Utility, if you connect to your printer with a USB connection.

The following browsers are known to be compatible with the Embedded Web Server:

- Internet Explorer 6 and later, for Windows
- Safari 2 and later, for Mac OS X 10.4
- Firefox 1.5 and later

To access the Embedded Web Server on any computer, open your Web browser and give the IP address of your printer.

You can see your printer's IP address (192.168.1.1 in this example) on the front panel.

If you have followed these instructions but failed to get through to the Embedded Web Server, see Cannot access the Embedded Web Server on page 171.

Change the language of the Embedded Web Server

The Embedded Web Server can work in the following languages: English, Portuguese, Spanish, Catalan, French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and...
Japanese. It uses whichever language you have specified in your Web browser’s options. If you have specified a language that it cannot support, it works in English.

To change the language, you must change your Web browser’s language setting. For example, in Internet Explorer version 6, go to the Tools menu and select Internet Options, Languages. Then ensure that the language you want is at the top of the list in the dialog box.

**Access the HP Utility**

The HP Utility enables you to manage your printer from a computer with a USB, TCP/IP or Jetdirect connection.

- **Under Windows**, start the HP Utility from your desktop shortcut or from Start > All Programs > Hewlett-Packard > HP Utility > HP Utility. This launches the HP Utility, showing the printers installed on your computer.

- **Under Mac OS**, launch the HP Utility from your dock shortcut or by selecting STARTUP_DISK > Library > Printers > hp > Utilities > HP Utility. This launches the HP Utility, showing the printers installed on your computer.

When you select your printer in the left pane, everything that appears in the right pane is specific to that printer.

If you have followed these instructions but failed to get through to the HP Utility, see Cannot access the HP Utility on page 174.

**Change the language of the HP Utility**

The HP Utility can work in the following languages: English, Portuguese, Spanish, Catalan (Windows only), French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and Japanese.

- **Under Windows**, select Tools > Set Language and select a language from the list.

- **Under Mac OS**, the language is changed as for any other application. In System Preferences, select International and re-launch the application.

**Change the sleep mode setting**

If the printer is left switched on but unused for a certain period of time, it goes automatically into sleep mode to save power. To change the time the printer waits before it goes into sleep mode, go to the front panel and select the Setup menu icon, then Front panel options > Sleep mode wait time. Highlight the wait time you want and then press the OK key. You can set the time from 1 to 240 minutes. The default time is 30 minutes.

**Turn the buzzer on and off**

To turn the printer’s buzzer on or off, go to the front panel and select the Setup menu icon, then Front panel options > Enable buzzer, and highlight on or off and press the OK key. By default, the buzzer is set to on.
Change the front-panel display contrast

To change the contrast of the front-panel display, select the Setup menu icon \(\text{Setup menu icon}\) then \(\text{Front panel options} > \text{Select display contrast}\), and enter a value using the Up or Down key. Press the OK key to set the value. The default contrast is set to 50.

Change the units of measurement

To change the units of measurement in the front-panel display, select the Setup menu icon \(\text{Setup menu icon}\) then \(\text{Front panel options} > \text{Select units}\), and select English or Metric. By default the units are set to metric.

Configure network settings

You can view and configure the network settings from the HP Utility. Under Windows, select the Settings tab, then Network Settings. Under Mac OS, select Configuration > Network Settings. The following settings are available.

- **IP Configuration method**: specify the way to set an IP address, selecting BOOTP, DHCP, Auto IP or Manual.
- **Host name**: specify an IP name for the network device. The name may contain up to 32 ASCII characters.
- **IP address**: specify the IP address on the print server. Duplicate IP addresses on a TCP/IP network are not allowed.

\(\text{NOTE:}\) If you change the current IP address and click Apply, the browser loses the current connection to the print server because it is pointing to the old address. To reconnect, browse to the new IP address.

- **Subnet mask**: specify a subnet mask, which is a 32-bit number applied to an IP address to determine which bits specify the network and subnet and which bits uniquely specify the node.
- **Default gateway**: specify the IP address of a router or computer that is used to connect to other networks or sub-networks. If none exist, use the IP address of the computer or the IP address of the print server.
- **Domain name**: specify the name of the DNS domain in which the print server resides (for example, support.hp.com).

\(\text{NOTE:}\) The domain name does not include the host name; it is not the fully qualified domain name, such as printer1.support.hp.com.

- **Idle timeout**: specify the number of seconds that an idle connection is allowed to remain open; 30 is the default value. If set to zero, the timeout is disabled and TCP/IP connections remain open until closed by the other node (such as a workstation) on the network.
- **Default IP**: specify the IP address to use when the print server is unable to obtain an IP address from the network when powered on or when reconfigured to use BOOTP or DHCP.
- **Send DHCP requests**: specify whether DHCP requests are transmitted when a legacy default IP address or a default Auto IP is assigned.
To configure the same network settings from the front panel, select the Connectivity menu icon then Fast Ethernet or Gigabit Ethernet > Modify configuration.

You have various other options available from the Connectivity menu icon.

- **USB**: view information about the USB connection
- **Jetdirect EIO**: view information, configure and reset the Jetdirect connection
- **Advanced > Select I/O timeout**: specify the number of seconds that an idle connection is allowed to remain open, 270 is the default value, if set to zero, the timeout is disabled
- **Advanced > Allow SNMP**: specify whether SNMP is permitted
- **Advanced > Embedded Web Server > Allow EWS**: specify whether the Embedded Web Server is enabled
- **Advanced > Web Services > HP Utility software**: view the HP Utility software settings
- **Advanced > Web Services > Color and paper management**: view the color and paper management settings

## Change the graphic language setting

You can change the graphic language setting from the HP Utility with the following steps.

1. **Under Windows**, select the Settings tab then Printer settings > Printing preferences.

   **Under Mac OS**, select Configuration then Printer settings > Configure printer settings > Printing preferences.

2. Select one of the following options.
   - Select **Automatic** to let the printer determine which type of file it is receiving. This is the default setting; it works for most software applications. You should not normally need to change it.
   - Select **HP-GL/2** only if you are sending a file of that type directly to the printer, without going through a printer driver.
   - Select **PDF** only if you are sending a file of that type directly to the printer, without going through a printer driver (with the PostScript/PDF upgrade).
   - Select **PostScript** only if you are sending a file of that type directly to the printer, without going through a printer driver (with the PostScript/PDF upgrade).
   - Select **TIFF** only if you are sending a file of that type directly to the printer, without going through a printer driver.
   - Select **JPEG** only if you are sending a file of that type directly to the printer, without going through a printer driver.

   You can change the graphic language setting from the front panel. Select the Setup menu icon then Printing preferences > Select graphic language. Select the desired option and press the OK key to set the value.

   **NOTE**: If the graphic language is set from the HP Utility, it overrides the front panel setting.
Personalize the list of paper types

If there are some paper types that you never use, you can remove them from the list shown in the front panel, the Embedded Web Server and the HP Utility.

1. In the Embedded Web Server, select the Setup tab and then Paper management.

2. In the Paper Management pane, select the Show/Hide papers tab.

3. Select any paper type you want to hide, and use the >> button to move it to the hidden paper list.

4. When you have finished, use the Apply button to save your changes.

If you change your mind later, you can move papers from the hidden list back to the visible list at any time.
Select paper mismatch action

If the paper currently loaded in the printer is not suitable for a particular job, the printer can either put the job on hold until some suitable paper is loaded, or it can ignore the problem and print the job on the unsuitable paper. There are two ways in which the loaded paper may be considered unsuitable:

- The paper type is not as specified for the job
- The paper size is smaller than specified for the job

You can set the printer’s behavior in such cases from the front panel.

- Select the Setup menu icon, then Job management options > Select paper mismatch action > Print anyway if you want such jobs to print on whatever paper is loaded. This is the default option.
- Select the Setup menu icon, then Job management options > Select paper mismatch action > Put job on hold if you want such jobs to be put on hold. The printer will send an alert whenever a job is put on hold.

When a job is put on hold for paper, it is kept in the printer queue until some suitable paper is loaded (in which case, all jobs waiting for that paper type can be printed). Meanwhile, other jobs with different requirements can continue printing.
4 Handle the paper

- Overview
- Load a roll onto the spindle
- Load a roll into the printer
- Unload a roll from the printer
- Use the take-up reel
- View information about the paper
- Perform paper advance calibration
- Download paper presets
- Use non-HP paper
- Cancel the drying time
- Change the drying time
- Printing paper info
- Feed and cut the paper
- Store the paper
- Order paper
Overview

Paper is only a subset of the portfolio of printing materials that the printer can handle. You can also print on a wide variety of films, textiles and fabrics, self-adhesive materials, and banner and sign materials. Throughout this guide, however, these materials are generally referred to as paper.

NOTE: Because the front panel has limited space, the names of the HP paper might be abbreviated and might not appear in the front panel exactly as they are shown on the packaging label.

NOTE: Because the complete list of supported paper is very long, only the most common paper types appear in the front panel. If you want to see an HP paper type that does not appear on the front panel, download the paper preset from http://www.hp.com/go/Z6200/paperpresets/. See Download paper presets on page 47.

NOTE: The automatic paper-cutter feature is disabled for some of the heaviest paper types, because some heavy paper can damage the cutter.

Use paper

Choosing the correct paper type for your needs is an essential step in ensuring good print quality. For best printing results, use only recommended HP paper (see Supported paper types on page 31). HP papers have been developed and thoroughly tested to ensure reliable performance. All printing components (printer, ink system, and paper) have been designed to work together to offer trouble-free operation and ensure optimal print quality.

Here are some additional tips about paper usage:

- Allow all paper types to adapt to room conditions, out of the packaging, for 24 hours before using them for printing.
- Handle film and photo paper by the edges, or wear cotton gloves. Skin oils can be transferred to the paper, leaving fingerprint marks.
- Keep the paper tightly wound on the roll throughout the loading and unloading procedures. To make sure that the roll stays tightly wound, consider using tape to stick the leading edge of the roll to the core just before removing the roll from the printer. You can keep the roll taped during storage. If the roll starts to unwind, it can become difficult to handle.

NOTE: The use of tape to attach the leading edge of the roll is especially important for 76.2-mm (3-in) cores, in which the inherent stiffness of the printing material can cause the material to loosen and unwind from its core.

- Whenever you load a roll, the front panel prompts you to specify the paper type that you are loading. For good print quality, it is essential to specify this correctly. Make sure that the paper name that is printed on the packaging label matches the description on the front panel.

If you cannot find a specific paper on the front-panel display, go to http://www.hp.com/go/Z6200/paperpresets/ to download the latest paper preset to your printer, or select the paper description that best matches the paper name printed on the packaging label.

- The quality of some images might be reduced if you use a paper type that is unsuitable for your image. This is especially important to consider when printing on fiber-based papers such as HP Universal Coated Paper, HP Coated Paper, HP Heavyweight Coated Paper and HP Universal Heavyweight Coated Paper. Printing images that contain high-saturation area fills on fiber-based papers can create unwanted wavy patterns as a result of paper expansion. This can ultimately contribute to more severe problems. Consider using Super Heavyweight Coated Paper and other cockle-free papers when printing high-saturation area fills.
● Make sure that the appropriate print-quality setting (Best, Normal, or Fast) is selected. You can set the print quality in the driver, in the Embedded Web Server, or on the front panel. Driver or Embedded Web Server settings override front panel settings. The combination of paper type and print-quality settings tells the printer how to place the ink on the paper—for example, the ink density and halftoning method. See Select print quality on page 82.

● Although the ink systems that are supplied with this printer have good light-fastness, colors will eventually fade or change if exposed to sunlight over a long period of time.

● If the paper type shown on the front panel does not correspond to the paper that you intend to use, take one of the following actions:
  ◦ Reload the roll into the printer and select the correct paper type. See Unload a roll from the printer on page 37 and Load a roll into the printer on page 36.
  ◦ Use the Embedded Web Server or the HP Utility to reconfigure the paper type for the roll.
  ◦ At the printer’s front panel, select the icon, then Change active paper type.

**NOTE:** The paper advance calibration is not performed when the paper type is changed from the front panel.

**Drying time**

With some paper types and under certain environmental conditions, the ink needs some time to dry before the paper is unloaded. The following settings are available for each paper type:

● **Automatic:** the printer automatically determines the appropriate drying time, based on the paper you have selected and the current temperature. If any drying time is required, a “drying time to go” countdown appears on the front panel.

● **Extended:** the default drying time is extended. This can be used if you find that the default drying time is sufficient to dry the ink.

● **Reduced:** the default drying time is reduced. This can be used if you want to get prints as fast as possible, and you find that the reduced drying time causes no significant problem in your environment.

● **None:** no drying time is provided. This can be used, for example, if you are manually removing the prints as quickly as the printer is producing them.

● **Manual:** this allows you to specify the drying time (in seconds).

To change the drying time, see Change the drying time on page 49.

**Supported paper types**

The following table lists the most common paper types that are suitable for use with your printer, and shows the name that you should select on the front panel when loading each paper type. If you want to use an HP paper that does not appear on the front panel, go to http://www.hp.com/go/Z6200/paperpresets/ and download the appropriate paper preset. You need to download a preset only once; the printer stores it for future use and it subsequently appears in the front panel.

For the part numbers, widths, and weights of these papers, see Order paper on page 50.

**NOTE:** This list is likely to change over the course of time. For the latest information, visit http://www.hp.com/go/Z6200/paperpresets/.
<table>
<thead>
<tr>
<th>Paper type</th>
<th>Paper name</th>
<th>Front panel name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bond and Coated Paper</td>
<td>HP Super Heavyweight Plus Matte Paper</td>
<td>HP Matt Super HW Plus</td>
</tr>
<tr>
<td></td>
<td>HP Heavyweight Coated Paper</td>
<td>HP HW Coated Paper</td>
</tr>
<tr>
<td></td>
<td>HP Universal Heavyweight Coated Paper</td>
<td>HP Uni HW Coated Paper</td>
</tr>
<tr>
<td></td>
<td>HP Coated Paper</td>
<td>HP Coated Paper</td>
</tr>
<tr>
<td></td>
<td>HP Universal Coated Paper</td>
<td>HP Uni Coated Paper</td>
</tr>
<tr>
<td></td>
<td>HP Bright White Inkjet Paper</td>
<td>HP Bright White IJ Paper</td>
</tr>
<tr>
<td></td>
<td>HP Universal Bond Paper</td>
<td>HP Universal Bond Paper</td>
</tr>
<tr>
<td></td>
<td>HP Recycled Bond Paper</td>
<td>HP Recycled Bond Paper</td>
</tr>
<tr>
<td></td>
<td>Super heavyweight coated paper</td>
<td>Super HW Coated Paper</td>
</tr>
<tr>
<td></td>
<td>Heavyweight coated paper</td>
<td>Heavyweight Coated Paper</td>
</tr>
<tr>
<td></td>
<td>Coated paper</td>
<td>Coated Paper</td>
</tr>
<tr>
<td></td>
<td>Bright white paper</td>
<td>Bright White Paper</td>
</tr>
<tr>
<td></td>
<td>Plain paper</td>
<td>Plain Paper</td>
</tr>
<tr>
<td>Photo Paper</td>
<td>HP Premium Matte Photo Paper</td>
<td>HP Prem Matte Photo Paper</td>
</tr>
<tr>
<td></td>
<td>HP Everyday Pigment Ink Gloss Photo Paper</td>
<td>HP Evday Pigm Gls Phto</td>
</tr>
<tr>
<td></td>
<td>HP Everyday Pigment Ink Satin Photo Paper</td>
<td>HP Evday Pigm Satn Phto</td>
</tr>
<tr>
<td></td>
<td>HP Professional Satin Photo Paper</td>
<td>HP Prof Satin Photo Paper</td>
</tr>
<tr>
<td></td>
<td>HP Premium Instant-dry Gloss Photo Paper</td>
<td>HP Prem ID G Photo</td>
</tr>
<tr>
<td></td>
<td>HP Premium Instant-dry Satin Photo Paper</td>
<td>HP Prem ID Satn Phto</td>
</tr>
<tr>
<td></td>
<td>Photo gloss/semi-gloss/satin paper</td>
<td>Photo Gls/S-Gls/Satn Papr</td>
</tr>
<tr>
<td></td>
<td>Photo gloss/semi-gloss/satin paper (less ink)</td>
<td>Photo Gls/S-Gls/Satn –ink</td>
</tr>
<tr>
<td></td>
<td>Photo gloss/semi-gloss/satin paper (more ink)</td>
<td>Photo Gls/S-Gls/Satn +ink</td>
</tr>
<tr>
<td></td>
<td>Photo matte paper</td>
<td>Photo Matte Paper</td>
</tr>
<tr>
<td>Fine Art Material</td>
<td>HP Matte Litho-realistic Paper</td>
<td>HP Matt Litho-real Paper</td>
</tr>
<tr>
<td></td>
<td>HP Professional Matte Canvas</td>
<td>HP Prof Matte Canvas</td>
</tr>
<tr>
<td></td>
<td>HP Collector Satin Canvas</td>
<td>HP Collector Satin Canvas</td>
</tr>
<tr>
<td></td>
<td>HP Artist Matte Canvas</td>
<td>HP Artist Matte Canvas</td>
</tr>
<tr>
<td></td>
<td>HP Universal Matte Canvas</td>
<td>HP Universal Matte Canvas</td>
</tr>
<tr>
<td></td>
<td>Canvas (more ink)</td>
<td>Canvas (more ink)</td>
</tr>
<tr>
<td></td>
<td>Canvas</td>
<td>Canvas</td>
</tr>
<tr>
<td></td>
<td>Fine art paper (more ink)</td>
<td>Fine Art Paper (more ink)</td>
</tr>
<tr>
<td></td>
<td>Fine Art Paper</td>
<td>Fine Art Paper</td>
</tr>
<tr>
<td>Paper type</td>
<td>Paper name</td>
<td>Front panel name</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------------------------</td>
<td>-----------------------------------------</td>
</tr>
<tr>
<td>Backlit Material</td>
<td>HP Premium Vivid Color Backlit Film</td>
<td>HP Prem Vivid Colr Bklit</td>
</tr>
<tr>
<td></td>
<td>Backlit material</td>
<td>Backlit material</td>
</tr>
<tr>
<td></td>
<td>Backlit material (more ink)</td>
<td>Backlit material (more ink)</td>
</tr>
<tr>
<td>Banner and Sign Material</td>
<td>HP Opaque Scrim</td>
<td>HP Opaque Scrim</td>
</tr>
<tr>
<td></td>
<td>HP Durable Banner with DuPont Tyvek</td>
<td>HP Durable Banner-Tyvek®</td>
</tr>
<tr>
<td></td>
<td>Indoor Banner</td>
<td>Indoor Banner</td>
</tr>
<tr>
<td>Technical Paper</td>
<td>HP Natural Tracing Paper</td>
<td>HP Natural Tracing Paper</td>
</tr>
<tr>
<td></td>
<td>HP Translucent Bond Paper</td>
<td>HP Translucent Bond Paper</td>
</tr>
<tr>
<td></td>
<td>HP Vellum Paper</td>
<td>HP Vellum Paper</td>
</tr>
<tr>
<td></td>
<td>Natural tracing paper</td>
<td>Natural Tracing Paper</td>
</tr>
<tr>
<td></td>
<td>Translucent bond paper</td>
<td>Translucent Bond Paper</td>
</tr>
<tr>
<td></td>
<td>Vellum</td>
<td>Vellum</td>
</tr>
<tr>
<td>Film</td>
<td>HP Clear Film</td>
<td>HP Clear Film</td>
</tr>
<tr>
<td></td>
<td>HP Matte Film</td>
<td>HP Matte Film</td>
</tr>
<tr>
<td></td>
<td>Transparent or clear film</td>
<td>Transparent/Clear film</td>
</tr>
<tr>
<td></td>
<td>Matte film</td>
<td>Matte film</td>
</tr>
<tr>
<td>Proofing Paper</td>
<td>Proofing Gloss Paper</td>
<td>Proofing Gloss Paper</td>
</tr>
<tr>
<td></td>
<td>Proofing Matte Paper</td>
<td>Proofing Matte Paper</td>
</tr>
<tr>
<td>Self-Adhesive Material</td>
<td>HP Colorfast Adhesive Vinyl</td>
<td>HP Colorfast Adh Vinyl</td>
</tr>
<tr>
<td></td>
<td>HP Everyday Adhesive Matte Polypropylene</td>
<td>HP Eday Adh Matt Polyprop</td>
</tr>
<tr>
<td></td>
<td>Adhesive Polypropylene</td>
<td>Adhesive Polypropylene</td>
</tr>
</tbody>
</table>

### Load a roll onto the spindle

1. Make sure that the printer wheels are locked (the brake lever is pressed down) to prevent the printer from moving.

2. Release the spindle lock on the right-hand side.
3. Remove the first end of the spindle from the right-hand side of the printer, and then move the spindle to the right in order to extract the other end. Do not insert your fingers into the spindle supports during the removal process.

The spindle has a hub at each end to keep the roll in position. Remove the blue hub at the left end to mount a new roll. The hub slides along the spindle to hold rolls of different widths.

4. Slide the lever-lock on the blue hub to the unlocked position and remove the hub (1) from the left end of the spindle.

5. Rest the roll of paper that you want to load on the loading table. The roll might be long and heavy, and you might need two people to handle it.
6. Slide the spindle into the roll. Make sure that no space exists between the roll and the fixed hub at the right end of the spindle.

Make sure that the paper will wind off the roll in the correct direction. If it does not, remove the spindle from the roll, turn the roll 180° and rest it on the loading table. Then slide the spindle into the roll.

**NOTE:** A label on the spindle also shows the correct winding direction.

7. Put the blue hub on to the upper end of the spindle, and push it towards the end of the roll as shown in step 1 in the following image. Then slide the lever-lock to the locked position as shown in step 2.

8. With the blue hub on the left, insert the spindle into the left side of the printer (1), and then into the right side of the printer (2).

9. Close the spindle lock on the right-hand side.
If you regularly use different paper types, you can change rolls more quickly if you pre-load rolls of different paper types on different spindles. Extra spindles are available for purchase.

**Load a roll into the printer**

**NOTE:** To start this procedure, you need to have a roll loaded on the spindle. See Load a roll onto the spindle on page 33.

1. At the printer’s front panel, select the icon, and then select Paper load > Load roll.

   ![Paper load menu]

   Alternatively, you can start loading paper without using the front panel, by feeding paper in or lifting the pinch lever when there is no paper loaded.

   **NOTE:** If you lift the pinch lever, you will need to align the paper manually; follow the instructions on the front panel.

2. If printing paper info is disabled, the front panel asks you to select the paper type.

3. The front panel asks you to feed paper. When the printer detects the paper, paper checks will begin.

4. If the paper that you are using has a paper-data barcode printed on the leading edge of the roll, and printing paper info is enabled, the printer automatically reads the information. If printing paper info is disabled, the barcode is ignored.

   ![Barcode example]

   If printing paper info is enabled and no barcode is detected on the roll that is being loaded, the front panel asks you to enter the paper type and the length of the roll you are loading. Select the paper category and paper type of the roll. If it is not clear which paper category or paper type to select, see Supported paper types on page 31.

   ![Paper types list]

   Select the length of the roll.

   ![Select roll length]

5. If some of the paper checks failed, the front panel explains the problem and helps you to load paper successfully.
6. If you have a take-up reel (a standard feature on the 1.5m printer and an optional accessory on the 1.1m printer), a message will appear on the front panel asking if you want to load paper onto the take-up reel. If you select No (or if you do not have a take-up reel) the front panel displays the Ready message and the printer is ready to print. If you select Yes, a message will appear on the front panel asking if you want to load the take-up reel now or during printing.

- If you want to load the take-up reel now, select Load take-up reel now, read through the introductory text in the section Use the take-up reel on page 37, and then continue to step 3 of the procedure.

- If you want to load the take-up reel during printing, select Load it during printing, read through the introductory text in the section Use the take-up reel on page 37, and then continue to step 3 of the procedure.

**NOTE:** Familiarize yourself with the procedural steps, because loading the take-up reel while printing requires you to complete the procedure while the printer is feeding and printing paper. Loading the take-up reel during printing saves approximately 1 m (3 ft) of paper.

**NOTE:** During the initial printer setup, printhead alignment and color calibration are performed automatically after the roll is loaded into the printer.

## Unload a roll from the printer

**NOTE:** If you used the take-up reel (a standard feature on the 1.5m printer and an optional accessory on the 1.1m printer) during printing, unload the printed roll from the take-up reel before attempting to remove the roll from the printer. See Unload a roll from the take-up reel on page 43.

1. At the printer’s front panel, select the icon, then Paper unload > Unload roll.
2. The paper is unloaded from the printer.
3. Release the spindle lock.
4. Remove the roll from the printer, pulling out the right end on the right side of the printer first. Do not insert your fingers into the spindle supports during the removal process.

## Use the take-up reel

**CAUTION:** Make sure the printer is turned off when installing the take-up reel motor on the printer.
The take-up reel is operated from the front panel.

Follow these guidelines when taping rolls to the take-up reel spindle core:

- Make sure that the paper is straight when it is attached to the spindle core. Otherwise it skews as it winds onto the core.
- The spindle core on the take-up reel must be the same width as the paper that you are using.
- Check that neither side of the spindle core has end caps, and make sure the spindle core is pushed firmly into both spindle guides.
- If you are using a Z6200 1.1m printer, make sure that the bin loop is placed behind the foot brace so that it does not block the take-up reel sensors.

**NOTE:** If you want to load the take-up reel during printing, familiarize yourself with the procedural steps. Loading the take-up reel during printing requires you to complete the procedure while the printer is feeding and printing paper. Loading the take-up reel during printing saves approximately 1 m (3 ft) of paper.

### Load a roll onto the take-up reel

1. On the printer’s front panel, select the icon, and then select **Paper load > Load take-up reel**.

2. If you want to load the take-up reel now, select **Load take-up reel now** on the front panel. If you want to load the take-up reel during printing, select **Load it during printing** on the front panel.

3. Make sure that the loading table is in its upright position.
4. Unlock the take-up reel spindle by pushing the spindle lever to its uppermost position.

5. Remove the take-up reel spindle.

6. The front-panel display guides you through the process of loading the take-up reel spindle core onto the take-up reel spindle. When that task is complete, load the take-up reel spindle into the printer by pushing firmly on both ends of the spindle.
7. Press the **OK** key on the front panel, and then select a winding direction.

<table>
<thead>
<tr>
<th>Select the printed roll winding direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>☐ Printed face outwards</td>
</tr>
<tr>
<td>☐ Printed face inwards</td>
</tr>
</tbody>
</table>

The printer advances the paper. Make sure that the paper passes in front of the loading table, as shown.

8. Pull the paper taut to the position shown in the following figure. Do *not* attempt to pull more paper out of the printer. Use tape to secure the paper to the spindle core. You might need to use more tape than is shown in the following image. The paper should be secure enough to support the weight of the loop-shaping core, which you insert in step 12.

**NOTE:** If you are loading the take-up reel *during* printing you do not need to pull the paper taut. Tape the paper to the spindle core when an adequate length of paper has fed from the printer after printing begins.

**NOTE:** To avoid having the paper skew as it winds onto the spindle core, make sure the paper is straight when you attach it. It is sometimes useful to use the core grooves to align the paper.
9. Press the OK key on the front panel. The printer advances the paper.

NOTE: Make sure that you insert the loop-shaping core. The take-up reel will not function correctly without it. The loop-shaping core must have end caps. Make sure that the end caps extend over the edges of the paper.

10. Assemble a loop-shaping core by matching the shape-coded and color-coded lengths of plastic tubing. The loop-shaping core must be the same width as the paper that you are using. Make sure that both end caps are firmly fitted on the ends of the loop-shaping core.

NOTE: The front-panel display shows the required length of the loop-shaping core based on the width of the roll that you have loaded into the printer.

11. Gently lower the loading table.
12. Carefully insert the loop-shaping core.

![Image of loop-shaping core insertion]

**NOTE:** Make sure that you insert the loop-shaping core. The take-up reel will not function correctly without it. The loop-shaping core must have end caps. Make sure that the end caps extend over the edges of the paper.

13. Use the wind-direction switch on the take-up reel motor to select the winding direction. Setting **1** winds the paper so that the printed image faces in. Setting **2** winds the paper so that the printed image faces out.

The front panel shows you to the correct setting based on the winding-direction decision you made in step 7.

![Image of wind-direction switch]

14. Press the **OK** key on the front panel. The *Take-up reel has been successfully installed* message appears.

15. The following image shows how the printer looks when it is operating. As paper is fed from the printer, it drops down in a loop and then up into the take-up reel spindle.

![Image of printer operation]

**NOTE:** While the take-up reel is operating, make sure that the take-up reel sensors are not blocked.

**NOTE:** The automatic paper-cutter is disabled when the take-up reel is in use.
NOTE: If you want to move the printer, first remove the take-up reel sensor and cable housing unit from the foot of the printer stand. Place the sensor and cable housing unit on the printer stand crossbar and use the blue plastic screw to affix the housing unit to the leg of the stand, as shown, while the printer is being moved. When reinstalling the housing unit, make sure that the wheel on the foot of the printer stand is pointing forward.

Unload a roll from the take-up reel

1. On the printer’s front panel, select the icon, and then select Paper unload > Unload take-up reel.

   The printer advances the paper to allow for cutting.

2. Lift the loading table to its upright position.

3. Switch the wind-direction switch to the off position. The switch is in the off position when it is centered (in other words, when the switch is neither in position 1 nor position 2).
4. Remove the loop-shaping core.

5. Use the winding button on the take-up reel motor to wind the excess paper around the take-up reel spindle.

6. Press the OK key on the front panel.

7. The printer knows if the type of paper that is loaded is suitable for the automatic paper-cutter. The paper is cut if it is suitable. If the paper is not suitable, cut the paper manually.

**NOTE:** The automatic paper-cutter feature is disabled for some of the heaviest paper types, because they can damage the cutter.
8. Use the winding button on the take-up reel motor to wind the remainder of the paper around the take-up reel spindle.

9. Press the **OK** key on the front panel.

   The amount of printed paper that is on the take-up reel spindle appears on the front panel.

10. Unlock the take-up reel spindle by pushing the spindle lever to its uppermost position.

11. Remove the roll from the printer, pulling out the end on the right side of the printer first. Do not insert your fingers into the spindle supports during the removal process.

12. To remove the roll from the printer after you have unloaded the take-up reel, see [Unload a roll from the printer on page 37](#).
View information about the paper

On the printer's front panel, press the icon. Alternatively, select the icon, then View loaded paper.

The following information appears on the front panel:

- The roll status
- The paper type that you have selected
- The width of the paper in millimeters (estimated by the printer)
- The length of the paper in millimeters (estimated by the printer)
- The color calibration status
- The paper advance calibration status

If no paper is loaded, the message Out of paper appears.

The same information appears on the Embedded Web Server’s Supplies page.

Perform paper advance calibration

The printer is calibrated to advance correctly when printing all the papers that appear on the front panel. When you select the type of loaded paper, the printer adjusts the rate at which it advances the paper while printing. However, to fine-tune the image quality of your print, you might need to calibrate the rate at which the paper advances. See Troubleshoot print-quality issues on page 144 to determine whether paper-advance calibration is the solution for your issue.

Accurate paper advance controls proper placement of dots on the paper. If the paper is not advanced correctly, light or dark bands appear in the printed image and the grain in the image might increase.

To check the paper advance calibration status of the paper, select the icon, then View loaded paper. The status appears:

- **DEFAULT**: this status appears when an HP paper is loaded. Unless you experience image-quality problems in your printed image, such as banding or graininess, HP recommends that you do not calibrate the paper advance.
- **RECOMMENDED**: this status appears when you create a new paper. The paper advance values for this paper are inherited from the family type. HP recommends that you perform a paper advance calibration to optimize the values.
- **OK**: this status indicates that the loaded paper has been calibrated previously. However, you might need to repeat the calibration if you experience image-quality problems, such as banding or graininess in your printed image.

**NOTE:** Whenever you update the printer firmware, the paper-advance calibration values are reset to the factory default. See Update the printer firmware on page 138.

**NOTE:** Colored papers, glossy canvas, and transparent materials such as translucent bond, clear film, natural tracing paper, and vellum are not suitable for paper-advance calibration.
Overview of the paper advance procedure

1. On the front panel, select the icon, and then select **Image quality maintenance > Paper advance calibration > Calibrate paper advance**. The printer automatically calibrates the paper-advance and prints a paper advance calibration image.

2. Wait until the front panel shows the status screen, and then reprint your image.

   **NOTE:** The calibration procedure takes approximately six minutes. The front-panel display shows any errors in the process.

   If you are satisfied with your image, continue using this calibration for your paper type. If you see improvement in your image, continue with step 3. If you are dissatisfied with the calibration, return to the default calibration. See Return to the default calibration on page 47.

3. To fine-tune the calibration, select the icon, and then select **Image quality maintenance > Paper advance calibration > Adjust paper advance**.

4. Select the percentage of change from -100% to 100%. To correct light banding, decrease the percentage. To correct dark banding, increase the percentage.

5. Press the OK key on the front panel to save the value.

6. Wait until the front panel shows the status screen, and then reprint your image.

Return to the default calibration

Returning to the default calibration sets all the paper-advance calibration to zero. To return to the default paper advance-calibration value, you must reset the calibration.

1. On the front panel, select the icon, and then select **Image quality maintenance > Paper advance calibration > Reset paper advance**.

2. Wait until the front panel shows that the operation has been successfully completed before you press the Back key to return to the Ready screen.

Download paper presets

Each supported paper type has its own characteristics. The printer changes the way it prints on each different paper type. For example, some might need more ink and some might require a longer drying time. The printer requires a description of the requirements of each paper type. This description is called the “paper preset”.

The paper preset contains the ICC profile, which describes the color characteristics of the paper. It also contains information about other characteristics and requirements of the paper that are not directly related to color. Existing paper presets for your printer are installed in the printer's software.

Your printer contains paper presets for only the most commonly used paper types. If you buy a paper type for which your printer has no preset, you cannot select that paper type in the front panel.
You can assign a preset for a new paper type in three ways:

- Use an HP factory paper preset by selecting the closest category and type on the front panel or in the HP Utility.

  **NOTE:** Because colors might not be accurate, this method is not recommended for high-quality prints.


  **NOTE:** HP provides presets for HP paper types only. If you do not find the paper preset that you want on the Web, it might have been added to the latest firmware for your printer. Check the firmware release notes for information. See Update the printer firmware on page 138.

- Add a custom paper type. See Use non-HP paper on page 48, and create an ICC profile for either HP or non-HP papers.

### Use non-HP paper

HP paper has been fully tested with the printer and can be expected to give the best print quality.

However, you can print on paper from any manufacturer. Before doing so, add the custom paper type and allow the printer to run a color calibration. You can add a custom paper by using the HP Color Center in the HP Utility.

**NOTE:** If you have already selected Custom paper > Add Custom Paper from the HP Utility, the first Add New Paper screen appears and you can start this procedure at step 4.

1. Go to the Color Center in the HP Utility.
2. Select Manage Papers.
4. Type the paper name.

  **TIP:** If you use the commercial name of the paper, other users will be able to recognize it easily.

5. Select a paper category. This is important, because it determines a number of basic parameters for printer-paper interaction, taking into account the properties of both sides of the paper.

  **TIP:** In some cases, you may need to experiment with different paper categories in order to find out which one works best in practice.

  **TIP:** You can get information about the characteristics of each HP paper type from the front panel: select the icon, then Paper types list > Paper category > Paper type > View paper details. This may help you to match your non-HP paper with a similar HP paper type.

6. Load the custom paper. See Load a roll into the printer on page 36.
7. Click Next. The printer performs a color calibration and prints a calibration chart. This can take up to 10 minutes.

  **NOTE:** For more information on the processes available in the Color Center, see A summary of the color-management process on page 100.

8. After the new calibration parameters are calculated and stored, you are reminded to create an ICC profile. Click Done. The custom paper is added to the paper category you selected.
9. To create an ICC profile, which allows you to print on your paper with the best possible color accuracy, see Color profiling on page 102.

10. Perform paper advance calibration (see Perform paper advance calibration on page 46). The default paper advance values for your custom paper are inherited from the paper category, but can probably be improved by calibration.

# Cancel the drying time

Press the Form Feed and Cut key on the front panel.

⚠️ **CAUTION:** A print that has not dried sufficiently can suffer from quality problems.

# Change the drying time

You can use the HP Utility to change the drying time for a particular paper type, to accommodate special printing conditions.

1. Open the HP Color Center.
2. Select **Paper preset management**.
3. Select **Change printing properties**.
4. Select the paper category.
5. Select the paper type.
6. Choose a drying time from the Dry Time drop-down menu.

**NOTE:** The text box to the right of the drop-down menu will not display the time in seconds when the Automatic option is selected (it is selected by default for all paper types). This is because the Automatic option means that the printer will calculate the optimal drying time for you depending on the temperature at printing time, and therefore it cannot be known in advance.

You can turn off all drying time for all paper types by selecting the icon, then Print retrieval > Select drying time > Off.

For more information about drying time, see Drying time on page 31.

# Printing paper info

The Printing paper info option is enabled by default; it allows the printer to estimate the remaining roll length by reading a barcode that is printed on the leading edge of the roll whenever the paper is unloaded.

![Barcode example]

When you load a new, unused roll, there is no barcode already printed on it, so the front panel will ask you for the length. The length printed on the barcode at unloading time is calculated from the length you declare at the start, minus the length that has been printed.

**NOTE:** If you declare at loading time that the length of the roll is unknown, and then later reload the same roll, the front panel will request the length again.
To disable the **Printing paper info** option, select the  icon in the printer’s front panel, and then select **Printing preferences > Paper options > Disable printing paper info**. In this case, the length will not be requested, and the barcode will be neither printed nor read.

**Feed and cut the paper**

If you press the **Form feed and cut** key on the front panel, the printer advances the paper and makes a straight cut across the front edge. There are several possible reasons why you might want to do this.

- To trim the leading edge of the paper if it is damaged or not straight.
- To feed and cut the paper when the automatic cutter has been disabled.
- To cancel the waiting time and print the available pages immediately, if the printer is waiting to nest more pages.

**NOTE:** The printheads are serviced after each print, and the paper cannot be cut until the process completes, so you may notice a delay.

**CAUTION:** Remove the cut piece from the output tray. If strips or short prints are left in the output tray, the printer could jam.

**Store the paper**

The following are tips for storing paper:

- Always keep unused rolls wrapped in the plastic wrap to prevent discoloration. Rewrap partially used rolls if they are not being used.
- Do not stack rolls.
- Allow all paper types to adapt to room conditions out of the packaging for 24 hours before printing.
- Handle film and glossy paper by the edges or wear cotton gloves. Skin oils can be transferred to the paper, leaving fingerprint marks.
- Keep the paper tightly wound on the roll throughout the loading and unloading procedures. If the roll starts to unwind, it can become difficult to handle.

**Order paper**

The following paper types are currently provided for use with your printer.

**NOTE:** This list is likely to change over the course of time. For the latest information, see [http://www.hp.com/go/Z6200/paperpresets/](http://www.hp.com/go/Z6200/paperpresets/).

Key to geographic availability:

- (A) indicates papers that are available in Asia (excluding Japan)
- (J) indicates papers that are available in Japan
- (E) indicates papers that are available in Europe, the Middle East, and Africa
- (L) indicates papers that are available in Latin America
- (N) indicates papers that are available in North America

If the part number is not followed by parentheses, the paper is available in all regions.

**Table 4-2  Paper**

<table>
<thead>
<tr>
<th>Paper type</th>
<th>g/m²</th>
<th>Length</th>
<th>Width</th>
<th>Part numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Bond and Coated Paper</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Super Heavyweight Plus Matte Paper</td>
<td>210</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q6626A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q6627A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q6628A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
<td>Q6630A</td>
</tr>
<tr>
<td>HP Heavyweight Coated Paper</td>
<td>131</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>C6029C (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C6030C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>C6569C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1372 mm (54 in)</td>
<td>C6570C (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
<td>C6977C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>67.5 m (225 ft)</td>
<td>Q1956A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1957A (EN)</td>
</tr>
<tr>
<td>HP Universal Heavyweight Coated Paper</td>
<td>120</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q1412A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1413A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1414A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
<td>Q1416A (AEJN)</td>
</tr>
<tr>
<td>HP Coated Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>420 mm (16.54 in)</td>
<td>Q1443A (J)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>594 mm (23.39 in)</td>
<td>Q1442A (EJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>C6019B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>841 mm (33.11 in)</td>
<td>Q1441A (EJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C6020B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>C6567B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1372 mm (54 in)</td>
<td>C6568B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>91.4 m (300 ft)</td>
<td>Q1443A (J)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C6980A</td>
</tr>
<tr>
<td>Paper type</td>
<td>g/m²</td>
<td>Length</td>
<td>Width</td>
<td>Part numbers</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>------</td>
<td>--------------</td>
<td>-------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td>HP Bright White Inkjet Bond Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>420 mm (16.54 in)</td>
<td>Q1446A (J)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>594 mm (23.39 in)</td>
<td>Q1445A (EJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>C1860A (LN), C6035A (AEJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>841 mm (33.11 in)</td>
<td>Q1444A (EJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C1861A (LN), C6036A (AEJ)</td>
</tr>
<tr>
<td></td>
<td>91.4 m (300 ft)</td>
<td></td>
<td>914 mm (36 in)</td>
<td>C6810A</td>
</tr>
<tr>
<td>HP Universal Bond Paper</td>
<td>80</td>
<td>45.7 m (150 ft)</td>
<td>594 mm (23.39 in)</td>
<td>Q8003A (AJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>Q1396A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1397A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1398A</td>
</tr>
<tr>
<td></td>
<td>175 m (574 ft)</td>
<td></td>
<td>594 mm (23.39 in)</td>
<td>Q8004A (AEJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>841 mm (33.11 in)</td>
<td>Q8005A (AEJ)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q8751A (LN)</td>
</tr>
<tr>
<td>HP Recycled Bond Paper</td>
<td>80</td>
<td>45.7 m (150 ft)</td>
<td>420 mm (16.54 in)</td>
<td>CG892A (E)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>CG889A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>CG890A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>CG891A (EN)</td>
</tr>
<tr>
<td>HP Technical Paper</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Special Inkjet Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>610 mm (24 in)</td>
<td>51631D (LN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>51631E</td>
</tr>
<tr>
<td>HP Natural Tracing Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>594 mm (23.39 in)</td>
<td>Q1439A (J)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>C3869A (AE)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C3868A (AE)</td>
</tr>
<tr>
<td>HP Translucent Bond Paper</td>
<td>67</td>
<td>45.7 m (150 ft)</td>
<td>610 mm (24 in)</td>
<td>C3860A (AJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C3859A (LN)</td>
</tr>
<tr>
<td>HP Vellum Paper</td>
<td>75</td>
<td>45.7 m (150 ft)</td>
<td>610 mm (24 in)</td>
<td>C3862A (N)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C3861A (LN)</td>
</tr>
<tr>
<td>HP Film (technical and graphic)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Clear Film</td>
<td>174</td>
<td>22.9 m (75 ft)</td>
<td>610 mm (24 in)</td>
<td>C3876A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C3875A</td>
</tr>
<tr>
<td>HP Matte Film</td>
<td>160</td>
<td>38.1 m (125 ft)</td>
<td>610 mm (24 in)</td>
<td>51642A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>51642B</td>
</tr>
<tr>
<td>HP Photographic Paper</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paper type</td>
<td>g/m²</td>
<td>Length</td>
<td>Width</td>
<td>Part numbers</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>------</td>
<td>--------------</td>
<td>---------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>HP Premium Matte Photo Paper</td>
<td>210</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>CG459A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
</tr>
<tr>
<td>HP Everyday Pigment Ink Gloss Photo Paper</td>
<td>235</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q8916A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>61 m (200 ft)</td>
<td>1524 mm (60 in)</td>
<td>CG841A (E)</td>
</tr>
<tr>
<td>HP Everyday Pigment Ink Satin Photo Paper</td>
<td>235</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q8920A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>61 m (200 ft)</td>
<td>1524 mm (60 in)</td>
<td>CG842A (E)</td>
</tr>
<tr>
<td>HP Professional Satin Photo Paper</td>
<td>300</td>
<td>15.2 m (50 ft)</td>
<td>610 mm (24 in)</td>
<td>Q8759A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>44 inches = 1118 mm</td>
</tr>
<tr>
<td>HP Premium Instant-dry Gloss Photo Paper</td>
<td>260</td>
<td>30.5 m (100 ft)</td>
<td>914 mm (36 in)</td>
<td>Q7993A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1270 mm (50 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>22.9 m (75 ft)</td>
<td>610 mm (24 in)</td>
<td>Q7991A</td>
</tr>
<tr>
<td>HP Premium Instant-dry Satin Photo Paper</td>
<td>260</td>
<td>30.5 m (100 ft)</td>
<td>914 mm (36 in)</td>
<td>Q7994A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1270 mm (50 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>22.9 m (75 ft)</td>
<td>610 mm (24 in)</td>
<td>Q7992A</td>
</tr>
<tr>
<td>HP Universal Instant-dry Gloss Photo Paper</td>
<td>190</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q6574A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>61 m (200 ft)</td>
<td>1067 mm (42 in)</td>
<td>Q8754A (ELN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
</tr>
</tbody>
</table>
Table 4-2  Paper (continued)

<table>
<thead>
<tr>
<th>Paper type</th>
<th>g/m²</th>
<th>Length</th>
<th>Width</th>
<th>Part numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Universal Instant-dry Semi-gloss Photo Paper</td>
<td>190</td>
<td>30.5 m</td>
<td>610 mm (24 in)</td>
<td>Q6579A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(100 ft)</td>
<td>914 mm (36 in)</td>
<td>Q6580A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q6581A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1270 mm (50 in)</td>
<td>Q6582A (AJLN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
<td>Q6583A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>61 m (200 ft)</td>
<td></td>
<td>Q8755A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q8757A (ELN)</td>
</tr>
<tr>
<td>HP Backlit Material</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Premium Vivid Color Backlit Film</td>
<td>285</td>
<td>30.5 m</td>
<td>914 mm (36 in)</td>
<td>Q8747A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(100 ft)</td>
<td>1067 mm (42 in)</td>
<td>Q8748A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1270 mm (50 in)</td>
<td>CG924A (AJ)</td>
</tr>
<tr>
<td>HP Self-Adhesive Material</td>
<td></td>
<td></td>
<td>1372 mm (54 in)</td>
<td>C8749A</td>
</tr>
<tr>
<td>HP Universal Adhesive Vinyl</td>
<td>290</td>
<td>20.1 m</td>
<td>914 mm (36 in)</td>
<td>Q8676A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(66 ft)</td>
<td>1067 mm (42 in)</td>
<td>Q8677A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
<td>CG498A (E)</td>
</tr>
<tr>
<td>HP Colorfast Adhesive Vinyl</td>
<td>328</td>
<td>12.2 m</td>
<td>914 mm (36 in)</td>
<td>C6775A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(40 ft)</td>
<td>1372 mm (54 in)</td>
<td>C6777A (EN)</td>
</tr>
<tr>
<td>HP Everyday Adhesive Matte Polypropylene</td>
<td>180</td>
<td>22.9 m</td>
<td>610 mm (24 in)</td>
<td>CG843A</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(75 ft)</td>
<td>914 mm (36 in)</td>
<td>CG824A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>CG825A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1270 mm (50 in)</td>
<td>CG840A (AJ)</td>
</tr>
<tr>
<td>HP Banner and Sign Material</td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
<td>CG826A</td>
</tr>
<tr>
<td>HP Durable Semi-gloss Display Film</td>
<td>255</td>
<td>15.2 m</td>
<td>914 mm (36 in)</td>
<td>Q6620B (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(50 ft)</td>
<td>1270 mm (50 in)</td>
<td>Q6621B (N)</td>
</tr>
<tr>
<td>HP Opaque Scrim</td>
<td>460</td>
<td>15.2 m</td>
<td>610 mm (24 in)</td>
<td>Q8675A (N)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>(50 ft)</td>
<td>914 mm (36 in)</td>
<td>Q18988 (AEN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q18998 (AEN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1372 mm (54 in)</td>
<td>Q19018 (AN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
<td>Q19028 (AEN)</td>
</tr>
<tr>
<td>Paper type</td>
<td>g/m²</td>
<td>Length</td>
<td>Width</td>
<td>Part numbers</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>------</td>
<td>------------</td>
<td>------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>HP Matte Polypropylene</td>
<td>130</td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1903A (AEN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1904A (AEN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1372 mm (54 in)</td>
<td>Q1906A (AEN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
<td>Q1907A (AEN)</td>
</tr>
<tr>
<td>HP Everyday Matte Polypropylene</td>
<td>120</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>CH022A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>CH023A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>CH025A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1270 mm (50 in)</td>
<td>CH026A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
<td>CH027A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>61 m (200 ft)</td>
<td>CH024A (N)</td>
</tr>
<tr>
<td>HP Durable Banner with Du Pont Tyvek</td>
<td>140</td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>CG821A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>CG822A</td>
</tr>
<tr>
<td>HP Fine Art Printing Material</td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
<td>CG823A</td>
</tr>
<tr>
<td>HP Matte Litho-realistic Paper</td>
<td>270</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q7972A (ELN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q7973A (ELN)</td>
</tr>
<tr>
<td>HP Professional Matte Canvas</td>
<td>430</td>
<td>15.2 m (50 ft)</td>
<td>610 mm (24 in)</td>
<td>Q8673B (ELN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q8671A (ELN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q8674A (ELN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
<td>Q8672A (ELN)</td>
</tr>
<tr>
<td>HP Collector Satin Canvas</td>
<td>400</td>
<td>15.2 m (50 ft)</td>
<td>610 mm (24 in)</td>
<td>Q8708B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q8709A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q8710A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
<td>Q8711A (ELN)</td>
</tr>
<tr>
<td>HP Artist Matte Canvas</td>
<td>380</td>
<td>6.1 m (20 ft)</td>
<td>610 mm (24 in)</td>
<td>Q8704A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>15.2 m (50 ft)</td>
<td>Q8705A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q8706A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1524 mm (60 in)</td>
<td>Q8707A</td>
</tr>
<tr>
<td>HP Universal Matte Canvas</td>
<td>350</td>
<td>6.1 m (20 ft)</td>
<td>610 mm (24 in)</td>
<td>Q8712A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>15.2 m (50 ft)</td>
<td>Q8713A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q8714A (EN)</td>
</tr>
</tbody>
</table>
Non-recommended paper types

In many cases, paper types that HP does not support might be compatible with your printer. However, the following paper types are unlikely to give satisfactory results:

- Photo paper that swells
- Brochure paper
5 Handle the ink system

- Ink system components
- Ink system tips
- Work with ink system components
- Order ink supplies
Ink system components

Ink cartridges

The printer’s eight ink cartridges provide matte black, chromatic red, magenta, yellow, light magenta, light cyan, photo black and light gray ink to the printheads.

Ink cartridges require no maintenance or cleaning. When each ink cartridge is shaken vigorously before installation, and inserted correctly into its slot, the ink will flow to the printheads. Because the printheads control the amount of ink that is transferred to the page, high-quality printing results continue even when the ink levels are getting low.

⚠️ **CAUTION:**  Avoid touching pins, leads, and circuitry when handling ink cartridges because these elements are sensitive to electrostatic discharge. Such devices are called ESD-sensitive devices. See Glossary on page 207. Electrostatic discharges are one of the main hazards to electronics products. This type of damage can reduce the life expectancy of the device.

Replace ink cartridges

To check the ink levels in the ink cartridges, select the icon, then View ink levels.

The front panel warns you when cartridge ink level is low. When a cartridge is empty, the printer stops printing and the front panel provides an explanation.

HP recommends that you replace the empty cartridge with a new HP cartridge. See Order ink supplies on page 78, Remove an ink cartridge on page 60, and Insert an ink cartridge on page 62.

The use of refilled or non-HP ink cartridges has several serious disadvantages:

- There is some risk of damaging the printer. In this case the printer warranty will not be valid for any printer repairs that are related to the cartridge, nor for any problems due to ink contamination.
- You will invalidate the warranty of all printheads of the same color used in the printer subsequently, unless and until the whole ink system (including ink tubes) is replaced.
Print quality may be impaired.

The printer will be unable to estimate the ink level in the cartridge, and will report it as empty.

To force the printer to accept cartridges that it believes to be empty, follow these instructions:

1. Install the cartridge in the printer (see Insert an ink cartridge on page 62).

2. The front panel will complain that the cartridge is empty, and the cartridge removal process will start. Press the Cancel key to stop this automatic process.

3. At the front panel, select the icon.

4. Highlight Replace ink cartridges, but do not select it.

5. Press the Cancel key and the Up key at the same time, and hold them down for at least two seconds.

6. The front panel will display a series of warning messages. In response to each message, press the Cancel key to cancel the process, or the OK key to confirm that you wish to continue.

When you have pressed OK in response to all warning messages, the front panel will give the usual ink cartridge status display, but the cartridge will be shown as empty with a warning sign.

### Printheads

The printheads are connected to the ink cartridges. They use jet action to put ink on the paper. Each printhead has two ink-cartridge connection points and two sets of nozzles, which means that each printhead prints in two different colors. For example, the printhead below prints in magenta and yellow.

The printheads are extremely durable and do not need to be replaced every time an ink cartridge is replaced. They provide excellent results even when the ink cartridges contain a low level of ink.

To maintain optimum print quality, the printheads are automatically tested at regular intervals, and automatically serviced when necessary. This takes a little time and can occasionally delay printing.

When a printhead eventually needs to be replaced, the front panel will display a message.

To check the status of the printheads, select the icon, then View printhead status.

⚠️ **CAUTION:** Avoid touching pins, leads, and circuitry when handling ink cartridges because these elements are sensitive to electrostatic discharge. Such devices are called ESD-sensitive devices. See Glossary on page 207. Electrostatic discharges are one of the main hazards to electronics products. This type of damage can reduce the life expectancy of the device.
Maintenance cartridge

Use the maintenance cartridge to clean and maintain the printheads, ensure the best possible print quality, and seal the printheads when they are not in use to prevent them from drying out.

NOTE: The maintenance cartridge contains liquid. Therefore, store any maintenance cartridges upright and on a flat surface.

Ink system tips

For best results, always follow these guidelines:

- Install the ink cartridges, printheads, and maintenance cartridge before the install-by date, which is printed on the packaging. The expiration for the ink cartridges is the manufacturing date marked on the cartridge plus 30 months.
- Follow the instructions on the front panel during installation.
- Allow the printer and the maintenance cartridge to clean the printheads automatically.
- Avoid unnecessary removal of the ink cartridges and printheads.
- The ink cartridges should never be removed while the printer is printing. They should be removed only when the printer is ready for you to replace them. The front panel guides you through the removal and installation procedures (or see Remove an ink cartridge on page 60 and Insert an ink cartridge on page 62).
- Make sure that you comply with all applicable laws and regulations when disposing of ink system consumables.

NOTE: Shake the ink cartridges vigorously before installing them. See Insert an ink cartridge on page 62.

Work with ink system components

Remove an ink cartridge

Ink cartridges should be removed for the following two reasons:

- The ink cartridge is very low and you want to replace it with a full cartridge for unattended printing. You can use the remaining ink in the first cartridge at a more convenient time.
- The ink cartridge is empty or faulty, and you must replace it to continue printing.

CAUTION: The procedure to remove an ink cartridge must be initiated from the front panel. Do not remove an ink cartridge until the front panel prompts you.

CAUTION: Remove an ink cartridge only if you are ready to insert another one.
WARNING! Make sure that the printer wheels are locked (the brake lever is pressed down) to prevent the printer from moving.

1. At the front panel, select the icon, then select **Replace ink cartridges**.

2. Grip the blue tab in front of the cartridge that you want to remove.

3. Pull the blue tab down and then pull it outwards, towards you.

4. The cartridge comes out, in its drawer.
5. Lift the cartridge out of its drawer.

**NOTE:** Avoid touching the end of the cartridge that is inserted into the printer, because the connection might be coated with ink.

**NOTE:** If necessary, store a partially-used ink cartridge in the same position as if it were inserted in the printer. Avoid using a partially-used cartridge that has been stored on its end.

6. The front-panel display identifies the missing ink cartridge.

```
Ink cartridge missing.
Install ink cartridge
```

---

**Insert an ink cartridge**

1. Pick up the new ink cartridge and find the label that identifies the ink color. Hold the ink cartridge so that you can see the label at the top of the side that is facing you.

2. Check that the colored label above the empty slot in the printer matches the color of the label on the cartridge.

3. Shake the cartridge vigorously for about 15 seconds.

4. Insert the ink cartridge into the cartridge drawer.
5. Slide the drawer and cartridge into the slot until they lock into position.

If you have difficulty, see Cannot insert an ink cartridge on page 165.

6. The front-panel display confirms that all cartridges have been correctly inserted.

![Ink levels]

Remove a printhead

⚠️ **WARNING!** Make sure that the printer wheels are locked (the brake lever is pressed down) to prevent the printer from moving.

Printhead replacement must be performed after the printer has been turned on with the hard power switch at the back of the printer.

1. At the front panel, select the icon, then select Replace printheads.

![Ink]

2. The printer moves the carriage into the correct position.

⚠️ **CAUTION:** If the carriage remains in the removal position for more than 3 minutes without inserting or removing any printheads, it will attempt to return back to its home position to the right.
3. When the carriage has stopped moving, the front panel prompts you to open the printer window.

4. Locate the carriage on the right side of the printer.

5. Pull up and release the latch on top of the carriage.

6. Lift up the cover. This provides access to the printheads.
7. To remove a printhead, lift up the blue handle.

8. Using the blue handle, gently disengage the printhead.

9. Gently pull the blue handle upward until the printhead is released from the carriage.

Δ **CAUTION:** Do not pull abruptly. That action can damage the printhead.

10. The front-panel display identifies the missing printhead.
Insert a printhead

1. Remove the orange protective caps by pulling them down.

2. The printhead is designed to prevent you from accidentally inserting it into the wrong slot. Check that the colored label on the printhead matches the colored label of the carriage slot into which the printhead is to be inserted.

3. Insert the new printhead into its correct slot in the carriage.

   △ **CAUTION:** Insert the printhead slowly and vertically, straight down. It can be damaged if you insert it too quickly, or at an angle, or if you rotate it as you insert it.

4. Push down as indicated by the arrow.

   △ **CAUTION:** You might feel some resistance when installing the new printhead, so you need to press it down firmly but smoothly. You should hear a beep and see confirmation on the front-panel display that the printhead has been inserted. If you have difficulty, see *Cannot insert a printhead* on page 165.
5. Insert all of the other printheads that need to be installed, and close the carriage cover.

![Inserting printheads](image1.png)

6. Make sure that the end of the blue handle catches the wire loop on the near side of the carriage.

![Catching wire loop](image2.png)

7. Lower the handle to rest on the carriage cover.

![Lowering handle](image3.png)

When all of the printheads have been inserted correctly and the printer has accepted them, the printer beeps.

**NOTE:** If the printer does not beep when you insert the printhead and the Replace message appears on the front-panel display, you might need to reinsert the printhead.

8. Close the printer window.

![Closing printer window](image4.png)

9. The front-panel display confirms that all of the printheads are correctly inserted. The printer starts checking and preparing the printheads. The default routine process, when all printheads are
changed, takes about 18 minutes. If the printer identifies a problem when preparing the printheads, the process takes longer, up to 30 minutes. For a single printhead insertion, the time varies between 10 and 20 minutes. After all printheads are checked and prepared, the printhead realignment procedure runs automatically if paper is loaded. See Align the printheads on page 71.

**Clean (recover) the printheads**

To clean the printheads (which often enables them to recover from problems), go to the printer’s front panel and select the icon, then select **Clean printheads**. Specify which printheads you would like to clean. You can clean all of the printheads or only some of them.

Cleaning all printheads takes about 5 minutes. Cleaning any two printheads takes about 3 minutes.

**NOTE:** Cleaning all printheads uses more ink than cleaning a single pair.

**NOTE:** HP recommends that you purge the ink from the printheads before printing a job if the printer has been turned off for more than six weeks or if you are experiencing inconsistent colors from print to print after long storage periods. Purging the ink from the printheads helps to ensure maximum color consistency; it is **not** a remedy for poor printhead health.

**Clean the electrical connections on a printhead**

It is possible that the printer will not recognize a printhead after it has been installed. This can happen when ink builds up on the electrical connections between the printhead and the printhead carriage. Under these circumstances, HP recommends that you clean the electrical connections on the printhead. However, routine cleaning of the connections when no problems are apparent is **not** recommended.

Use an absorbent lint-free cloth, slightly dampened with isopropyl alcohol, to clean the electrical interconnects on both the printhead carriage and the printhead if the **Reseat** or **Replace** message persists next to the printhead on the front-panel display.

1. Open the printhead carriage latch and extract the printhead that is causing the problem, as indicated on the front panel. See Remove a printhead on page 63.
2. Cover your finger with the cloth and insert it into the printhead slot at the back.

**CAUTION:** If the carriage remains in the central part of the printer for more than 7 minutes, it attempts to return to its home position to the right.
3. Rub the cloth against the electrical contacts with a light force along the entire depth of the flex connector. Try to avoid picking up any ink deposit that may have accumulated on the bottom surface of the slot.

4. Take special care to clean all contacts thoroughly, including the ones at the lowest point of the connector.

5. Using the same cloth, clean the strip of electrical contacts on the printhead (unless the printhead is new). Avoid touching the printhead nozzles.

\[\textbf{CAUTION:}\] Do not touch the surface of the printhead that contains the nozzles, because the nozzles are easily damaged.

6. After waiting a few moments to allow both connectors to dry, replace the printhead into the printhead carriage. See \textit{Insert a printhead on page}\ 66.

7. Wash or dispose of the cloth. Take care to prevent the transfer of ink onto hands and clothing.

If the front panel continues to show the \textbf{Reseat} or \textbf{Replace} message, replace the printhead or contact your HP customer service representative.

\begin{center}
\textbf{Clean the printhead drop detector}
\end{center}

The printhead drop detector is a sensor that detects which nozzles on the printheads are not printing, so that other nozzles can substitute for them. If particles block the sensor (such as fibers, hair or small pieces of paper), print quality is affected.

When the front panel displays a warning message that the drop detector needs cleaning, you are recommended to clean it. If you do not clean it immediately, the printer continues working normally, but the front panel display continues to show the warning.

\[\textbf{CAUTION:}\] Wear gloves to avoid getting ink on your hands.
1. On the printer’s front panel, select the icon, then select **Replace printheads**.

2. Turn off the printer at the front panel.

3. To avoid an electric shock, switch the printer off and unplug it.

4. Open the printer window.

5. Find the printhead drop detector to the right of the printhead carriage.

6. Remove any debris blocking the printhead drop detector.
7. With a dry, lint-free cloth, wipe the surface of the drop detector to remove any non-visible debris.

8. Close the printer window.

9. Plug in and switch on the printer.

10. Power the printer on at the front panel.

**Align the prinheads**

Precise alignment between printheads is essential for accurate colors, smooth color transitions and sharp edges in graphical elements. Your printer has an automatic printhead alignment process which runs whenever a printhead has been accessed or replaced.

If the paper has jammed or you are experiencing problems with color accuracy, you may need to align the printheads.

**NOTE:** If the paper has jammed, it is recommended that you reinsert the printheads and initiate the realignment procedure from the Image Quality Maintenance menu.

**CAUTION:** Do not use transparent or semi-transparent paper to align the printheads.

**Reinsert printheads procedure**

1. If the realignment process is running and the wrong paper is loaded, press the Cancel key on the front panel.

   **CAUTION:** Do not print if the realignment process has been canceled. You can restart the alignment with the Image Quality Maintenance menu procedure.

2. Load the paper you wish to use, see [Handle the paper on page 29](#). You can use a roll or cut sheet, however, it must be A3 landscape or larger.

   **CAUTION:** Do not use transparent or semi-transparent paper to align the printheads.
3. Remove and re-insert all the printheads, see Remove a printhead on page 63 and Insert a printhead on page 66. This starts the printhead alignment procedure.

4. Ensure the window is closed, as a strong light source near the printer during printhead realignment can affect alignment.

5. The process takes about six minutes. Wait until the front-panel display shows the process complete before using the printer.

   **NOTE:** The printer prints a calibration image. Do not worry about the image. The front-panel display shows any errors in the process.

---

**Image Quality Maintenance menu procedure**

1. Load the paper you wish to use, see Handle the paper on page 29. You can use a roll or cut sheet, which must be A3 landscape or larger: 420 × 297 mm (16.54 × 11.69 in).

   **CAUTION:** Do not use transparent or semi-transparent paper to align the printheads.

2. From the front panel, select the Image Quality Maintenance menu icon, then **Align printheads**. The printer checks to see if it has enough paper to run the realignment.

3. If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern. Ensure the window is closed, as a strong light source near the printer during printhead realignment can affect alignment.

4. The process takes about five minutes. Wait until the front-panel display shows the process complete before using the printer.

---

**Scanning errors during alignment**

If the alignment process fails, a Scanning problems message appears on the front panel. This means that the alignment has not completed successfully. Therefore the printer is not aligned and the alignment should be repeated before printing with good image quality. The problem may be due to:

- The paper used was not valid, repeat the alignment with valid paper
- Printhead health problems, clean printheads, see Clean the printheads on page 165
- The alignment was done with the window open, repeat the alignment with the window closed

If the problem persists after using valid paper, cleaning the printheads and keeping the window closed, there may be a failure in the scanning system needing reparation or the printheads, although clean, may not work and need to be replaced.

**The Image Diagnostics Print**

The Image Diagnostics Print consists of patterns designed to highlight printhead reliability problems. It helps you to check the performance of the printheads that are currently installed in your printer, and whether any printhead suffers from clogging or other problems.
To print the Image Diagnostics Print:

1. Use the same paper type that you were using when you detected a problem.

2. Use the \[i\] key on the front panel to check that the selected paper type is the same as the paper type loaded into the printer.

3. At the printer’s front panel, select the Image Quality Maintenance menu icon \[\text{Icon}\], then Print diagnostic image.

It takes about two minutes to print the Image Diagnostics Print.

The print is divided into two parts, both of which test printhead performance.

- Part 1 (top) consists of rectangles of pure colors, one for each printhead. This part represents the print quality that you will get from each color.

- Part 2 (bottom) consists of small dashes, one for each nozzle on each printhead. This part complements the first, and aims more specifically to detect how many faulty nozzles each printhead has.

Please look carefully at the print. The names of the colors are shown above the rectangles and in the center of the patterns of dashes.

First look at the upper part of the print (part 1). Each colored rectangle should be a uniform color without any horizontal lines across it.

Then look at the bottom part of the print (part 2). For each individual colored pattern, check that most of the dashes are present.

If you see horizontal lines in part 1 and also missing dashes in part 2 for the same color, the printhead responsible needs cleaning. However, if the rectangles look solid, do not worry about just a few missing dashes in part 2; these are acceptable because the printer can compensate for a few clogged nozzles.

Here is an example of a gray printhead in a good state:
And here is an example of the same printhead in a bad state:

Corrective action

1. Clean any faulty printheads (see Clean the printheads on page 165). Then reprint the Image Diagnostics Print to see whether the problem has been solved.

2. If the problem remains, clean the printheads again, and reprint the Image Diagnostics Print to see whether the problem has been solved.

3. If the problem remains, consider cleaning your printheads manually (see Clean the printheads on page 165). You could also try reprinting your current print job, in case it now prints satisfactorily.

4. If the problem remains, try cleaning the printhead drop detector. The printer normally notifies you when this is necessary, but it may be worth trying even if the printer has not suggested it. See Clean the printhead drop detector on page 69.

5. If the problem still remains, replace any persistently faulty printheads (see Handle the ink system on page 57), or contact HP Support (see HP Customer Care on page 176).

Remove the maintenance cartridge

A message appears on the front panel when you must change the maintenance cartridge. Follow these precautions when removing a maintenance cartridge:

- Be careful not to get ink on your hands. Ink might be on, around, and inside the replaced maintenance cartridge.

- Always handle and store the replaced maintenance cartridge upright to avoid spilling any ink.
⚠️ **CAUTION:** A message appears on the front panel when the maintenance cartridge is almost full and again when it is completely full and must be changed. You can ignore the alert and continue printing by pressing the OK key on the front panel. However, HP strongly recommends that you change the maintenance cartridge when prompted. Ignoring the alert can result in serious damage to the printer.

⚠️ **WARNING!** Make sure that the printer wheels are locked (the brake lever is pressed down) to prevent the printer from moving.

1. At the front panel, select the ⚗️ icon, then select **Replace maintenance ctg**.

2. The maintenance cartridge is located in a slot underneath the front panel, at the front of the printer. Open the door.

3. The maintenance cartridge has a handle on the front. To remove the cartridge, press inward and upward as indicated by the arrow, until the cartridge is released.

4. Lift up the maintenance cartridge to remove it from the slot, and slide it out.
See also Insert the maintenance cartridge on page 76.

**Insert the maintenance cartridge**

The plastic bag in which the new maintenance cartridge comes can be used to dispose of the old maintenance cartridge.

1. Insert the maintenance cartridge into the slot, in the direction indicated by the arrow.

2. When the maintenance cartridge has been pushed all the way in, press inwards and downwards as indicated, until it clicks into place.

If you have difficulty, see Cannot insert the maintenance cartridge on page 165.

**NOTE:** The front panel will not show the new maintenance cartridge until the door is closed.

3. When you have inserted the maintenance cartridge into the printer, close the door.

**NOTE:** The printer needs all the ink cartridges, printheads and maintenance cartridge to be installed before it can continue.

4. If no paper is loaded, the front panel will instruct you to load some.

**NOTE:** Make sure that the printer window and the door to the right are closed after you replace the supplies. The printer will not print while these are open.
Check the status of the ink system

2. Go to the Supplies page on the Main tab.

The Supplies page shows you the status of the ink cartridges (including the ink levels), the printheads, the maintenance cartridge, and the loaded paper.

View ink cartridge information

You can view information about your ink cartridges using the front panel or the HP Utility.

Front panel procedure

1. At the front panel, select the icon, then Ink cartridge information.
2. Select the cartridge about which you want information.
3. The front panel shows the following information:
   - Color
   - Product name
   - Product number
   - Serial number
   - Status
   - Ink level, if known
   - Total ink capacity in milliliters
   - Expiration date
   - Warranty status
   - Manufacturer
HP Utility procedures

- In the HP Utility for Windows, go to the **Overview** tab. The status of each cartridge appears when you select **Supply Status > Cartridges**.
- In the HP Utility for Mac OS, select **Information > Printer Status**.

View printhead information

The printer automatically checks and services the printheads after each print. Follow these steps to get more information on your printheads.

1. At the front panel, select the **icon, then Printhead information**.
2. Select the printhead for which you want to see information.
3. The front panel shows the following information:
   - Colors
   - Product name
   - Product number
   - Serial number
   - Status (see **Front-panel error messages on page 199**)
   - Volume of ink it has used
   - Warranty status

You can also get most of this information without leaving your computer by using the HP Utility.

**NOTE:** If the status is **See warranty note**, this indicates that non-HP ink is being used. Printer service or repairs required as a result of using non-HP ink are not covered under warranty. See the **Legal Information** document for detailed warranty implications.

Order ink supplies

You can order the following ink supplies for your printer.

**Table 5-1 Ink cartridges**

<table>
<thead>
<tr>
<th>Cartridge</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP 771 775 ml Matte Black Designjet Ink Cartridge</td>
<td>CE037A</td>
</tr>
<tr>
<td>HP 771 775 ml Chromatic Red Designjet Ink Cartridge</td>
<td>CE038A</td>
</tr>
<tr>
<td>HP 771 775 ml Magenta Designjet Ink Cartridge</td>
<td>CE039A</td>
</tr>
<tr>
<td>HP 771 775 ml Yellow Designjet Ink Cartridge</td>
<td>CE040A</td>
</tr>
<tr>
<td>HP 771 775 ml Light Magenta Designjet Ink Cartridge</td>
<td>CE041A</td>
</tr>
<tr>
<td>HP 771 775 ml Light Cyan Designjet Ink Cartridge</td>
<td>CE042A</td>
</tr>
<tr>
<td>HP 771 775 ml Photo Black Designjet Ink Cartridge</td>
<td>CE043A</td>
</tr>
<tr>
<td>HP 771 775 ml Light Gray Designjet Ink Cartridge</td>
<td>CE044A</td>
</tr>
<tr>
<td>Table 5-2 Printheads</td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td><strong>Printhead</strong></td>
<td><strong>Part number</strong></td>
</tr>
<tr>
<td>HP 771 Matte Black &amp; Chromatic Red Designjet Printhead</td>
<td>CE017A</td>
</tr>
<tr>
<td>HP 771 Magenta &amp; Yellow Designjet Printhead</td>
<td>CE018A</td>
</tr>
<tr>
<td>HP 771 Light Magenta &amp; Light Cyan Designjet Printhead</td>
<td>CE019A</td>
</tr>
<tr>
<td>HP 771 Photo Black &amp; Light Gray Designjet Printhead</td>
<td>CE020A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Table 5-3 Maintenance cartridge</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Maintenance cartridge</strong></td>
<td><strong>Part number</strong></td>
</tr>
<tr>
<td>HP 771 Designjet Maintenance Cartridge</td>
<td>CH644A</td>
</tr>
</tbody>
</table>

Handle the ink system
6 Print options

- Create a print job
- Select print quality
- Print a draft
- High-quality printing
- Select paper size
- Select margins options
- Print on loaded paper
- Rescale a print
- Preview a print
- Print 16-bit color images
- Change the treatment of overlapping lines
- Print crop lines
- Rotate an image
- Print in gray shades
- Use paper economically
- Nest jobs to save paper
- Use ink economically
Create a print job

In order to print something, you must send it to the printer. This constitutes a print job, which is entered into the printer’s print queue. There are two main ways of sending a print job to the printer:

- To print directly from a program, use the program’s Print command as usual. When you select your printer, the printer driver is invoked to send your job to the printer.

- If you have a file that is already in a supported graphical format, you can use the Embedded Web Server to send it directly to the printer without going through a printer driver (see below).

Using the Embedded Web Server to print files

From the HP Utility or the Embedded Web Server, select Submit Job in the Job Center group. You will see the window below.

Press the Add files button to choose the files from your computer that you want to print. The files must be in one of the following formats:

- PDF
- PostScript
- TIFF
- JPEG
- CALS/G4

NOTE: When you print to a file, the file should be in one of the above formats, but its name may have an extension such as .plt or .prn.

If the files are not in one of these formats, they will not be printed successfully.

If the jobs have been generated with the appropriate settings (such as page size, rotation, resizing and number of copies), you can just press the Print button and they will be sent to the printer.
If you need to specify printing settings, go to the Job settings section and select the options you need. Each option has explanatory text on the right, so that you can understand the behavior of each setting. Remember that, if you leave the setting as Default, the setting saved in the job will be used. If the job contains no setting, the setting in the printer will be used.

**Printing stored jobs**

When you print a file with the Embedded Web Server, you can mark the job to be stored permanently in the printer.

If you select Stored jobs in printer in the Main tab of the Embedded Web Server, you will see a list of the stored jobs. The information displayed for each job includes:

- The name of the job
- The size of the job
- The date and time when the job was received by the printer
- The name given by the person who submitted the job

You can click on the title of any column to sort the list by the information in that column.

You can select one or more jobs in the list and perform the following operations on them by using the buttons at the top of the list.

- **Print**: The selected jobs are printed with the original settings. You will be able to see the progress of your jobs on the Job queue page.

- **Advanced print**: The settings of the selected jobs are displayed, and you can modify them. You can save the new settings by pressing the Save button, and print the jobs by pressing the Print button.

  The value of a setting is shown only if it has the same value in all of the selected jobs. Otherwise, a hyphen is shown.

- **Delete**: The selected jobs are permanently deleted from the printer.

**Select print quality**

The printer has various print-quality options because best-quality printing requires some loss of speed, while fast printing implies some reduction in print quality.

Therefore, the standard print-quality selector is a slider that allows you to choose between quality and speed.

Alternatively, you can select from the custom options: **Best**, **Normal** and **Fast**. If you select **Fast**, you can also select **Economode**, which uses a lower rendering resolution and consumes less ink. It therefore increases printing speed even further, but reduces print quality. **Economode** can be selected only from the custom options (not from the slider).

There are also two supplementary custom options that may have an effect on print quality: **Max. resolution** and **Unidirectional**. See High-quality printing on page 84.

**NOTE:** In the Windows driver dialog, the rendering and printing resolutions for your job are displayed in the Paper/Quality tab. In the Mac OS Print dialog, they are displayed in the Summary panel.
You can select print-quality options in the following ways:

- **In the Windows driver dialog:** go to the Paper/Quality tab and look at the Print Quality section. If you select Standard Options, you will see a simple slider with which you can select speed or quality. If you select Custom Options, you will see the more specific options described above.

- **In the Mac OS X 10.4 Print dialog:** go to the Image Quality panel. If you select Standard quality options, you will see a simple slider with which you can select speed or quality. If you select Custom quality options, you will see the more specific options described above.

- **In the Mac OS X 10.5 or 10.6 Print dialog:** go to the Paper/Quality panel and look at the Quality Options section. If you select Standard quality options, you will see a simple slider with which you can select speed or quality. If you select Custom quality options, you will see the more specific options described above.

- **On the Embedded Web Server’s Submit Job page:** select Basic settings > Print quality. If you then select Standard options, you can choose between Speed and Quality. If you select Custom options, you will see the more specific options described above.

- **Using the front panel:** select the Setup menu icon , then Printing preferences > Print quality.

**NOTE:** If you have set the print quality from your computer, that overrides the print-quality setting in the front panel.

**NOTE:** You cannot change the print quality of pages that the printer is already receiving or has already received (even if they have not started to print yet).

## Print a draft

You can specify fast draft-quality printing in the following ways:

- **In the Windows driver dialog:** go to the Paper/Quality tab and look at the Print Quality section. Move the print-quality slider to the extreme left (’Speed’).

- **In the Mac OS X 10.4 Print dialog:** go to the Image Quality panel and move the print-quality slider to the extreme left (’Speed’).

- **In the Mac OS X 10.5 or 10.6 Print dialog:** go to the Paper/Quality panel and move the print-quality slider to the extreme left (’Speed’).

- **On the Embedded Web Server’s Submit Job page:** select Basic settings > Print quality > Standard options > Speed.

You can specify even faster draft-quality printing by using Economode, as follows. This is intended mainly for documents containing only text and line drawings.

- **In the Windows driver dialog:** go to the Paper/Quality tab and look at the Print Quality section. Select Custom Options, then set the quality level to Fast and check the Economode box.

- **In the Mac OS X 10.4 Print dialog:** go to the Image Quality panel and set the quality options to Custom, then set quality to Fast and check the Economode box.
- In the Mac OS X 10.5 or 10.6 Print dialog: go to the Paper/Quality panel and set the quality options to Custom, then set quality to Fast and check the Economode box.

- On the Embedded Web Server’s Submit Job page: select Basic settings > Print quality > Custom. Set Quality level to Fast, and Economode to On.

High-quality printing

You can specify high-quality printing in the following ways:

- In the Windows driver dialog: go to the Paper/Quality tab and look at the Print Quality section. Move the print-quality slider to the extreme right (‘Quality’).

- In the Mac OS X 10.4 Print dialog: go to the Image Quality panel and move the print-quality slider to the extreme right (‘Quality’).

- In the Mac OS X 10.5 or 10.6 Print dialog: go to the Paper/Quality panel and move the print-quality slider to the extreme right (‘Quality’).


Printing is bidirectional by default (the printheads print when travelling in both directions across the paper), but you can choose Unidirectional printing for a further small improvement in quality at the expense of speed. This option is not available if you have chosen Fast print quality.

If you have a high-resolution image

If your image has a resolution greater than the rendering resolution (which you can see in the driver’s Paper/Quality tab under Windows), print sharpness may be improved by selecting the Max. resolution option. This option is available only if you are printing on glossy paper and you have selected Best print quality.

- In the driver dialog (Mac OS Print dialog): select custom instead of standard print-quality options, then check the Max. resolution box.

- On the Embedded Web Server’s Submit Job page: select Basic settings > Print quality > Custom. Set Quality level to Best, and Max. resolution to Yes.

**NOTE:** The Max. resolution option results in slower printing with photo papers, but it does not increase the amount of ink used.

Select paper size

The paper size can be specified in the following ways.

**NOTE:** The paper size specified here should be the paper size in which the document was created. It is possible to rescale the document to a different size for printing. See Rescale a print on page 86.

- In the Windows driver dialog: select the Paper/Quality tab, then select your paper size from the Document Size list.

- In the Mac OS Page Setup dialog: select your printer in the Format for popup menu, then Paper Size.

**NOTE:** If your application offers no Page Setup dialog, please use the Print dialog.

Using the front panel: select the Setup menu icon , then Printing preferences > Paper options > Select paper size.

**NOTE:** If you have set the paper size from your computer, that overrides the paper size setting in the front panel.

**NOTE:** If you have disabled skew checking, the paper length is estimated as four times the width.

**TIP:** If your document is 330 × 483 mm (13 × 19 in), designed to fit on sheet paper of the same size, select the document size Super B/A3.

Custom paper sizes

To choose a non-standard paper size not shown in the list of paper sizes:

- **Under Windows,** there are two different ways:
  - In the driver dialog, press the Custom button in the Paper/Quality tab, then specify the name and dimensions of your new paper size, then click Save to save your new paper size. In the PostScript driver, to see your new custom size in the list of custom sizes, you need to exit the printer properties, then reenter them (and use the More button if necessary).

  **NOTE:** The driver will not allow you to create a paper size whose width exceeds its length.

  - From the Start menu, select Printers, then from the File menu select Server Properties. In the Forms tab, check the Create a new form box, specify the name and dimensions of the new form, then click Save Form.

  **NOTE:** Such forms are not available when using a shared printer that is connected to a different computer.

- **In the Mac OS Page Setup dialog:** select Paper Size > Manage Custom Sizes.

  **NOTE:** If your application offers no Page Setup dialog, please use the Print dialog.

- **On the Embedded Web Server’s Submit Job page:** select Advanced settings > Paper > Page size > Custom.

Select margins options

By default, the printer leaves a 5 mm (0.2 in) margin between the edges of your image and the edges of the paper. However, you can change this behavior in several ways.

- **In the Windows driver dialog:** select the Paper/Quality tab and then the Margins/Layout button.

  **TIP:** In the Windows PostScript driver, make sure you have made the right choice from the Document size list. You should select a ‘no margins’ document size if you intend to use the Oversize, Clip Contents By Margins or Borderless options.

- **In the Mac OS X 10.4 Print dialog:** select the Finishing panel and then Layout.
In the Mac OS X 10.5 or 10.6 Print dialog: select the Margins/Layout panel.

On the Embedded Web Server’s Submit Job page: select Advanced settings > Paper > Layout/Margins.

You will then see at least some of the following options.

- **Standard.** Your image will be printed on a page of the size you have selected, with a narrow margin between the edges of the image and the edges of the paper. The image should be small enough to fit between the margins.

- **Oversize.** Your image will be printed on a page slightly larger than the size you have selected. If you cut off the margins, you will be left with a page of the size you selected, with no margins remaining between your image and the edges of the paper.

- **Clip Contents By Margins.** Use this option when your image has white borders and a size equal to that of the paper you have selected. The printer will use the white border for its margins and you will get a page of size equal to that which is selected in the driver.

- **Borderless.** Your image will be printed on a page of the size you have selected, with no margins. The image is slightly enlarged to ensure that no margin is left between the edges of the image and the edges of the paper. If you select Automatically by Printer, this enlargement is done automatically. If you select Manually in Application, you should ensure that the image size in your application is slightly larger than the paper size.

**Print on loaded paper**

To print a job on whichever paper is loaded in the printer, select Any in the Paper Type option of your printer driver.

- **In the Windows driver dialog:** select the Paper/Quality tab, then select Any in the Paper Type drop-down list.

- **In the Mac OS X 10.4 Print dialog:** select the Image Quality panel, then select Any in the Paper Type drop-down list.

- **In the Mac OS X 10.5 or 10.6 Print dialog:** select the Paper/Quality panel, then select Any in the Paper Type drop-down list.

**NOTE:** Any is the default Paper Type selection.

**Rescale a print**

You can send an image to the printer at a certain size but tell the printer to rescale it to a different size (normally larger). This may be useful if your software does not support large formats.
You can rescale an image in the following ways:

- **In the Windows driver dialog:** go to the **Features** tab and look at the Resizing Options section.
  - The **Print document on** option adjusts the image size to the paper size you have selected. For example, if you have selected ISO A2 as the paper size and you print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer reduces a larger image to fit the A4 size.
  - The **% of actual size** option enlarges the printable area of the original paper size (the page minus the margins) by the percentage indicated, then adds the margins to create the output paper size.

- **In the Mac OS Print dialog:** select the **Finishing** panel, then **Print document on** to adjust the image size to the paper size you have selected. For example, if you have selected ISO A2 as the paper size and you print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer reduces a larger image to fit the A4 size.

- **On the Embedded Web Server’s Submit Job page:** select **Advanced settings > Resizing**.
  - The **Standard** and **Custom** options adjust the image size to the standard or custom paper size you have selected. For example, if you have selected ISO A2 as the paper size and you print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer reduces a larger image to fit the A4 size.
  - The **% of actual size** option enlarges the printable area of the original paper size (the page minus the margins) by the percentage indicated, then adds the margins to create the output paper size.

- **Using the front panel:** select the Setup menu icon, then **Printing preferences > Paper options > Resize**.

  If you are printing to a single sheet, you must ensure that the image can actually fit onto the sheet, otherwise the image will be clipped.

**Preview a print**

Previewing a print on the screen allows you to check the layout of the print before printing, which may help you to avoid wasting paper and ink on a bad print.
NOTE: If you load sheet paper with skew checking disabled, the printer does not measure the length of the sheet, so the print preview will not be a reliable guide to the final printout.

- To preview a print under Windows, you have the following options:
  - Use your application’s print preview option.
  - Check the Show preview before printing option, which you can find in the driver’s Paper/Quality tab and Features tab. The preview may be provided in different ways, depending on your printer and printer driver.

- To preview a print under Mac OS, you have the following options:
  - Use your application’s print preview option.
  - Click the Preview button at the bottom of the Print dialog box. This is the basic print preview provided by Mac OS.
  - Check the Show print preview option, which you can find in the driver’s Printing dialog, in the Finishing panel.

- To preview a print using the Embedded Web Server, select Basic settings > Hold for preview.

Print 16-bit color images

In a 16-bit RGB image, each of the three primary colors is encoded by a 16-bit value, so that each pixel takes up 48 bits.

If you print your 16-bit color images through a printer driver, they will be reduced to 8-bit colors before they reach the printer.

In order to send a 16-bit color image to the printer, you must save it as a 16-bit color TIFF or JPEG file, then send the file directly to the printer without using a printer driver (see Using the Embedded Web Server to print files on page 81). In this case, color management is done on the 16-bit color image, and is therefore done more accurately. The image is still reduced to 8-bit colors for final printing.

TIP: Some applications refuse to save a 16-bit color image in JPEG format; others automatically reduce it to 8-bit colors. A TIFF file generally gives a higher-quality result, and is recommended.

Change the treatment of overlapping lines

NOTE: This topic applies only when printing an HP-GL/2 job.

The merge option controls the overlapping lines in an image. There are two settings:

- Off: where the lines cross, only the color of the top line is printed. This is the default setting.
- On: where the lines cross, the colors of the two lines merge.

To turn merge on, go to the front panel and select the Setup menu icon then Printing preferences > HP-GL/2 options > Enable merge. You can set the merge option from your software in some applications. Settings in your software override the front-panel settings.
Print crop lines

Crop lines indicate where the paper should be cut to reduce it to your selected page size. You can print crop lines automatically with individual jobs in the following ways:

- **In the Windows driver dialog**: select the **Features** tab, then **Enable crop lines**.
- **In the Mac OS Print dialog**: go to the **Finishing** panel and select **Enable crop lines**.
- **On the Embedded Web Server’s Submit Job page**: select **Advanced settings > Roll options > Enable crop lines**.
- **Using the front panel**: select the Setup menu icon ( ), then **Printing preferences > Paper options > Enable crop lines > On**.

To print crop lines with nested jobs (see [Nest jobs to save paper on page 92](#)), you must select a different option:

- **In the Embedded Web Server**: select **Job management > Use crop lines when nest is enabled > On**.
- **Using the front panel**: select the Setup menu icon ( ), then **Job management > Nest options > Enable crop lines > On**.

Rotate an image

By default, images are printed with their shorter sides parallel to the leading edge of the paper, like this:

You may wish to rotate your images by 90 degrees in order to save paper, like this:
You can do this in the following ways:

- **In the Windows driver dialog:** select the Features tab, then Rotate by 90 degrees.
- **In the Mac OS Print dialog:** go to the Finishing panel and select Rotate by 90 degrees.
- **On the Embedded Web Server's Submit Job page:** select Advanced settings > Roll options > Rotate.
- **In the front panel:** select the Setup menu icon 🗠️, then Printing preferences > Paper options > Rotate.

**NOTE:** If rotation is set from your computer, it overrides the setting in the front panel.

**NOTE:** When you rotate a job, the page length may be increased to avoid clipping, because the top and bottom margins are usually larger than the side margins.

**NOTE:** If you rotate an image to landscape whose original orientation was portrait, the paper may not be wide enough for the image. For example, rotating a portrait D/A1-size image on D/A1-size paper by 90 degrees will probably exceed the width of the paper. If you are using the Embedded Web Server, the preview screen will confirm this with a warning triangle.

### Autorotate

The Autorotate option automatically rotates jobs by 90 degrees if doing so will save paper.

Autorotation allows you to defer the decision of rotating a page until printing time. This may be useful if you routinely work with different roll sizes and want to ensure that plots will not get clipped or waste unnecessary paper width if and when roll conditions change.

To enable autorotation:

- **In the Windows driver dialog:** select the Features tab, then Autorotate.
- **In the Mac OS Print dialog:** go to the Finishing panel and select Autorotate.
- **On the Embedded Web Server's Submit Job page:** select Advanced settings > Roll options > Autorotate.
- **In the front panel:** select the Setup menu icon 🗠️, then Job management > Autorotate.

**NOTE:** If autorotation is set from your computer, it overrides the setting in the front panel.

**NOTE:** If autorotation is enabled, the Rotate option is ignored.
**NOTE:** The autorotate decision requires known page dimensions. Therefore, the job must have **When to Start Printing** set to **After Processing** (see Select when to print a job in the queue on page 114) and cannot have variable dimensions, which happens when **Fit to roll** or **Remove top/bottom blank areas** is used.

**TIP:** Once the job is rendered and ready for reprints, autorotation may take a few minutes, depending on job dimensions and resolution. To speed up autorotated reprints, send the job to render when the roll configuration meets your planned scenario, and leave last-minute autorotation only to correct unexpected changes in roll conditions. This applies to TIFF/JPEG/PS/PDF jobs only.

---

### Print in gray shades

You can convert all colors in your image to shades of gray in the following ways:

- **In your application program:** many programs provide this option.
- **In the Windows driver dialog:** go to the **Color** tab and look at the Color Options section. Select **Print in Grayscale**.
- **In the Mac OS X 10.4 Print dialog:** go to the **Color Options** panel and select **Print In Grayscale**.
- **In the Mac OS X 10.5 or 10.6 Print dialog:** go to the **Color Options** panel and select **Grayscale** from the Mode drop-down list.
- **On the Embedded Web Server's Submit Job page:** select **Color > Color/Grayscale > Print in grayscale**.

### Use paper economically

Here are some recommendations for making economical use of paper:

- If you are printing relatively small images or document pages, you can use nesting to print them side by side instead of one after another. See Nest jobs to save paper on page 92.

- If you are printing multipage documents with relatively small pages, you can print up to 16 of them on one sheet of paper. Use the **Pages per sheet** option in the **Features** tab (Windows driver) or the **Layout** panel (Mac OS driver).

- You may be able to save some roll paper by using the following options:
  - **In the Windows driver dialog:** select the **Features** tab and then **Remove Top/Bottom Blank Areas** and/or **Rotate by 90 degrees** or **Autorotate**.
  - **In the Mac OS Print dialog:** select the **Finishing** panel, then **Remove Top/Bottom Blank Areas** and/or **Rotate by 90 degrees** or **Autorotate**.
  - **On the Embedded Web Server's Submit Job page:** select **Advanced settings > Roll options > Remove top/bottom blank areas** and/or **Rotate**.

- If you check the print preview on your computer before printing, you can sometimes avoid wasting paper on prints containing obvious mistakes. See Preview a print on page 87.
Nest jobs to save paper

Nesting means automatically printing images or document pages side by side on the paper, rather than one after the other. This is done to avoid wasting paper.

1. Direction of paper flow
2. Nesting off
3. Nesting on
4. Paper saved by nesting

When does the printer try to nest pages?

When Nest is On in the front panel’s Job Management menu and the Embedded Web Server’s Job Management page.

What pages can be nested?

All pages can be nested, unless they are so large that two of them cannot fit side by side on the roll, or unless there are too many of them to fit into the remaining length of the roll. A single group of nested pages cannot be split between two rolls.

Which pages qualify for nesting?

In order to be in the same nest, the individual pages must be compatible in all of the following ways:

- All pages must have the same print quality setting (Economode, Fast, Normal or Best).
- The Max. resolution and Unidirectional setting must be the same on all pages.
- The Margins setting must be the same for all pages.
- The Mirror Image setting must be the same for all pages.
- The Cutter setting must be the same for all pages.
- The color adjustment settings must be the same for all pages. See Color-adjustment options on page 105.
- Pages must be all color, or all grayscale: not some in color and some in grayscale.
All pages must be in one or other of the following two groups (the two groups cannot be mixed in the same nest):

- CALS/G4
- PostScript, PDF, TIFF, JPEG

JPEG, TIFF and CALS/G4 pages with resolutions greater than 300 dpi may not nest with other pages in some cases.

**How long does the printer wait for another file?**

So that the printer can make the best nest possible, it waits after a file has been received to check whether a subsequent page will nest with it or with pages already in the queue. This waiting period is the nest wait time; the factory default nest wait time is two minutes. This means that the printer waits for up to two minutes after the last file is received before printing the final nest. You can change this waiting time from the printer’s front panel: select the Setup menu icon, then Job management options > Nest options > Select wait time. The available range is 1 to 99 minutes.

While the printer is waiting for nesting to time out, it displays the remaining time on the front panel. You can print the nest (cancel the nest wait) by pressing the Form feed and cut key.

**Use ink economically**

Here are some recommendations for making economical use of ink.

- For draft prints, use plain paper and move the print-quality slider to the left end of the scale (‘Speed’). For further economy, select custom print quality options, then select Fast and Economode.

- Clean the printheads only when needed, and clean only those printheads that need cleaning. Cleaning the printheads can be useful, but it uses ink.

- Leave the printer permanently turned on so that it can maintain the printheads in good condition automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not done, the printer may need to use much more ink later to restore the health of the printheads.

- Wide prints make more efficient use of ink than narrow prints, because printhead maintenance uses some ink, and its frequency is related to the number of passes made by the printheads. Therefore, nesting jobs can save ink as well as saving paper (see Nest jobs to save paper on page 92).
7 Color management

- What is color?
- The problem: color in the computer world
- The solution: color management
- Color and your printer
- A summary of the color-management process
- Color calibration
- Color profiling
- Color-management options
- Color-adjustment options
- HP Professional PANTONE® Emulation
- Color emulation modes
What is color?

We see the world around us as steeped in color. Color is in the first instance simply an aspect of how we experience our environment and is therefore subjective. Our color experiences are closely related to brain activity that is triggered by signals that our eyes send to it. These signals undergo a complex and highly interlinked sequence of processing stages that make the relationship between what our eyes emit and what we experience anything but direct. The signals sent by the eye depend on the light-sensitive cells that line the back of our eyes, and they belong to three types, each sensitive to electromagnetic radiation of different physical properties (wavelengths). Such electromagnetic radiation is called light and objects appear to have certain colors because of how the objects interact with light (by emission, reflection, absorption, transmission, scattering, etc.).

Our individual experiences of color are also affected by our previous experiences and memories and by the way in which we put our experiences into language. Finally, environmental factors such as changes in lighting, scene content, or the proximity of other colors also have an effect, which makes the way in which we view a given display or print an essential part of the colors we see. Differences in all these aspects (from physiological differences between people, to differences in their past experiences, memories and linguistic tendencies) can result in people talking about colors differently even in response to the same light reflected from an single object. However, many similarities exist between how individuals experience color. You can make very specific judgments about color that others will also agree with when care is taken in the process. In conclusion we can say that color results from the interaction between light, objects, and a viewer, which makes it a very complex and to a large degree subjective phenomenon.

The problem: color in the computer world

Color-imaging devices such as printers, displays, projectors, and televisions create colors by using different methods and materials (colorants). Displays, for instance, use colorants that emit red (long wavelength), green (medium wavelength), and blue (short wavelength) light. A white color requires all three colorants and black requires that none of them be used (i.e. that no light be emitted). Devices that use light-emitting colorants are called additive, because the light from them is added together before it enters a viewer’s eyes. Printers, on the other hand, use materials that absorb parts of the light that shines on them. They are called subtractive. Typical prints use cyan (red absorbing), magenta (green absorbing), and yellow (blue absorbing) inks and an additional black ink that absorbs light at all wavelengths. To get white using a printer requires not absorbing any of the light that illuminates a piece of paper and to get black, all of the inks need to be used to absorb all of the light that is present.
To control the output of color imaging devices, the following color spaces are normally used:

- **RGB (Red, Green, and Blue)** is the color space typically used for additive devices. A color is represented as a combination of specific quantities of red, green, and blue colorants that create the range of colors (color gamut) in the device.

  ❧ **NOTE:** Colors in subtractive devices can also be controlled by using RGB data. Especially when control over the printer’s black ink is unnecessary, this is an efficient option.

- **CMYK (Cyan, Magenta, Yellow, and Black)** is the color space for subtractive devices, such as printers or presses. A color is represented as a combination of cyan, magenta, yellow, and black (K) inks, and combinations provide the entire range of colors in the device.

Color spaces are only methods of controlling different color-imaging devices. They do not describe colors directly. The same CMYK values, for example, create different colors when sent to different printers that use different inks and paper types. For example, consider a printer that can use indoor inks or outdoor inks. The printer (hardware) is the same, but it has two different color gamuts due to the different chemistry of the inks (dye-based versus pigmented). Furthermore, they need to work with different paper types, as ink interaction with the paper depends on its chemistry. Thus, the colors resulting from given CMYK values depend on the types of inks and papers that you use with a printer. If this is the case using the same printer, you can easily imagine how different results can be obtained with printers using different technologies and therefore using different ink chemistry.

The same happens with RGB-controlled devices. For example, imagine that two different monitors from the same manufacturer have their white points at 9600 K and 6500 K, respectively. Their colors are going to be different because they will be related to a different white point reference. The situation varies even more among monitors from different manufacturers. To emulate the standard color temperature of the graphic-arts industry, set the white point of your monitor to 5000 K (also called D50).

  ❧ **NOTE:** The white point is the brightest neutral color that a device can reproduce or that is present in an image. The human visual system automatically adapts to the content of an image based on its white point.

Different devices do not give access to the same color gamuts: some colors that can be shown on a display cannot be matched in print, and vice versa. The following figure illustrates how the human eye perceives a larger range of colors than a typical display or printer. It also shows that the color gamuts in two different types of color-imaging devices do not match each other.
Some color spaces are not device-dependent, but instead represent how a viewer sees colors, such as CIE Lab or CIECAM02. These color spaces are defined by the CIE (Commission Internationale de l’Éclairage). The advantage of these spaces is that if two objects have the same CIELAB values, they look the same when viewed under the same conditions. Values in these spaces can be obtained from measuring the light emitted or reflected by an object.

The solution: color management

Many colors from an RGB-controlled device cannot be reproduced in a CMYK-controlled device, and vice versa. These colors are called “out-of-gamut” colors.

1. **Describe the color behavior of a device as accurately as possible by using an ICC profile.** The color behavior of a device can be described by taking various RGB or CMYK combinations, sending them to a device, measuring the resulting output, and expressing it in a device-independent color space (for example, CIE Lab). The resulting relationship is stored in an ICC profile, which is a standard file that translates the color space of a device (CMYK or RGB) to a device-independent color space (for example CIE Lab). The process of generating an ICC profile is called profiling.

2. **Convert colors as effectively as possible by using a Color Management System (CMS).** A CMS is software that uses information from ICC profiles to transform the color space of one device (defined by a source profile) into the color space of another device (defined by a destination profile). In this solution, difficulties arise with the colors that exist in the gamut that one device uses and that the other does not use.

The following four settings describe a CMS:
● **CMS:** Color Management System. The software that converts the color information that is stored in the input image (defined by a source profile) into an output image that has the color space specified by a destination profile. Many different CMSs are on the market: in software programs, in operating systems, and in printing software, including the Z6200 internal RIP.

● **Source profile:** a description of the color behavior of the input device

● **Destination profile:** a description of the color behavior of the output device

● **Rendering intent:** the most difficult challenge in color management is when a color in the source gamut does not correspond directly to a color in the destination gamut. When a perfect match is not possible, choices must be made about how to treat gamut differences. These choices are called rendering intent. There are four different possibilities depending on the final output that you want to achieve.

  ◦ Use **Perceptual** for the most pleasing final output. It is suitable for photographic content.

  ◦ Use **Saturation** for vivid final output. It is suitable for business graphics (charts, presentations, and so on), but is not recommended for color matching.

  ◦ Use **Relative Colorimetric** for press proofing. This rendering intent provides a match for colors that are inside both the source and destination gamuts, and minimizes differences when a match is not possible.

  ◦ Use **Absolute Colorimetric** for press proofing (like Relative Colorimetric), when you also want to simulate the color of the source’s paper.

The following are the most commonly used device color spaces and profiles:

● **RGB mode:**

  ◦ **sRGB (sRGB IEC61966-2.1):** for images that typically originate from consumer digital cameras and scanners and from the Web

  ◦ **Adobe® RGB (1998):** for images that typically originate from professional digital cameras

  ◦ **Specific RGB device space:** for images that are coming from or going to a specific RGB device that has been profiled

● **CMYK mode:**

  ◦ **SWOP:** Specifications for Web Offset Publications, a set of press standards that have been defined for a typical U.S. press and for different types of paper stock

  ◦ **ISO 12647-2:** a set of press standards that have been defined by the International Standards Organization for different types of paper. Some examples of the definitions include Coated, Uncoated, and so on.
Other regional standards: Euroscale, JMPA, Japan Color

Specific CMYK device space: for images that are coming from or going to a specific CMYK device that has been profiled.

Color and your printer

As a creative professional, predictable and dependable results from your printer are essential to getting your job done. Predictability is a key element of an efficient color workflow. You need prints that match your expectations and that generate neutral grays and correct colors on your selected paper, print-to-print and printer-to-printer. Dependability ensures that every print is free of print-quality defects and ready to use or send to your customer. You save time and effort and avoid wasting ink and paper, and you can meet demanding production schedules with confidence.

The Z6200 printers have been engineered with advanced hardware and driver features to ensure predictable and dependable results, and offer dramatic improvements in efficiency and control for your color workflow.

HP Embedded Spectrophotometer

The Z6200 printer series revolutionizes professional color workflows by using a built-in spectrophotometer for color calibration and profiling.

A spectrophotometer is a precision instrument that can determine the exact composition of the light that is reflected from a color patch. It splits the reflected light into different wavelength components and measures the strength of each component. The HP Embedded Spectrophotometer is mounted on the printhead carriage.

The Z6200 printers use the spectrophotometer to generate custom ICC profiles automatically for your preferred paper types. It then calibrates the printers to deliver print-to-print and printer-to-printer consistency with less than half the color error of earlier HP Designjets, under all environmental conditions, and even on unknown (not factory-profiled) paper types. A built-in white calibration tile, which is protected by an automatic shutter, ensures reliable measurements that meet international standards.

The printer, color-imaging pipeline, and professional-quality spectrophotometer with GretagMacbeth i1 color technology are integrated with the HP Color Center software for the Z6200. Giving the calibration and profiling processes direct access to the writing system allows precise control of ink levels and color separations for each printed color patch. The automated measurement process eliminates the need to handle the test print, provides repeatable drying times, and allows fast measurements with precise electromechanical positioning of the spectrophotometer over the color patch. This provides unprecedented ease of use and matches or exceeds the performance of more expensive offline, handheld profiling systems.
A summary of the color-management process

To get the accurate and consistent colors that you want, follow these steps for each paper type that you use.

1. If the printer does not recognize your paper type, add the type to the printer’s list of known papers. See Use non-HP paper on page 48. Typical users might add a few custom paper types every year.

2. Color-calibrate the paper type to ensure consistent colors. Perform this calibration when a printer alert recommends this calibration (typically, every few weeks for each paper type you use). In addition, calibrate immediately before a particularly important print job in which color consistency is vital.

3. Color-profile the paper type to ensure accurate colors. Profiling does not normally need to be repeated; after you have a profile for a particular paper type, you can continue to use it. However, re-profiling does no harm, and some users repeat the profiling process every month to ensure that the profile is up-to-date.

4. When printing, select the correct color profile for the paper type that you are using.

Paper types that are defined in the printer also have color profiles stored in the printer. However, HP recommends that you calibrate the paper before using it.

If you define a new paper type, the printer automatically leads you through calibration and profiling.

The following diagram shows the operations that the HP Color Center performs, in order.
NOTE: You can perform all three operations in sequence, as shown. You can also choose to start with or stop after any of the three operations. However, color calibration is performed automatically after you add a new paper type.

Color calibration

Your printer uses color calibration to produce consistent colors with the specific printheads, inks, and paper type that you are using, and in your particular environmental conditions. After color calibration, you can expect to get identical prints from any two different printers that are situated in different geographical locations.

Calibration should be done in any of the following circumstances:

- Whenever a printhead is replaced
- Whenever a new paper type is introduced that has not yet been calibrated with the current set of printheads
- Whenever a certain amount of printing has been done since the last calibration
- Whenever the printer has been turned off for a long period of time
- Whenever the environmental conditions (temperature and humidity) change significantly

The printer usually reminds you with an alert whenever you need to perform color calibration, unless you have disabled the alerts. However, if the environmental conditions change, the printer will not be aware of it.

You can check the color calibration status of the currently loaded paper at any time by selecting the icon, then View loaded paper. The status can be one of the following conditions:

- Pending: the paper has not been calibrated

NOTE: Whenever you update the printer’s firmware, the color calibration status of all papers is reset to PENDING. See Update the printer firmware on page 138.

- Recommend: the printer software recommends that you calibrate the printer because it has recognized a condition that might require calibration
- Obsolete: the paper has been calibrated, but the calibration is now out of date and should be repeated
- OK: the paper has been calibrated, and the calibration is up to date
- Disabled: this paper cannot be calibrated

NOTE: Colored papers; glossy canvas; and transparent materials such as translucent bond, clear film, tracing paper; and vellum are not suitable for color calibration.

You can also check the color calibration status by using the HP Utility.

Calibrate a paper type before creating its color profile. Later recalibration does not require a new color profile.
You can start color calibration in the following ways:

- From the printer alert that recommends calibration
- From the HP Color Center: select **Calibrate Your Printer**
- From the front panel: select the **Calibrate color** icon

After launching calibration, the process is fully automatic and can be performed unattended after you have loaded appropriate paper. The paper must be at least 24 inches wide.

The process takes about 8 minutes and consists of the following steps.

1. A calibration test chart is printed, which contains patches of each ink that your printer uses.

2. To stabilize the colors, the test chart dries for a period of time that depends on the paper type.

3. The HP Embedded Spectrophotometer scans and measures the test chart.

4. The printer uses the measurements to calculate the necessary correction factors for consistent color printing on that paper type. It also calculates the maximum amount of each ink that can be applied to the paper.

### Color profiling

**NOTE:** Color profiling information applies only to PostScript printers.

Color calibration provides consistent colors, but consistent colors are not necessarily accurate colors.

In order to print accurate colors, convert the color values in your files to the color values that will produce the correct colors when using your printer, your inks, and your paper. An ICC color profile is a description of a printer, ink, and paper combination that contains all the information for these color conversions.

When you have defined and calibrated a new paper type, the printer is ready to create an ICC profile for use with your paper, which allows you to print on it with the best possible color accuracy. Alternatively, if your paper type is already known to the printer, you already have its appropriate ICC profile.

### Create your own profile

Create a color profile easily by using the HP Color Center to select **Create and Install ICC Profile**. The printer prompts for information about the paper, and then creates and installs the new profile automatically.
The process takes about 15 to 20 minutes and consists of the following steps.

1. A profiling test chart is printed, which contains patches of each ink used in your printer. Unlike a calibration test chart, most of the patches contain combinations of ink.

   ![Test Chart](image)

   **NOTE:** To use a longer drying time, instruct the HP Color Center to create the test chart without creating a profile (Windows: select **Print target only**; Mac OS: select **Print ICC profiling chart**). Later, when the chart is completely dry, restart the HP Color Center and request a profile that uses the test chart that you have already created (Windows: select **Create ICC profile from a target that has already been printed**; Mac OS: select **Scan ICC profiling chart and create ICC profile**). The scan will begin after the spectrophotometer warms up.

2. The HP Embedded Spectrophotometer scans and measures the test chart.

3. The printer uses the measurements to calculate the necessary correction factors for consistent color printing on that paper type. It also calculates the maximum amount of each ink that can be applied to the paper.

4. The new ICC profile is stored in the correct system folder on your computer, where your software programs can find it.

   The profile is also stored in the printer so other computers that are connected to the same printer can copy it. A profile can be accessed and used as soon as a job is submitted from the Embedded Web Server. The HP Utility will notify you if your printer has profiles that are not yet stored on your computer.

   **NOTE:** You might need to quit and restart some programs in order to use a profile that has just been created.

**Use a third-party profile**

If you have obtained an ICC profile through means other than using the printer’s built-in profiling software (for instance from an Internet download or a third-party profiling software package), you can install it for use with your printer and paper.

The printer needs to know which paper type the profile corresponds to. First select a paper type from the list of papers that the printer recognizes. When selecting a paper type, try to pick one that resembles your actual paper type as closely as possible. The paper type determines the amount of ink that is used and other basic printing parameters, so making a good choice here is fundamental to achieving good results later on. If you find that you cannot obtain satisfactory results with the profile and paper type that you picked, try selecting different types, and use the one that works best.

If the paper that you are using is not listed, or if you cannot find a paper type that resembles yours closely enough, you can define a new type. See **Use non-HP paper on page 48**. The printer then calibrates itself for use with that paper, after which you can return to installing the ICC profile.

After you have selected the paper type, browse to the file that contains the ICC profile to use with your printer and paper. Normally, ICC profile file names end in the extension “.icc” (for International Color Consortium) or “.icm” (for Image Color Matching). The profile is stored in the correct system folder on your computer, and in the printer.
Profile your monitor

Also calibrate and profile your monitor (display device), so that the colors you see on the screen relate more closely to those that you see on your prints. In the HP Color Center, select How To Calibrate Your Display for further information.

Color-management options

The aim of color management is to reproduce colors as accurately as possible on all devices: so that, when you print an image, you see very similar colors as when you view the same image on your monitor.

There are two basic approaches to color management for your printer:

- **Application-Managed Colors**: in this case your application program must convert the colors of your image to the color space of your printer and paper type, using the ICC profile embedded in the image and the ICC profile of your printer and paper type.

- **Printer-Managed Colors**: in this case your application program sends your image to the printer without any color conversion, and the printer converts the colors to its own color space. The details of this process depend on the graphics language that you are using.
  
  - **PostScript**: the PostScript interpreter module inside the printer performs the color conversion using the profiles stored in the printer (including those generated by the HP Color Center) and any additional profiles sent with the PostScript job. This kind of color management is done when you are using the PostScript driver and you specify printer color management or when you send a PostScript, PDF, TIFF or JPEG file directly to the printer through the Embedded Web Server. In either case you have to select the profiles to use as default (in case the job doesn’t specify any).

  - **Non-PostScript (HP-GL/2, RTL)**: the color management is done using a set of stored ICC profiles. This method is somewhat less versatile than the previous methods, but is a little simpler and faster, and can produce good results with standard HP paper types. This kind of color management is done when you are using a non-PostScript driver and you specify printer color management.

  There are only two color spaces that the printer can convert to its own color space using the stored profiles: Adobe RGB and sRGB.

You are recommended to consult the Knowledge Center at [http://www.hp.com/go/Z6200/knowledgecenter/](http://www.hp.com/go/Z6200/knowledgecenter/) to see how to use the color management options of your particular application.

To choose between **Application-Managed Colors** and **Printer-Managed Colors**:

- **In the Windows driver dialog**: select the Color tab.
- **In the Mac OS Print dialog**: select the Color Options panel.
- **In some applications**: you can make this choice in the application.
Color management example with Photoshop

In this example, you have an Adobe RGB image that you want to print from Photoshop. There are three ways of doing it.

● **Select Let Photoshop determine colors** in Photoshop. Select **Application-Managed Colors** in the printer driver. Color management is done in Photoshop. This is the recommended way.

● **Select Let printer determine colors** in Photoshop. Select **Printer-Managed Colors** and the sRGB profile in the printer driver. Photoshop converts the image from Adobe RGB to sRGB and sends it to the printer. Color management is done in the printer. Unfortunately, conversion to sRGB results in a loss of gamut, but Photoshop cannot be prevented from converting to sRGB when **Let printer determine colors** is selected.

● **Select No color management** in Photoshop. Select **Printer-Managed Colors** and the AdobeRGB profile in the printer driver. Photoshop does not perform any conversion, there is no loss of gamut, and color management is done in the printer. However, this method will not work if you are using synchronized color management in Photoshop (see below).

Synchronized color management with Photoshop

If you are using Adobe Photoshop CS2 for Mac OS, or Adobe Photoshop CS3 for Windows, or later versions, the color management options can be automatically synchronized between Photoshop and the driver.

● If you select **Let Photoshop determine colors** or **No color management** in Photoshop, **Application-Managed Colors** is automatically selected in the driver.

● If you select **Let printer determine colors** in Photoshop, **Printer-Managed Colors** is automatically selected in the driver. The PostScript driver will use the color profile attached to the job by Photoshop.

To enable this Photoshop synchronization under Windows XP, you must download and install the following free software packages from Microsoft’s Web site:

● Microsoft Core XML Services (MSXML) 6.0

● Microsoft XML Paper Specification Essentials Pack 1.0

Color-adjustment options

The aim of color management is to print accurate colors. If you perform color management correctly, then you should be able to print accurate colors with no need of any manual color adjustments.

However, manual adjustments may be useful in the following situations:

● If your color management is not working correctly for some reason

● If you want colors that are subjectively pleasing rather than accurate

The printer driver provides different adjustment facilities depending on whether you are printing in color or in grayscale. If you are printing in pure black and white, there are no color adjustment options.
Printing in color

You can adjust the colors of your print in similar ways under Windows and Mac OS:

- **In the Windows driver dialog:** select the **Color** tab, ensure that the **Advanced color adjustments** box is checked, then press the **Settings** button beside it.

- **In the Mac OS X 10.5 or 10.6 Print dialog:** select the **Color Options** panel, select **Color** from the Mode list, then press the **Adjust** button.

- **In the Mac OS X 10.4 Print dialog:** select the **Color Options** panel, then **Lightness and Hue**.

Under either operating system, you will then be able to make adjustments using a lightness slider and three color sliders.

The **Reset All** button restores each slider to its default central position.

![Advanced Lightness and Color Balance Adjustments](image)

- The lightness slider simply makes the whole print lighter or darker.

- The color sliders can be used to fade or emphasize each of the primary colors in the print. The primary colors may be red, green and blue; or cyan, magenta and yellow; depending on the color model used in the image.

Printing in grayscale

You can adjust the gray balance of your print in similar ways under Windows and Mac OS:

- **In the Windows driver dialog:** select the **Color** tab, ensure that the **Advanced color adjustments** box is checked, then press the **Settings** button beside it.

- **In the Mac OS X 10.5 and 10.6 Print dialog:** select the **Color Options** panel, select **Grayscale** from the Mode list, then press the **Adjust** button.

- **In the Mac OS X 10.4 Print dialog:** select the **Color Options** panel, then **Print in Grayscale**, then the **Gray balance** tab.

Under either operating system, you will then be able to make adjustments using separate controls for highlights, midtones and shadows.
The lightness slider simply makes the whole print lighter or darker. This slider is available in the same window as the other grayscale controls, except under Mac OS X 10.4, where it is available by selecting Lightness and Hue.

The zone definition sliders can be used to define what you mean by highlight, midtone and shadow.

The other controls for highlight, midtone and shadow can be used to adjust the gray balance of highlights, midtones and shadows respectively.

The Reset All button restores each control to its default setting.

**HP Professional PANTONE* Emulation**

When you use a named PANTONE* color in an image, your software program normally sends a CMYK or RGB approximation to that color to the printer. However, instead of taking the printer or the paper type into account, the software merely produces a generic approximation of the PANTONE* color, that looks different on different printers and on different papers.

HP Professional PANTONE* Emulation takes into account the characteristics of the printer and the paper type. The results look as similar to the original PANTONE* colors as is possible on a given printer using a given paper type. This technology is designed to produce emulations that are similar to those that prepress professionals establish.

To use HP Professional PANTONE* Emulation, just turn it on.

- With the Windows PostScript printer driver: click the Color tab, and then select **HP Professional PANTONE Emulation**.
- With a Mac OS printer driver: select the Color Options panel, and then select **HP Professional PANTONE Emulation**.
- Through the Embedded Web Server: select the Submit Job page, and then select **Color > HP Professional PANTONE Emulation**.
- On the front panel: select the icon, and then select **Printing preferences > Color options > HP Professional PANTONE Emulation**.
NOTE: HP Professional PANTONE® Emulation is available only when printing a PostScript or PDF job.

You can also use the Embedded Web Server to print a swatch book that shows emulations of PANTONE® colors from your printer, along with a measure of the color difference (ΔE) between each emulation and the original PANTONE® spot color. HP Professional PANTONE® Emulation not only provides the closest match that can be achieved on your printer; but also provides clear information about how close the emulation is to the original spot color.

To print a swatch book, click the Embedded Web Server Main tab, and then select HP Professional PANTONE® Emulation. Select the PANTONE® stock to emulate, and then select the PANTONE® colors that you want to print. When you have selected all the colors that you want, click the Print button.

Color emulation modes

If you want to print a particular print job and to see approximately the same colors that you would get from printing the same job on a different HP Designjet series printer, use the printer’s emulation mode.

- In the Windows driver: click the Color tab, select Printer Managed Colors, and then select Printer Emulation from the Source profile drop-down menu. Then select from the Emulated printer drop-down menu.
- In the Mac OS Print dialog box: select the Color Options panel, and then select from the Printer Emulation list.
• On the front panel: select the icon, and then select **Printing preferences > Color options > Emulate Printer**.

• Through the Embedded Web Server: select the **Submit Job** page, and then **Job settings > Advanced settings > Color > Color management** and the desired emulation mode.

You can emulate the following printers:

• HP Designjet 5500 Dye series

• HP Designjet Z6100

The following table shows approved combinations of print-quality settings and papers for the best printer-emulation results.

<table>
<thead>
<tr>
<th>Paper Type</th>
<th>Best</th>
<th>Normal</th>
<th>Fast</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Premium Instant-Dry Gloss Photo Paper</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>HP Universal Instant-Dry Photo Gloss</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>HP Heavyweight Coated Paper</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>HP Coated Paper</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>HP Bright White Inkjet Bond Paper</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**CMYK color emulation**

All CMYK emulation options apply to PDF, PostScript, TIFF, and JPEG files only.

A traditional workflow defines color in the CMYK space. For best results, the colors must be adjusted to the printer, because different printers will produce different colors from the same CMYK data. If the image file that you are printing was not created specifically for your printer, it will require some readjustment, which can be done using one of the following options provided with your printer:

• **None (Native):** no emulation. The printer will use its default internal conversion from CMYK to RGB, without following any color standard. This does not imply that results will be bad.

• **ISO Coated 2-ECI** is based on the characterization dataset FOGRA39L.txt, applicable to the following reference printing conditions according to the international standard ISO 12647-2:2004/Amd 1: commercial and specialty offset, paper type 1 and 2, gloss or matt coated paper, positive plates, tone value increase curves A (CMY) and B (K), white backing.

• **Coated GRACoL 2006-ISO12647** provides GRACoL proofing and printing on Grade 1 coated paper, ISO 12647-2 Paper type 1.

• **PSO Uncoated ISO12647-ECI** is based on the characterization data set FOGRA47L.txt, applicable to the following reference printing condition according to the international standards ISO 12647-2:2004 and ISO 12647-2:2004/Amd 1:2007: commercial and specialty offset, paper type 4, uncoated white paper, positive plates, tone value increase curves C (CMY) and D (K), white backing.

• **PSO LWC Improved-ECI** is based on the characterization data set FOGRA45L.txt, applicable to the following reference printing condition according to the international standards ISO 12647-2:2004 and ISO 12647-2:2004/Amd 1:2007: commercial and specialty offset, improved LWC paper (light weight coating), positive plates, tone value increase curves B (CMY) and C (K), white backing.
● **Web Coated SWOP 2006 Grade 3** provides SWOP® proofing and printing on U.S. Grade 3 coated publication paper.

● **Web Coated SWOP 2006 Grade 5** provides SWOP® proofing and printing on U.S. Grade 5 coated publication paper.

● **U.S. Sheetfed Coated 2** uses specifications designed to produce quality separations using U.S. inks under the following printing conditions: 350% total area of ink coverage, negative plate, bright white offset stock.

● **U.S. Sheetfed Uncoated 2** uses specifications designed to produce quality separations using U.S. inks under the following printing conditions: 260% total area of ink coverage, negative plate, uncoated white offset stock.

● **U.S. Web Coated (SWOP) 2** uses specifications designed to produce quality separations using U.S. inks under the following printing conditions: 300% total area of ink coverage, negative plate, coated publication-grade stock.

● **U.S. Web Uncoated 2** uses specifications designed to produce quality separations using U.S. inks under the following printing conditions: 260% total area of ink coverage, negative plate, uncoated white offset stock.

● **Euroscale Uncoated 2** uses specifications designed to produce quality separations using Euroscale inks under the following printing conditions: 260% total area of ink coverage, positive plate, uncoated white offset stock.

● **Japan Web Coated (Ad)** uses specifications developed by the Japan Magazine Publisher Association for digital proofing of images in the Japanese magazine/advertising market.

● **Japan Color 2001 Coated** uses the Japan Color 2001 specification for type 3 (coated) paper. It is designed to produce quality separations using 350% total ink coverage, positive film and coated paper.

● **Japan Color 2001 Uncoated** uses the Japan Color 2001 specification for type 4 (uncoated) paper. It is designed to produce quality separations using 310% total ink coverage, positive film and uncoated paper.

● **Japan Color 2002 Newspaper** uses the Japan Color 2002 for Newspapers specification. It is designed to produce quality separations using 240% total ink coverage, positive film and standard newsprint paper.

● **Japan Color 2003 WebCoated** is for type 3 coated paper. It is designed to produce quality separations for standard ISO printing using 320% total ink coverage, positive film, and coated paper on heat-set web offset presses.

● **JMPA**: Japanese standard for offset press.

● **Toyo** is designed to produce quality separations for Toyo printing presses.

● **DIC** is designed to produce quality separations for Dainippon Ink Company printing presses.

**NOTE:** These options have no effect if the software defines its own CMYK space, known as calibrated CMYK or CIEBasedDEFG in PostScript terminology.

**RGB color emulation**

These options apply to PDF, PostScript, TIFF, and JPEG files. For HP-GL/2 and RTL files, only sRGB and AdobeRGB are supported.
If you want to print an RGB image, it must be converted to CMYK data. You might be able to do the conversion in the software or operating system. To perform this conversion on the printer, use the following color profiles:

- **None (Native)**: no emulation. The printer uses its default internal conversion from RGB to CMYK, without following any color standard. This does not imply that results will be bad.

- **sRGB IEC61966-2.1** emulates the characteristics of the average PC monitor. This standard space is endorsed by many hardware and software manufacturers, and is becoming the default color space for many scanners, printers, and software programs.

- **ColorMatch RGB** emulates the native color space of Radius Pressview monitors. This space provides a smaller gamut alternative to Adobe RGB (1998) for print-production work.

- **Apple RGB** emulates the characteristics of the average Apple monitor, and is used by a variety of desktop publishing applications. Use this space for files that you plan to display on Apple monitors, or for working with old desktop publishing files.

- **Adobe RGB (1998)** provides a fairly large gamut of RGB colors. Use this space if you need to do print-production work that includes a broad range of colors.
8 Job queue management

- Embedded Web Server job queue page
- Job preview
- Turn off the job queue
- Pause the job queue
- Select when to print a job in the queue
- Identify a job in the queue
- Prioritize a job in the queue
- Delete a job from the queue
- Reprint or copy a job in the queue
- Job status messages
Embedded Web Server job queue page

You can manage your printer’s job queue from the HP Utility, see Access the HP Utility on page 24, or the printer’s Embedded Web Server, see Access the Embedded Web Server on page 23.

The job queue page shows all jobs that are available in the printer job queue. It includes jobs that are being received, parsed, rendered, printed and already printed.

The following information is displayed for each job:

- **Preview:** Click the icon to see the job preview. The job preview is available once the job is processed.
- **File name:** Click the file name to see the properties of the job.
- **Status:** Gives the current job status.
- **Pages:** Number of pages in the job.
- **Copies:** Number of copies printed.
- **Date:** Date and time the printer received the job.
- **User:** The user’s name.

Jobs in the queue can be sorted by any of the information items (except Preview) by clicking on the title of the corresponding column. You can perform the following operations on one or all jobs in the queue:

- **Cancel:** Cancels the selected jobs. You are asked to confirm before the job is canceled. The job remains stored in the printer, but it is not printed unless you click Reprint.
- **Hold:** Holds the selected jobs until you click Continue to print.
- **Continue:** All selected jobs, which are on hold, continue printing.
- **Reprint:** Prints more copies of a job. Type the number of copies (default 1, maximum 99) and click Print.
- **Move to front:** Sends all selected jobs to the top of the job queue.
- **Delete:** Deletes selected jobs from the job queue. You are asked to confirm before the job is deleted.
- **Refresh:** Refreshes the page, ensuring the information is updated.

**NOTE:** The job queue page does not automatically update.

Job preview

The printer samples all incoming jobs and generates a JPEG file that can be served as a preview of the job. This preview is available for all languages supported by the printer: PDF, PS, CALS/G4, TIFF and JPEG.

**TIP:** Do not send a job for preview with more than 64 pages.
Job preview is available once the job is processed. To access the preview page, click the magnifying glass icon, which appears in the Preview column on the job queue page. The preview page shows the following job details along with a thumbnail preview of the job:

- **File name**: The file name of the job.
- **Loaded paper**: The type of paper loaded in the printer.
- **Job dimensions**: The dimensions of the job.

To see a larger preview of the job, click either the job thumbnail or the magnifying glass icon, which appears on the right hand side of the printer image.

**NOTE:** Browsers without the Macromedia plug-in show the job image as yellow shaded. Browsers that have the Macromedia flash plug-in version 7 and above shows an enhanced preview of the job image inside the paper loaded in the printer.

---

### Turn off the job queue

You can turn off the queue in the following ways:

- From the Embedded Web Server: select **Setup tab > Printer settings > Job management > Queue > Off**.
- From the front panel: select the Setup menu icon , then **Job management options > Enable queue > Off**.

### Pause the job queue

To pause the job queue, go to the front panel and select the Job Queue icon , then **Pause printing**.

### Select when to print a job in the queue

**NOTE:** The When To Start Printing options cannot be used with PostScript jobs.

You can select at what point you want to print a file you have in the queue. From the Embedded Web Server, select **Setup tab > Printer settings > Start printing**; or, from the front panel, select the Setup menu icon , then **Job management options > When to start printing**.

There are three options you can select:

- **When After Processing** is selected, the printer waits until the whole page has been processed and then it starts to print. This is the slowest setting but ensures the best print quality in large or complex prints.
- **When Immediately** is selected, the printer prints the page as it is processed. This is the quickest setting, but the printer may stop halfway through a print to process data. This setting is not recommended for complex images with dense color.
- **When Optimized** is selected (this is the default setting), the printer calculates the best time to begin printing the page. It is usually the best compromise between the After Processing and Immediately settings.
Identify a job in the queue

The best way to look at the queue is in the Embedded Web Server (Main tab > Job queue), where you can manage the queue and get full information on every job (by clicking the name of the file).

However, you can also manage the queue from the front panel. To do so, select the Job Queue icon ☐, then Job queue, where you can see a list of the jobs in the queue.

Each has an identifier, comprising:

<position in queue>: <image name>

The job currently being printed has a pointing hand icon, jobs already printed have a check mark, canceled jobs have crosses, processing jobs have a clock and jobs on hold have a warning.

Prioritize a job in the queue

To make any job in the queue the next one to be printed, select it and choose Reprint (in the Embedded Web Server) or Move to front (in the front panel).

If nesting is turned on, the prioritized job may still be nested with others. If you really want this job to be printed next, and on its own on the roll, first turn nesting off and then move it to the front of the queue as described above.

Delete a job from the queue

Under normal circumstances, there is no need to delete a job from the queue after printing it, as it is removed from the queue as more files are sent. However, if you have sent a file in error, and want to avoid any chance of it being reprinted, you can simply delete it, by selecting it and choosing Delete (in the Embedded Web Server or in the front panel).

In the same way, you can delete a job that has not been printed yet.

If the job is currently being printed (Status = printing in the Embedded Web Server, or it is the first job in the queue in the front panel), and you want both to cancel the job and to delete it, first click the Cancel icon in the Embedded Web Server, or press the Cancel key on the front panel, and then delete it from the queue.

Reprint or copy a job in the queue

To reprint or make extra copies of any job in the queue, select the job in the Embedded Web Server and click the Reprint icon, then specify the number of copies you want. The job is moved to the top of the queue. To make more than one print of a non-printed job in the queue from the front panel, select the job and choose Copies, then specify the number of copies required and press the Select key. This overrides any value set by your software.

**NOTE:** If Rotate was On when you sent the file, every copy is rotated.

You can reprint an already-printed job from the front panel. Select the Job Queue menu icon ☐, then select the job from the queue, then select Reprint.
Job status messages

These are the possible job status messages, approximately in the order in which they may be seen:

- **Receiving**: the printer is receiving the job from the computer
- **Waiting to process**: the job has been received by the printer and is waiting to be rendered (for jobs submitted through the Embedded Web Server only)
- **Processing**: the printer is parsing and rendering the job
- **Preparing to print**: the printer is performing writing system checks before printing the job
- **Waiting to print**: the job is waiting for the print engine to become free to proceed with printing
- **Waiting for nest**: the printer is set up with nesting on and is waiting for other jobs in order to complete the nest and proceed with printing
- **On hold**: the job was sent with the on hold for preview option and is on hold

**TIP**: Do not send a job for preview with more than 64 pages.

**NOTE**: If the printer hangs up while printing a job, and the queue facility is turned on, the partially printed job appears in the queue as on hold when the printer is next turned on. When you resume the job, it starts printing at the page it was interrupted.

- **On hold for paper**: the job can’t be printed because paper is not loaded in the printer. Load the required paper, see Handle the paper on page 29, and click Continue to resume the job
- **On hold for accounting**: the job can’t be printed because the printer requires all jobs to have an account ID: enter the account ID and then click Continue to resume the job
- **Printing**
- **Drying**
- **Cutting paper**
- **Ejecting page**
- **Canceling**: the job is being canceled, but remains in the printer job queue
- **Deleting**: the job is being deleted from the printer
- **Printed**
- **Canceled**: the job has been canceled by the printer
- **Canceled by user**
- **Empty job**: the job does not contain anything to print

**Remove a hold**

When the printer puts a job on hold you receive an alert, see Printer alerts on page 175, which explains why the job is on hold. Follow the instructions on the screen to remove the hold and continue printing.
9 Retrieve printer usage information

- Get printer accounting information
- Check printer usage statistics
- Check ink and paper usage for a job
Get printer accounting information

There are various different ways of getting accounting information from your printer.

- View printer usage statistics for the whole lifetime of the printer, see Check printer usage statistics on page 118.
- View ink and paper usage for each of your recent jobs by using the HP Utility, see Check ink and paper usage for a job on page 118. If the HP Utility is not available, see Access the HP Utility on page 24.
- Use a third-party application to request printer status, printer usage or job accounting data from the printer through the Internet. The printer provides data in XML to the application whenever requested. HP provides a Software Development Kit to facilitate the development of such applications.

Check printer usage statistics

There are two ways to check your printer’s usage statistics.

⚠️ NOTE: The accuracy of the usage statistics is not guaranteed.

Printer statistics with the Embedded Web Server

1. Access the Embedded Web Server, see Access the Embedded Web Server on page 23.
2. Go to the Main tab.
3. Select History > Usage.

Printer statistics with the HP Utility

1. Access the HP Utility, see Access the HP Utility on page 24.
2. Under Windows, go to the Overview tab and click on the Printer usage link.
   Under Mac OS, select Information > Printer Usage and click on the Lookup button.

Check ink and paper usage for a job

There are two ways to check ink and paper usage for a job.

⚠️ NOTE: The accuracy of the usage statistics is not guaranteed.

Ink and paper statistics with the Embedded Web Server

1. Access the Embedded Web Server, see Access the Embedded Web Server on page 23.
2. Go to the Main tab.
3. Select History > Accounting.
Ink and paper statistics with the HP Utility

1. Access the HP Utility, see Access the HP Utility on page 24.

2. Select Job center to view information regarding the most recent jobs.

3. Under Windows, click on the Accounting link.
   Under Mac OS, select Job Accounting and click on the Look Up button.
10 Practical printing examples

- Overview
- Resize an image with Adobe Photoshop CS4
- Print a color photo with Photoshop CS2
- Print a draft for revision with the correct scale
- Reprint a job with consistent colors
- Use ESRI ArcGIS 9 to print a map
Overview

The following step-by-step instructions for printing jobs that use specific software are similar to those at the HP Knowledge Center on the Web. Consult the Knowledge Center at http://www.hp.com/go/Z6200/knowledgecenter/ for the most up-to-date information and for additional printing examples, including RIP scenarios.

Resize an image with Adobe Photoshop CS4

Application settings

1. Open your image in Adobe Photoshop, and then select Image size from the Image menu.

   The Image Size dialog box appears.

   ![Image Size dialog box](image)

2. Set the sizing options.

   - **Pixel Dimensions**: Set the resulting image size
   
   - **Document Size and resolution**: Set the resulting page size and resolution. As a general guideline, consider setting the resolution according to your print quality setting. Refer to the following table for guidance.

<table>
<thead>
<tr>
<th>Print quality setting</th>
<th>Recommended resolution setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast</td>
<td>300</td>
</tr>
<tr>
<td>Normal</td>
<td>600–900</td>
</tr>
<tr>
<td>Best</td>
<td>1200</td>
</tr>
</tbody>
</table>

For more information about the print quality setting, see Select print quality on page 82.

   - **Constrain Proportions**: Select this option if you want to preserve height-to-width ratio of your original image

   - **Resample Image**: When an image is resampled, an interpolation method is used to assign color values to any new pixels that Photoshop creates, based on the color values of existing pixels in the image. Photoshop uses sophisticated methods to preserve the quality
and detail from the original image when you resample. Select from the following resampling options:

- **Nearest Neighbor**: A fast but less precise method that replicates the pixels in an image. This method is for use with illustrations that contain edges that are not anti-aliased, to preserve hard edges and produce a smaller file. However, this method can produce jagged effects, which become apparent when you distort or scale an image or perform multiple manipulations on a selection.

- **Bilinear**: A method that adds pixels by averaging the color values of surrounding pixels. It produces medium-quality results.

- **Bicubic**: A slower but more precise method based on an examination of the values of surrounding pixels. Using more complex calculations, Bicubic produces smoother tonal gradations than Nearest Neighbor or Bilinear.

- **Bicubic Smoother**: A good method for enlarging images based on Bicubic interpolation but designed to produce smoother results.

- **Bicubic Sharper**: A good method for reducing the size of an image based on Bicubic interpolation with enhanced sharpening. This method maintains the detail in a resampled image. If Bicubic Sharper oversharpens some areas of an image, try using Bicubic.

3. When you have finished setting the sizing options, click the **OK** button.

4. Select **Print** from the **File** menu.
5. Select your printer and then click the **Page Setup** button. The printer properties dialog box appears.

![Printer Properties Dialog Box](image)

6. Set the page size and other print options that you want and then click the **OK** button. For more information about print option settings, see Print options on page 80.

---

**Print a color photo with Photoshop CS2**

This example uses Adobe Photoshop CS2 under Windows XP. The color management is done by Photoshop.

1. Initial recommendations:
   - Select an appropriate paper type for the job.
   - The paper type should be calibrated and profiled with the printer and the print-quality level that you intend to use. See Color calibration on page 101 and Color profiling on page 102.
   - To obtain a correct preview of the printed image, the monitor should also be profiled.

2. Open Adobe Photoshop CS2.

3. On the **Edit** menu, select **Color Settings**.
   - Make sure that **More Options** are displayed.
   - In **Color Management Policies**, select **Preserve Embedded Profiles**.
   - In **Profile Mismatches**, select **Ask When Opening** and **Ask When Pasting**.
   - In **Missing Profiles**, select **Ask When Opening**.
   - In **Conversion Options**, click the **More Options** button to open **Conversion Options**, and then select **Intent > Perceptual**.
   - Click the **OK** button.
4. On the **File** menu, select **Open** to open the image.
   - If the document has an embedded color profile that does not match the current working space, select **Use the embedded profile**. Otherwise, select **Assign working space**.
     
     If the image colors do not look right, try assigning it to other color spaces by selecting **Edit > Assign Profile** (try sRGB, Adobe RGB, ColorMatch RGB and others) until you are satisfied.
   - Click the **OK** button.

5. On the **File** menu, select **Print with Preview**.
   - Select **Page Setup**.
   - Select the printer (for example, **HP Designjet Z6200ps 1524-mm**).
   - In **Paper size**: select the size of the paper that is currently loaded in the printer.
   - In **Orientation**: select the orientation of your image on the paper (portrait or landscape).
   - Click the **OK** button.
   - Set the **Position** and the **Scaled Print Size** that you want.
   - Make sure that **More Options** are displayed.
   - Click the **Color Management** tab.
   - In **Print**: select **Document**.
   - Select **Options > Color Handling**, and then select **Let Photoshop Determine Colors**.
   - Select **Options > Printer Profile**, and then select the correct profile for your printer and paper type.
   - Click the **Print** button.

6. Select the driver settings.
   - In **Printer**: select the printer (**HP Designjet Z6200ps 1524-mm**).
   - Click the **Paper Type/Quality** tab, and then specify these options:
     - In **Paper Type**: select the paper type that is currently loaded in the printer.
     - In **Quality Options**: select **Standard options** and drag the slider to **Quality**.
   - Click the **Color** tab, and then specify these options:
     - Select **Print in Color**.
     - In **Color Management**: select **Application Managed Colors**.
   - Click the **Print** button.
Print a draft for revision with the correct scale

Using Adobe Acrobat

1. In the Acrobat window, check the plot size by positioning your cursor near the bottom left corner of the screen.

2. Select **File** and then select **Print**.

NOTE: The page size is not automatically selected according to the drawing size.
3. To keep the scale, set **Page Scaling** to **None** (which is not the default setting).

4. Click the **Properties** button.

5. Select the **Document size** and **Print Quality** you want to use. Click the **Custom** button if you want to define a new custom paper size.
6. Click the **Features** tab, and then select **Autorotate**.

![Image of the HP DesignJet 5200r Properties dialog box showing the Features tab and Autorotate option selected.]

7. Click the **OK** button and check that the print preview in the Print dialog box looks correct.

![Image of the Print dialog box showing the document preview and print settings.]

8. Click **OK** again to print.

---

**Reprint a job with consistent colors**

This scenario explains how to get consistent colors from print-to-print.

**NOTE:** HP supports color consistency between print jobs printed with the same printer models, using the same paper type.

**Scenario 1**

Reprint a job with consistent colors by using the same printer.
To ensure color consistency when reprinting the job, use the same paper type.

1. Check that the color calibration is valid for the paper type that is loaded. On the front pane, select the icon, and then select View loaded paper. In the Paper information window, check that Color Calibration is OK. If the status of the Color Calibration is Pending or Recommended, perform a color calibration from the HP Color Center, or on the front panel.

2. Reprint a job: Through the Embedded Web Server, go to the Job queue, select the job you want to reprint, and then click the Reprint button.

A file can also be printed again if was stored in the printer. Through the Embedded Web Server, go to Stored jobs in printer, select the job you want to print, and then click the Print button.

Scenario 2

Reprint a job by using two HP Designjet Z6200 printers.
To ensure color consistency when reprinting the job, use the same paper type.

1. Check that the color calibration is valid for the paper type that is loaded in both printers. On the front panel, select the icon, and then select View loaded paper. In the Paper information window, check that Color Calibration is OK. If the status of the Color Calibration is Pending or Recommended, perform a color calibration from the HP Color Center, or on the front panel.

2. Print the jobs.

**Use ESRI ArcGIS 9 to print a map**

ArcGIS is a scalable system of software for geographic data creation, management, integration, analysis, and dissemination for every organization, from an individual to a globally distributed network of people.

The software always sends RGB data to the printer driver. Select from several different printer engines. The printer engine determines the format and method that ArcMap uses to send the print job to the printer. One to three options are available, depending on license and printer configurations.

- **Windows** is the default and is always available, regardless of the printer that is in use. It allows the software to use the installed HP-GL/2 and RTL driver.
- **PostScript** is available only if your printer supports PostScript and when the PostScript driver has been selected in the Name section. This allows you to output the file as a PostScript file. This option might be useful in certain specific cases, but in general it is not recommended.
- **ArcPress** is an extension that can be purchased for printing from ArcGIS. It is a software RIP that takes the original metafile and applies raster to it before sending it to the printer, so that the printer does not need to. This is beneficial because some printers cannot apply raster or do not have enough memory to process large jobs. Always use ArcPress with HP RTL (RGB) TrueColor.

**Use the Windows printer engine**

1. Make sure that you have installed the HP-GL/2 and RTL driver.

2. When you are ready to print, select **File > Page and Print Setup**, and select the HP-GL/2 and RTL driver.
3. Click the Properties button and configure the driver as follows.
   - On the Paper/Quality tab, set Print Quality to Quality.
   - On the Color tab, clear the Print In Grayscale check box, and set Printer managed colors to sRGB in the Source profile drop-down menu.

4. Click the OK button.

5. Select File > Print.
   - Printer Engine: select Windows Printer.
   - Output Image Quality (Resample Ratio): this setting alters the number of pixels that are sampled when an ArcMap print file is generated. It determines how many pixels in the map document are used to create the file that goes to the printer.
     - Fast = 1:5
     - Normal = 1:3
     - Best = 1:1 (as is)

Selecting Best requires a lot of printer resources to process the print job, and might cause long processing times and generate out-of-memory messages, depending on the map size. If you experience these issues, select an Output Image Quality that is lower than Best. You will gain no advantage in print quality when you send an image that has resolution higher than the printer’s input resolution.

6. Click the OK button to print.

Use the ArcPress printer engine

1. Even though it will function only as a port, you must have the driver that you need installed.

2. When you are ready to print, select File > Page and Print Setup, select the driver (the driver settings have no effect), and click the OK button.

   - Printer Engine: select ArcPress.
● Click the **Properties** button, select the **HP RTL (RGB) TrueColor** driver, and select the resolution to be sent to the printer.

![Properties dialog box]

● Click the **Color Adjustment** tab if you want to adjust gamma, brightness, contrast, or saturation. You can preview the changes.

![Color Adjustment dialog box]

4. To print, click the **OK** button both in this dialog box and in the Print dialog box.
Maintain the printer

- Clean the exterior of the printer
- Clean the platen
- Clean the paper-advance sensor window
- Lubricate the printhead carriage
- Maintain the ink cartridges
- Perform preventive maintenance
- Move or store the printer
- Update the printer firmware
- Change the ink absorber
- Secure disk erase
Clean the exterior of the printer

Use a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid soap to clean the outside of the printer and all other parts of the printer that you regularly touch as part of normal operation (for example, ink cartridge drawer handles).

⚠️ **WARNING!** To avoid an electric shock, make sure that the printer is turned OFF and unplugged before you clean it. Do not let water get inside the printer.

⚠️ **CAUTION:** Do not use abrasive cleaners on the printer.

Clean the platen

You should clean your printer’s platen every few months, or when necessary.

⚠️ **NOTE:** If you print on wide paper after having printed on narrower paper, you might find that the left side of the platen has become dirty. If this contaminated section of the platen is not cleaned, it might leave marks on the back of the paper.

⚠️ **WARNING!** Be careful not to damage the paper-advance sensor when cleaning the platen. The sensor is the very small rectangular window found near the sixth platen roller from the right. See **Clean the paper-advance sensor window on page 135.**

Follow these instructions to clean the platen.

1. Unload all paper from the printer. See **Unload a roll from the printer on page 37.**
2. Open the printer window.
3. With a dry brush, remove ink deposits from the cutter groove.
4. With the same dry brush, remove ink deposits from the platen surface.

5. Use a clean, absorbent lint-free cloth that has been slightly dampened with isopropyl alcohol to wipe loosened ink deposits from the platen.

⚠️ **CAUTION:** Do not use commercial cleaners or abrasive cleaners. Do not wet the platen directly, because you will leave too much moisture behind.

6. Use the damp cloth to clean the cutter ramp.

7. Use a dry cloth to clean the exposed part of the wheels. Ideally, you should clean the entire circumference of these wheels.
Clean the paper-advance sensor window

The paper advance sensor is the very small rectangular window (less than 1 cm² in size and shown in the following graphic) near the sixth platen roller from the right.

You should clean the paper-advance sensor window every six months, and whenever you experience print-quality issues.

1. Unload the paper using the front panel procedure. See Unload a roll from the printer on page 37.

2. Use a clean, absorbent, lint-free cloth, slightly dampened with isopropyl alcohol, to wipe any dust and loosened ink deposits very gently from the sensor window.

3. Under ambient light, a clean sensor window shows a violet-colored reflection that extends uniformly across the entire surface. To see this reflection, look closely at the sensor window and slightly change your viewing angle.

4. Wait 3–4 minutes before reloading the paper to ensure that the alcohol has evaporated completely.

Lubricate the printhead carriage

The printhead carriage occasionally (about once a year) needs lubrication so that it continues to slide easily along the slider rod.

1. To gain access to the carriage, go to the front panel and select the icon, and then select Replace printheads. The carriage slides to the middle section of the printer.

⚠️ CAUTION: If the carriage remains in the central part of the printer for more than 7 minutes, it attempts to return to its home position on the right.
2. Open the printer window and apply a few drops of multi-purpose lubricating oil to the pads on either side of the carriage.

**NOTE:** A roller lubrication kit can be ordered if necessary as part of the Printer Maintenance Kit.

3. Apply a few drops of oil directly to the slider rod on either side of the carriage.

4. Close the printer window.

**Maintain the ink cartridges**

During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to maintain the best print quality, you should replace a cartridge when it has reached its expiration date, which is the manufacturing date marked on the cartridge plus 30 months.

**Perform preventive maintenance**

During the life of your printer, components that are used constantly can wear out.

To avoid having these components degrade to the point that the printer breaks down, the printer keeps track of the number of cycles that the printer carriage makes across the axis of the printer, and also monitors the total quantity of ink used.

The printer uses these numbers to track the need for preventive maintenance, and displays one of the following messages on the front panel:

- Maintenance #1 required
- Maintenance #2 required

These messages mean that some components are nearing the end of their lives. You can continue printing for quite some time, depending on your use of the printer. However, HP strongly recommends that you contact your customer service representative and arrange for a preventive maintenance visit. The service engineer can then replace the worn parts onsite, which will prolong the life of the printer.
The benefits of arranging a service engineer’s visit when these messages appear on the front panel are two-fold:

- The printer components can be replaced at a time that is convenient for you, and so will not disturb your daily workflow.
- When the service engineer performs a preventive maintenance visit, replaces several parts at once. This eliminates the need for repeat visits.

**Move or store the printer**

If you need to move your printer or store it for an extended period of time, prepare it correctly to avoid possible damage.

1. Do not remove the ink cartridges, printheads or printhead cleaners.
2. Make sure that no paper is loaded.
3. Make sure that the printhead carriage is located in the service station (at the right end of the printer).
4. Make sure that the **Ready** message appears on the front panel.
5. Turn off the power by using the **Power** key on the front panel.
6. Also switch off the power switch at the rear of the printer.
7. Disconnect the power cable and any cables that connect the printer to a network, a computer, or a scanner.
8. If you have a take-up reel installed, remove the take-up reel sensor and cable-housing unit from the foot of the printer stand. For your convenience, you can place the sensor and cable-housing unit on the printer-stand crossbar and use the blue, plastic screw to affix the housing unit to the leg of the stand, while you move the printer. See the illustration below. When reinstalling the housing unit, make sure that the wheel on the foot of the printer stand is pointing forward.

![Image of printer](image-url)

**NOTE:** If the printer or ink cartridges are moved from a cold location to a warm and humid location, water from the atmosphere can condensate on the printer parts and cartridges and can result in ink leaks and printer errors. In this case, HP recommends that you wait at least 3 hours before turning on the printer or installing the ink cartridges, to allow the condensate to evaporate.

**TIP:** Because preparing and purging the printheads uses both time and ink, you are strongly recommended to leave the printer always on or in sleep mode, whenever possible, to maintain the health of the printheads. In both cases, the printer wakes up from time to time to maintain the printheads. Thus you can avoid going through lengthy preparation processes before using your printer.
Update the printer firmware

The printer’s various functions are controlled by software that resides in the printer, also known as firmware.

From time to time, firmware updates from Hewlett-Packard become available. These updates increase the printer’s functionality and enhance its features.

Firmware updates can be downloaded from the Internet and installed in your printer in the following ways. Use the method that you find most convenient.

- In Windows, open the HP Utility, select your printer, click the Support tab, and then select Firmware Update.
- In Mac OS, open the HP Utility, select Support and then select Firmware Update.
- Through the printer’s Embedded Web Server, click the Setup tab and then select Firmware update.

Follow the onscreen instructions to download the firmware file and store it on your hard disk. Then select the downloaded file and click Update.

The firmware includes a set of the most commonly used paper presets. Extra paper presets can be downloaded separately; see Download paper presets on page 47.

If you experience very slow progress while uploading the firmware file to the printer, the reason could be that you are using a proxy server. In that case, try bypassing the proxy server and accessing the Embedded Web Server directly.

- In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN Settings, and select the Bypass proxy server for local addresses check box. Alternatively, for more precise control, click the Advanced button and add the printer’s IP address to the list of exceptions, for which the proxy server is not used.
- In Safari for Mac OS, go to Safari > Preferences > Advanced and click the Proxies: Change Settings button. Add the printer’s IP address or its domain name to the list of exceptions, for which the proxy server is not used.

Change the ink absorber

An alert appears on the printer front panel when the ink absorber is reaching its maximum saturation and again when the absorber should be changed.

**NOTE:** The absorber can become excessively dry and fail to function correctly in climates where the relative humidity is consistently below 25%.

**CAUTION:** A saturated or excessively dry ink absorber can cause severe damage to the printheads and other parts of the printer. HP strongly recommends that you promptly change the ink absorber when alerted.

Remove the ink absorber

An ink absorber and disposable plastic gloves are included in the maintenance kit that can be ordered for your printer.
1. On the printer’s front panel, select the icon, then select Replace ink absorber.

2. Open the printer window.

3. Identify the left spittoon.

4. Locate the ink absorber.

5. Lift the tab that extends from the front edge of the absorber.

**NOTE:** Use the disposable plastic gloves to avoid getting ink on your hands.
6. Lift the tab on the absorber until it is clear of the spittoon and you can easily grip the tab.

7. Lift and remove the absorber from the spittoon.

8. Dispose of the soiled ink absorber according to your local regulations.

Insert the ink absorber

1. Grip the new ink absorber as shown.
2. Insert the back edge of the absorber into the fitting in the spittoon.

3. Use your thumb to slide the absorber to the back of the fitting in the spittoon.

4. Push down on the tabbed edge until you hear the absorber click into place. Make sure that the top of the ink absorber is seated flatly and that none of the corners are higher than the plane of the platen.

5. Press the OK key on the front panel. The printer verifies that the ink absorber is correctly seated. If the front panel shows a message that it is not seated correctly, remove the ink absorber, insert it again, and then press the OK key.

Secure disk erase

The printer’s hard disk is used as a temporary storage area for print jobs. The Secure Disk Erase facility can completely erase your information from the hard disk to protect it from unauthorized access. You can choose to erase particular files, or the whole hard disk.
Secure Disk Erase provides three different levels of security:

- **Non-Secure Fast Erase**: all pointers to the information are erased. The information itself remains on the hard disk until the disk space it occupies is needed for other purposes, and it is then overwritten. While it remains on the disk, it is difficult for most people to access, but may be accessed using software designed for the purpose. This is the normal method in which files are erased on most computer systems; it is the fastest method but the least secure.

- **Secure Fast Erase**: all pointers to the information are erased, and the information itself is also overwritten with a fixed character pattern. This method is slower than Non-Secure Fast Erase, but more secure. It may still be possible to access fragments of the erased information by using special tools to detect residual magnetic traces.

- **Secure Sanitizing Erase**: all pointers to the information are erased, and the information itself is repetitively overwritten using an algorithm designed to eliminate any residual traces. This is the slowest method, but the most secure. Secure Sanitizing Erase meets the US Department of Defense 5220-22.m requirements for clearing and sanitization of disk media. This is the default security level when using Secure Disk Erase.

Secure Disk Erase is one of the facilities provided by Web JetAdmin, which is HP’s free Web-based print management software. See [http://www.hp.com/go/webjetadmin/](http://www.hp.com/go/webjetadmin/).

If you have difficulty in using Secure Disk Erase from Web JetAdmin, please contact HP Support. See HP Customer Care on page 176.

**NOTE:** If you choose to erase the whole hard disk, you may be asked to restart the printer several times during the process, which will take about 6 hours with Secure Disk Erase or 24 hours with Secure Sanitizing Erase.
Order accessories

The following accessories can be ordered for your printer.

<table>
<thead>
<tr>
<th>Name</th>
<th>Product number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Designjet HD Scanner</td>
<td>CQ654A</td>
</tr>
<tr>
<td>HP Designjet PostScript®/PDF Upgrade Kit</td>
<td>CQ745A</td>
</tr>
<tr>
<td>HP Designjet Z6100/Z6200 User Maintenance Kit</td>
<td>Q6715A</td>
</tr>
<tr>
<td>HP Designjet External Hard Disk</td>
<td>CN501A</td>
</tr>
<tr>
<td>HP Designjet Z6200 1067-mm (42-in) Take-up Reel</td>
<td>CQ752A</td>
</tr>
<tr>
<td>HP Designjet 1524-mm (60-in) Media Bin</td>
<td>Q6714A</td>
</tr>
<tr>
<td>HP Designjet 1067-mm (42-in) Spindle</td>
<td>CQ753A</td>
</tr>
<tr>
<td>HP Designjet 1524-mm (60-in) Spindle</td>
<td>CQ754A</td>
</tr>
<tr>
<td>HP Jetdirect 635n IPv6/IPsec Print Server</td>
<td>J7961G</td>
</tr>
</tbody>
</table>

The following software can be downloaded for your printer.

<table>
<thead>
<tr>
<th>Name</th>
<th>Download from</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Instant Printing Pro</td>
<td><a href="http://www.hp.com/go/hpinstantprintingutilitypro/">http://www.hp.com/go/hpinstantprintingutilitypro/</a></td>
</tr>
<tr>
<td>Serif PosterPro</td>
<td><a href="http://www.hp.com/go/PosterDesignerPro/">http://www.hp.com/go/PosterDesignerPro/</a></td>
</tr>
</tbody>
</table>
13 Troubleshoot print-quality issues

- General advice
- Troubleshooting tools
- Lines are too thick, too thin, or missing
- Lines appear stepped or jagged
- Parts of lines or text are missing
- Lines are printed double or in the wrong colors
- Lines are blurred (ink bleeds from lines)
- Lines are slightly warped
- Dark or light horizontal lines across the image (banding)
- The image is grainy
- The image has a metallic hue (bronzing)
- The printed output is not flat
- The print smudges when touched
- Ink marks appear on the paper
- Defects near the top of a print
- Colors are inaccurate
- The output is completely blank
- The output contains only a partial print
- The image is clipped
- The image is in one portion of the printing area
- The image is unexpectedly rotated
- The print is a mirror image of the original
- The print is distorted or unintelligible
- One image overlays another on the same print
- Pen settings seem to have no effect
- The image has a wood-grain appearance (aeroworms)
General advice

Use the following approach when you have any print-quality problem:

- To achieve the best performance from your printer, use only genuine HP supplies and accessories, whose reliability and performance have been thoroughly tested to give trouble-free performance and best-quality prints. For details of recommended papers, see Order paper on page 50.

- Make sure that the paper type that you select on the front panel is the same as the paper type that is loaded in the printer. Make sure that the paper type has been calibrated. Also make sure that the paper type that you select in your software is the same as the paper type that you loaded in the printer.

⚠️ CAUTION: If you have the wrong paper type selected, you might experience poor print quality and incorrect colors, and damage to the printheads might occur.

- Make sure that you are using the most appropriate print-quality settings for your purposes. See Select print quality on page 82. You are likely to see lower print quality if you have moved the print-quality slider to the Fast end of the scale, or set the custom quality level to Fast.

- Make sure that your environmental conditions (temperature, humidity) are in the recommended range. See Environmental specifications on page 206.

- Make sure that your ink cartridges and printheads have not passed their expiration dates. See Maintain the ink cartridges on page 136.

- Avoid touching the paper while printing is in progress.

Troubleshooting tools

To access the troubleshooting tools in the Embedded Web Server, select the Support tab. The first two tools can also be accessed from the front panel’s Image quality maintenance menu.

Optimize print quality

This option ensures that printer and supplies are adjusted to deliver optimum print quality. Click Next to execute all calibration and recovery routines automatically. The whole process consumes 80 cm (31.5 in) of paper and may take up to 20 minutes.

⚠️ NOTE: This option can also be selected from the front panel. From the main menu, select ➤, then Optimize print quality.
Optimization suggested actions

This option suggests a series of recommended actions to improve print quality, based on the results of internal checks. These actions may include reseating a printhead, changing paper to run a specific calibration, cleaning some printer component, etc. Execute them in the proposed order.

**TIP:** Use this option if you want to save time by acting directly on the causes of your problem, or if your problem persists after the automatic **Optimize print quality** process.

**NOTE:** This option can also be selected from the front panel. From the main menu, select ![Optimization suggested actions](image)

Most-common issues resolution

This option is designed to help you resolve some of the most common print-quality issues that users encounter in large-format printing:

- Dark or light horizontal lines across the image (banding)
- Graininess
- Poor line quality
- Inaccurate colors

In the first window, select the print-quality issue that you are experiencing and click **Next**. A list of suggestions for corrective action appears along with help to guide you through each action.

Lines are too thick, too thin, or missing

1. Check that the paper type that you have loaded corresponds to the paper type that you selected on the front panel and in your software.
2. Make sure that you are using the appropriate print-quality settings for your purposes. See **Select print quality** on page 82.
3. If you are using a HP-GL/2 driver and the resolution of your image is greater than the printing resolution, you might notice a loss of line quality. You can find the **Max. Application Resolution** option on the Windows driver **Advanced** tab, under **Document Options > Printer Features**. If you change this option, reprint your job if the problem has been solved.
4. If lines are too thin or missing, print the Image Diagnostics Print. See **The Image Diagnostics Print on page 72**.
5. Try aligning the printheads. See Align the printheads on page 71. After alignment, reprint your job if the problem has been solved.

6. Select the icon on the printer’s front panel, and then View loaded paper to see the paper-advance calibration status. If the status is PENDING, perform a paper-advance calibration. See Perform paper advance calibration on page 46.

If the problem persists after you complete these actions, contact your customer service representative for further support.

**Lines appear stepped or jagged**

Use the following procedure if lines in your image appear stepped or jagged when printed:

1. The problem might be inherent in the image. Try to improve the image within the software program that you are using to edit it.

2. Make sure that you are using appropriate print-quality settings. See Select print quality on page 82.

3. If you are using an HP-GL/2 driver, change your image-rendering resolution to 300 dpi or 600 dpi, depending on your printing need. The Max. Application Resolution option in the Windows driver dialog’s Advanced tab, under Document Options > Printer Features.

**Parts of lines or text are missing**

A high-quality large-format print job often requires a large amount of data, and in some specific workflows, the output might not look like you expected. Here are some suggestions to help you to avoid this problem:

- Select a smaller page size and scale to the final page size in the driver or on the front panel.
- Save the file in another format, such as TIFF or EPS, and open it in another program.
- Use a RIP to print the file.
- Reduce the resolution of the bitmap images in your software.
- Select a lower print quality in order to reduce the resolution of the printed image.
- On the Advanced tab of the Windows driver dialog, select Document options, Printer features, and then establish the following settings:
  - Set Send job as bitmap to Enabled (HP-GL/2 driver only).
  - Set Max. Application resolution to 300.

**NOTE:** These settings are described for troubleshooting purposes only and might adversely affect the final output quality or the time necessary to generate the print job. Therefore, restore these settings to their default values if they do not help to solve the problem.
Lines are printed double or in the wrong colors

This problem can have various visible symptoms:

- Colored lines are printed double, in different colors.

  ![Colored lines example]

- The borders of colored blocks are the wrong color.

  ![Border example]

Use these steps to correct this kind of problem:

1. Align the printheads. See Align the printheads on page 71.
2. Make sure that you are using appropriate print-quality settings. See Select print quality on page 82.

Lines are blurred (ink bleeds from lines)

![Blurred line example]
Humidity can cause ink to soak into the paper, making the lines look blurred and fuzzy. Try the following remedies:

1. Make sure that your environmental conditions (temperature, humidity) are suitable for high-quality printing. See Environmental specifications on page 206.

2. Check that the paper type that you select on the front panel is the same as the paper type that you are using. To check, select the icon from the printer’s front panel, and then select View loaded paper.

3. Try changing to a heavier paper type, such as HP Heavyweight Coated Paper, HP Super Heavyweight Coated Paper, or Digital Fine Art paper.

4. If you are using glossy paper, try changing to a different type of glossy paper.

5. Align the printheads. See Align the printheads on page 71.

### Lines are slightly warped

The paper itself might be warped. This can happen if it has been used or stored in an extreme environment. See Environmental specifications on page 206.

### Dark or light horizontal lines across the image (banding)

Try the following remedies if your printed image suffers from added horizontal lines as shown (the color may vary):

1. Make sure that the paper type you have loaded corresponds to the paper type that you select on the front panel and in your software.

2. Make sure that you are using appropriate print-quality settings for your purposes. See Select print quality on page 82. In some cases, you can overcome a print-quality problem merely by selecting a higher print-quality level. For instance, if you have set the print-quality slider to Fast, try setting it to Best. If you change the print-quality settings, reprint your job if the problem has been solved.

3. Print the Image Diagnostics Print. See The Image Diagnostics Print on page 72.
4. Check the paper-advance calibration status on the front panel. If the status is PENDING, you should perform paper-advance calibration. See Perform paper advance calibration on page 46.

5. Try aligning the printheads. See Align the printheads on page 71. After alignment, reprint your job if the problem has been solved.

If the problem persists, contact your customer service representative for further support.

The image is grainy

1. Check that the paper type you have loaded corresponds to the paper type that you select on the front panel and in your software.

2. Check that you are printing on the correct side of the paper.

3. Make sure that you are using appropriate print-quality settings. See Select print quality on page 82. In some cases, you can overcome a print-quality problem merely by selecting a higher print-quality level. For instance, if you have set the print-quality slider to Fast, try setting it to Best. Alternatively, you could try unidirectional printing. If you change the print-quality settings, reprint your job if the problem has been solved.

4. Try aligning the printheads. See Align the printheads on page 71. After alignment, reprint your job if the problem has been solved.

5. Check the paper-advance calibration status on the front panel. If the status is PENDING, you should perform paper-advance calibration. See Perform paper advance calibration on page 46.

If the problem persists, contact your customer service representative for further support. See HP Customer Care on page 176.

The image has a metallic hue (bronzing)

Bronzing describes an image that has a metallic hue when it is viewed from specific angles. Bronzing occurs most commonly when you print pigmented inks on non-matte paper, such as photo paper. If you are using standard print-quality options and the image contains the bronzing effect, move the slider to Quality. See Select print quality on page 82.

If you are experiencing bronzing when printing grayscale images on glossy paper, try using the Full Set of Inks printing option. To do so from the Windows driver, click the Color tab and select Print In Grayscale, and then select the Full Set of Inks option from the drop-down menu.
The printed output is not flat

If the paper does not lie flat when it comes out of the printer, but instead contains shallow waves, you are likely to see defects in the printed image, such as vertical stripes. This can happen when you use thin paper that becomes saturated with ink.

1. Make sure that the paper type you have loaded corresponds to the paper type that you select on the front panel and in your software.

2. Try changing to a thicker paper type, such as HP Heavyweight Coated Paper, HP Super Heavyweight Coated Paper, or thicker Digital Fine Art papers.

The print smudges when touched

The black ink pigment can smudge when a finger or pen touches it. This is particularly noticeable on: vellum, translucent bond, films, productivity photo paper, and natural tracing paper.

Try these remedies to reduce the smudging:

- Try to print in an environment that is not too humid for the printer. See Environmental specifications on page 206.

- Change pure black objects in your image to a dark color, such as dark brown, so that they are printed with colored inks instead of black ink.

- Use HP Heavyweight Coated Paper.

- Increase the drying time. See Change the drying time on page 49.

Ink marks appear on the paper

This problem can occur for several different reasons.

Smears on the front of coated paper

If a lot of ink is used on coated paper, the paper absorbs the ink quickly and expands. As the printheads move over the paper, the printheads come into contact with the paper and smear the printed image.
Whenever you notice this problem, cancel the printing job immediately. Press the Cancel key on the front panel and also cancel the job from your computer software. Otherwise the soaked paper might damage the printheads.

Try the following suggestions to avoid this problem:

- Use a recommended paper type. See Supported paper types on page 31.
- If the image you are printing contains intense color, try using HP Heavyweight Coated Paper.
- Try to increase the margins by relocating the image within the page by using your software application.
- If necessary, try changing to a non-paper-based material such as transparent film.

Smears or scratches on the front of glossy paper

Glossy paper can be extremely sensitive to the bin or to anything else that it contacts soon after printing. This depends on the amount of ink that has been deposited on the paper and the environmental conditions at the time of printing. Avoid any contact with the paper surface and handle the print with care.

Ink marks on the back of the paper

Ink residue on the platen or the input rollers is likely to mark the back of the paper. See Clean the platen on page 133.

Defects near the top of a print

In a defect that affects only the start of a print, within 5.5 cm (2.2 in) of the leading edge of the paper, a band of inconsistent color appears:

Use these steps to avoid this problem:

1. The easiest solution may be to increase the margins by relocating the image within the page in your software application, so that the area of the paper affected by the problem (at the start of the page) will be blank.
2. Align the printheads. See Align the printheads on page 71.
3. Make sure that you are using appropriate print-quality settings. See Select print quality on page 82.
Colors are inaccurate

If the colors of your print do not match your expectations, try the following remedies:

1. Check that the paper type you have loaded corresponds to the paper type that you selected on the front panel and in your software. At the same time, check the color-calibration status. If the status is RECOMMENDED or OBSOLETE, you should perform color calibration. See Color calibration on page 101. If you have made any changes, reprint your job if the problem has been solved.

2. Check that you are printing on the correct side of the paper.

3. Make sure that you are using the appropriate print-quality settings. See Select print quality on page 82. If you have selected the Fast options, you might not get accurate colors. If you change the print-quality settings, reprint your job if the problem has been solved.

4. If you are using Application Color Management, make sure that the color profile that you are using corresponds to the selected paper type and print-quality settings. If you have doubts about which color settings to use, see Color management on page 94. If you need to create a color profile, see Color profiling on page 102.

5. If the problem consists of color differences between your print and your monitor, follow the instructions in the “How to calibrate your monitor” section of the HP Color Center. Reprint your job if the problem has been solved.

6. Print the Image Diagnostics Print. See The Image Diagnostics Print on page 72.


If the problem persists, contact your customer service representative for further support. See HP Customer Care on page 176.

PANTONE* colors are inaccurate

See HP Professional PANTONE* Emulation on page 107.

Colors between different HP Designjets do not match

If you print an image on two different printer models (for instance, on an HP Designjet Z6200 printer series and an HP Designjet 5500 printer series), the colors of the two prints might not match well.

Matching two printing devices that use different ink chemistry, paper chemistry, and printheads is unlikely to be completely successful. Use the information provided here is to attempt to make one printer match another.
**Print with PostScript drivers**

The situation describes printing with the PostScript driver installed for that printer. In this example, we are using an HP Designjet Z6200 printer series and an HP Designjet 5500 printer series.

1. Check that both printers have the most recent firmware version. See Update the printer firmware on page 138.

2. Check that you have the most recent printer driver for both printers. Download the latest versions for any HP printer from http://www.hp.com/go/Z6200/drivers/.

3. Make sure that Color Calibration is turned on. On the front panel of the HP Designjet Z6200, select the icon, and then select **Printer configuration > Color calibration > On**.

4. Load the printers with the same type of paper.

5. Check that the Paper Type setting on the front panel corresponds to the paper that you have loaded.

6. Use you normal settings to print your image on the HP Designjet 5500.

7. Now prepare to print the same image on the HP Designjet Z6200.

   In your software, set the color space of the image to emulate the HP Designjet 5500 and the specific paper type that you used in that printer. The data sent to the driver must be already converted to this emulation color space, which is a CMYK color space. See the online help for the software program to find information about how to do this. In this way, the Z6200 will emulate the colors that the 5500 can produce when printing on that paper type.

8. In the PostScript driver for the HP Designjet Z6200, go to the Color Management section and set the CMYK input profile to the same HP Designjet 5500 color space that you selected in the software (the emulation color space).

9. Print the image on the HP Designjet Z6200.

**Print with HP-GL/2 drivers**

The situation describes printing with the HP-GL/2 driver installed for that printer.

1. Check that both printers have the most recent firmware version. See Update the printer firmware on page 138.

2. Check that you have the most recent printer drivers for both printers. You can download the latest versions for any HP printer from http://www.hp.com/go/Z6200/drivers/.

3. Make sure that Color Calibration is turned on. On the front panel of the HP Designjet Z6200 printer series, select the icon, then **Printer configuration > Color calibration > On**.

4. Load the printers with the same type of paper.

5. Check that the Paper Type setting on the front panel corresponds to the paper you have loaded.
6. In the HP-GL/2 driver for the HP Designjet Z6200, click the **Color** tab, and select **Printer Emulation** from the list of color management options. Then select the HP Designjet 5500 from the list of emulated printers.

7. In the HP-GL/2 driver for the HP Designjet 5500, click the **Options** tab, and then select **Manual Color > Color Control > Match Screen.** Also click the **Paper Size** tab, and then select **Paper Type.**

### Print the same HP-GL/2 file

The situation describes how to produce an HP-GL/2 file (also known as a PLT file) with the HP-GL/2 driver installed for one printer that you intend to send to another printer.

1. Check that both printers have the most recent firmware version. See **Update the printer firmware on page 138.**

2. Make sure that Color Calibration is turned on. At the front panel of the HP Designjet Z6200, select the **icon, then Printer configuration > Color calibration > On.**

3. Load the printers with the same type of paper.

4. Check that the Paper Type setting on the front panel corresponds to the paper you have loaded.

5. If you have an HP-GL/2 file for an HP Designjet 5500 and you want to print it on an HP Designjet Z6200, use the Embedded Web Server or the front panel.
   - Through the Embedded Web Server: leave the color options set to **Default.**
   - On the front panel: select the **icon, and then select Printing preferences > Color options > Emulate printer > HP Designjet 5500 Series.**

   For other HP Designjet printers, set both printers to match the screen colors (sRGB, if that is available), as when printing with separate HP-GL/2 drivers.

### The output is completely blank

If the front-panel graphic language setting is **Automatic** (the default), try the other settings: **PostScript** for a PostScript file, **HP-GL/2** for an HP-GL/2 file, and so on. Then send the file again.

When you have finished this particular print, remember to reset the graphic language to **Automatic.**

### The output contains only a partial print

- If you pressed **Cancel** before the printer received all the data, you ended the data transmission and will have to print the page again.

- The **I/O timeout** setting might be too short. This setting determines how long the printer waits for the computer to send more data, before deciding that the job is finished. On the front panel, increase the **I/O timeout** setting to a longer period and then send the print again by selecting the Connectivity menu icon **then Advanced > Select I/O timeout.**

- A communications problem between your computer and the printer might exist. Check your USB or network cable.
Check that your software settings are correct for your current page size (for example, long-axis prints).

If you are using network software, make sure that it has not timed out.

The image is clipped

Clipping normally indicates a discrepancy between the actual printable area on the loaded paper and the printable area as described by your software. You can often identify this kind of problem before printing by previewing your print. See Preview a print on page 87.

Check the actual printable area for the paper size that you have loaded.

\[
\text{printable area} = \text{paper size} - \text{margins}
\]

Check what your software understands to be the printable area (which it might cite as "printing area" or "imageable area"). For example, some software programs assume standard printable areas that are larger than those used in this printer.

If you have defined a custom page size that has very narrow margins, the printer might impose its own minimal margins and clip your image slightly. You might want to use a larger paper size. See Select margins options on page 85.

If your image contains its own margins, you might be able to print it successfully by using the Clip Contents by margins option. See Select margins options on page 85.

If you are trying to print a very long image on a roll, make sure that your software can print an image of that size.

You might have asked to rotate the page to landscape orientation on a paper size that is not sufficiently wide.

If necessary, reduce the size of the image or document in your software, so that it fits between the margins.

Other explanations exist for a clipped images. Some programs, such as Adobe Photoshop, Adobe Illustrator, and CorelDRAW, use an internal 16-bit coordinate system which means that they cannot handle an image of more than 32,768 pixels. If you try to print a larger image, the bottom of the image will be clipped. To print the entire image, try these suggestions:

If you are using an HP-GL/2 driver, you can reduce the resolution so that the whole image requires fewer than 32,768 pixels. The Windows driver includes an option called Max. Application Resolution, which reduces the resolution automatically. The option is on the Advanced tab, under Document Options > Printer Features.

Save the file in another format, such as TIFF or EPS, and open it in another program.

Use a RIP to print the file.

The image is in one portion of the printing area

In the software, have you selected a page size that is too small?

Does your software read the image as being in one portion of the page?
The image is unexpectedly rotated

On the front panel, select the icon, and then select Printing preferences > Paper options > Rotate. Check that the setting is what you wanted.

For non-PostScript files: if Nesting is On, pages are sometimes automatically rotated to save paper. See Nest jobs to save paper on page 92.

The print is a mirror image of the original

On the front panel, select the icon, and then select Printing preferences > Paper options > Enable mirror image. Check that the setting is what you wanted.

The print is distorted or unintelligible

- The interface cable that is connecting your printer to your network (or to your computer) might be faulty. Try another cable.

- On the front panel, select the icon, and then select Printing preferences > Select graphics language. If the language setting is Automatic (the default), try the other settings: PostScript for a PostScript file, HP-GL/2 for an HP-GL/2 file, on so on. Then send the file again.

- Depending on the software, drivers, and RIPs that you are using with your printer, different ways to solve this problem exist. Refer to the vendor’s user documentation for details.

One image overlays another on the same print

The I/O timeout setting might be too long. On the front panel, decrease the setting and print again. Select the Connectivity menu icon then Advanced > Select I/O timeout.

Pen settings seem to have no effect

- You have changed the settings on the front panel by selecting the icon followed by Printing preferences > HP-GL/2 > Define palette, but did not select that palette in Printing preferences > HP-GL/2 > Select palette.

- To enable the software-driven pen settings, go to the front panel and select the icon followed by Printing preferences > HP-GL/2 > Select palette > Software.
The image has a wood-grain appearance (aeroworms)

Aeroworms are wavy, horizontal bands produced by air-induced dot placement error (DPE). In extreme cases, aeroworms give the image a wood-grain appearance. The problem occurs most commonly on print jobs that are set for low-quality and high-speed. It does not occur when the custom print-quality setting is set to “best.”

To eliminate aeroworms, select a higher IQ print setting. See Select print quality on page 82.
14 Troubleshoot paper issues

- The paper cannot be loaded successfully
- The paper has jammed
- Prints do not stack correctly in the bin
- Automatic paper-cutter does not function
- Take-up reel paper jammed
- Take-up reel does not wind
The paper cannot be loaded successfully

Here are a few things to check if you cannot successfully load the paper.

- The paper might be loaded at an angle (skewed or mislocated). Make sure that the right edge of the paper is aligned with the half-circle on the right-hand side of the platen, and that the leading edge of the paper is aligned with the metal bar in the platen.

- The paper might be crumpled or warped, or have irregular edges.

- If the paper jams in the paper path to the platen, the leading edge of the paper might not be straight or clean. Remove the initial 2 cm (1 in) of paper from the roll and try again. This might be necessary even with a new roll of paper.

- Make sure that the spindle is correctly inserted.

- Make sure that the paper is correctly loaded on the spindle, and that it loads over the roll towards you.

- Check that the paper is wound tightly on the roll.

The paper has jammed

When a jam occurs, the Possible paper jam message usually appears in the front panel, with one of two error codes:

- 81:01 indicates that paper cannot advance into the printer.

- 86:01 indicates that the printhead carriage cannot move from side to side.

Check the printhead path

1. Turn off the printer at the front panel, then also switch off the power switch at the rear.
2. Open the printer window.

3. Try to move the printhead carriage out of the way.

4. Lift the paper-load lever as far up as it will go.

5. Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

6. Carefully pull the remainder of the roll down and out of the printer.

7. Turn on the printer.
8. Reload the roll. See Load a roll into the printer on page 36.

9. If some paper continues to cause an obstruction within the printer, it can often be cleared by loading a rigid paper type into the printer.

10. If you find that you have print-quality problems after a jam, try realigning the printheads. See Align the printheads on page 71.

**Check the paper path**

- This problem can occur when a roll has finished and the end of the roll is stuck to the cardboard core. If this has happened, cut the end of the roll away from the core. Then feed the paper through the printer, and load a new roll.

- Otherwise, follow the procedure described above, under Check the printhead path on page 160

**Prints do not stack correctly in the bin**

**NOTE:** This topic applies to the Z6200 1.1m printer only.

- Paper often tends to curl near the end of a roll, which can cause stacking problems. Load a new roll, or remove prints manually as they are completed.

- If you are mixing prints or nesting sets of several different sizes, you might experience stacking problems because of the different sizes of paper in the bin.

**Automatic paper-cutter does not function**

The automatic paper-cutter is disabled when the take-up reel is in use, and when printing on some heavy paper types, which might damage the cutter.

**Take-up reel paper jammed**

If the paper is severely damaged on the take-up reel spindle core, do not use the printer’s cutter to cut and remove the paper. Instead, cut the paper manually as close as possible to the printer window, and then remove the roll. See Unload a roll from the printer on page 37.

**Take-up reel does not wind**

Predictably, if the take-up reel is not winding as anticipated, the printed output is likely to end up on the floor. If the printer recognizes a problem with the take-up reel, it will interrupt the print job until the issue is corrected. If the printer does not recognize a problem, the job will continue to print. The following table highlights possible issues and solutions.
<table>
<thead>
<tr>
<th>Take-up reel LED status</th>
<th>Issue</th>
<th>Print job interrupted?</th>
<th>Possible cause</th>
<th>Possible solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blinking quickly</td>
<td>Take-up reel is not winding</td>
<td>Yes</td>
<td>The sensor beam was blocked for more than 3 seconds.</td>
<td>Make sure that the take-up reel sensors are not blocked by a strip of paper, the collection bin if you are using the Z6200 1.1m printer, or any objects. See the following graphic. Make sure that the collection bin is placed behind the foot brace. Also ensure that the take-up reel power switch is in the On position.</td>
</tr>
<tr>
<td>Blinking slowly</td>
<td>Take-up reel is not winding</td>
<td>No</td>
<td>The sensor cables are loose or unplugged.</td>
<td>Ensure that the sensor cables are correctly secured.</td>
</tr>
<tr>
<td>Solid red</td>
<td>Take-up reel is not winding</td>
<td>No</td>
<td>There is too much resistance on the take-up reel motor.</td>
<td>Ensure that the paper is not winding too tightly. A loop-shaping core should be inserted and hanging as shown in step 10 of Use the take-up reel on page 37.</td>
</tr>
<tr>
<td>Solid green</td>
<td>Take-up reel is not winding</td>
<td>No</td>
<td>The take-up reel power switch is in the Off position</td>
<td>Ensure that the take-up reel power switch is in the On position.</td>
</tr>
<tr>
<td>Solid green</td>
<td>Take-up reel is winding in the wrong direction</td>
<td>No</td>
<td>The take-up reel wind-direction switch is in the wrong winding position.</td>
<td>Flip the take-up reel wind-direction switch to the correct position.</td>
</tr>
</tbody>
</table>

The following graphic shows the take-up reel sensors and cable.

1. Take-up reel sensor
2. Take-up reel sensor and cable housing unit
15 Troubleshoot ink-system issues

- Cannot insert an ink cartridge
- Cannot insert a printhead
- Cannot insert the maintenance cartridge
- Front panel recommends reseating or replacing a printhead
- Clean the printheads
- Align the printheads
Cannot insert an ink cartridge

1. Check that you have the correct type of cartridge (model number).
2. Check that the colored label on the cartridge is the same color as the label on the slot.
3. Check that the cartridge is correctly oriented, the arrow on the front of the ink cartridge should face upwards.

△ CAUTION: Never clean inside the ink cartridge slots.

Cannot insert a printhead

1. Check that you have the correct type of printhead (model number).
2. Check that you have removed the protective caps and the clear protective tape from the printhead.
3. Check that the colored label on the printhead is the same color as the label on the slot.
4. Check that the printhead is correctly oriented (compare with the others).
5. Check that you have closed and latched the printhead cover.

Cannot insert the maintenance cartridge

Check that the maintenance cartridge is of the correct type and correctly oriented.

Front panel recommends reseating or replacing a printhead

1. Remove the printhead and check that its protective film has been removed.
2. Clean the electrical connections between the printhead and the carriage. See Clean the electrical connections on a printhead on page 68.
3. Reinsert the printhead into the carriage and check the front panel message.
4. If the problem persists, insert a new printhead.

Clean the printheads

Periodic printhead cleaning is performed automatically, as long as the printer is kept turned on. However, you should clean the printheads if you are experiencing poor image quality and cannot resolve the issues by other methods. This ensures that there is fresh ink in the nozzles and helps to prevent nozzle clogs.

If you have printed the Printhead status plot, you know which colors are failing. Clean the pair of printheads that are not performing adequately. If you are not sure which printheads to clean, clean all of the printheads.

To clean the printheads, go to the printer’s front panel and select the icon, then Clean printheads, then select which printheads you want to clean. You can clean all of the printheads or only some of them.
Cleaning all of the printheads takes about 5 minutes. Cleaning any two printheads takes about 3 minutes.

**NOTE:** Cleaning all printheads uses more ink than cleaning a single pair.

**NOTE:** HP recommends that you purge the ink from the printheads before printing a job if the printer has been turned off for more than six weeks or if you are experiencing inconsistent colors from print to print after long storage periods. Purging the ink from the printheads helps to ensure maximum color consistency; it is *not* a remedy for poor printhead health.

**Align the printheads**

Precise alignment between printheads is essential for color accuracy, smooth color transitions, and sharp edges in graphical elements. Your printer has an automatic printhead alignment process which runs whenever a printhead has been accessed or replaced.

In the case of a paper jam, if you have used a custom paper, or if you are experiencing problems with color accuracy; you might need to align the printheads. See Align the printheads on page 71.

**NOTE:** If you experience a paper jam, HP recommends that you reinsert the printheads and align the printheads.

**TIP:** Use the same paper you intend to print on to align the printheads. Photo paper is recommended for the best results. Plain; bond; and thin, coated papers are acceptable, but provide marginal results.

**WARNING!** Colored papers, glossy canvas, and transparent materials such as translucent bond, clear film, tracing paper, and vellum are not suitable for aligning the printheads. However, if you must perform printhead alignment with a material that is not supported, make sure you use a material with the same thickness as the material you are going to use for printing.

**Reinsert printheads procedure**

1. If the printhead alignment process is running and the wrong paper is loaded, press the Cancel key on the front panel.

   **CAUTION:** Do not print if the printhead alignment process has been canceled.

2. Load the paper you want to use. Photo paper is recommended for the best results.

   **WARNING!** Colored papers, glossy canvas, and transparent materials such as translucent bond, clear film, tracing paper, and vellum are not suitable for aligning the printheads. However, if you must perform printhead alignment with a material that is not supported, make sure you use a material with the same thickness as the material you are going to use for printing.
3. Remove and reinsert all of the printheads. See Remove a printhead on page 63 and Insert a printhead on page 66. This starts the printhead alignment process.

⚠️ **NOTE:** Make sure the printer window is closed during printhead alignment.

4. The process takes about 10 minutes. Wait until the front panel shows that the process is complete before using the printer.

⚠️ **NOTE:** A calibration image is printed during the printhead alignment process. The front panel shows if there were any errors in the process.

### Image Quality Maintenance menu procedure

1. Load the paper you want to use. Photo paper is recommended for the best results. Plain; bond; and thin, coated papers are acceptable, but provide marginal results.

⚠️ **WARNING!** Colored papers, glossy canvas, and transparent materials such as translucent bond, clear film, tracing paper, and vellum are not suitable for aligning the printheads. However, if you must perform printhead alignment with a material that is not supported, make sure you use a material with the same thickness as the material you are going to use for printing.

2. Go to the front panel and select the [ ] icon, then select **Align printheads**. The printer checks that a sufficient amount of paper exists to perform printhead alignment.

3. If the paper type that is loaded is acceptable for printhead alignment, the printer performs the alignment and prints an alignment pattern.

⚠️ **NOTE:** Make sure the printer window is closed during printhead alignment.

4. The process takes about 10 minutes. Wait until the front panel shows that the process is complete before using the printer.
Scan errors during alignment

If the alignment process fails, a **Scanning problems** message appears on the front panel. This indicates that the alignment was not completed successfully. Therefore, the printheads are not aligned and the alignment should be repeated before printing. The problem might be because of one of the following scenarios:

- The type of paper used in the printhead alignment process was not acceptable. Repeat the alignment process using one of the recommended paper types.
- The printheads are not clean. Clean the printheads. See [Clean the printheads on page 165.](#)
- The printer window was open during the printhead alignment process. Repeat the alignment process with the printer window closed.

If the problem persists after following the recommended remedies, try replacing all of the printheads. If the problem persists after replacing the printheads, a failure in the scanning system may exist.
16 Troubleshoot other issues

- The printer is not printing
- The software program slows down or stalls while generating the print job
- The printer seems slow
- Communication failures between computer and printer
- Cannot access the Embedded Web Server
- “Out-of-memory” error message
- The platen rollers squeak
- Cannot access the HP Utility
- Print job canceled and purged when held for preview
- Printer alerts
The printer is not printing

Possible reasons why a file you have sent from your computer is not printing when expected, include the following:

- A problem with the electrical power might exist. If the printer is not performing and the front panel does not respond, check that the power cable is correctly connected and that the electrical socket is functioning.

- An unusual electromagnetic phenomena may exist, such as strong electromagnetic fields or severe electrical disturbances. Such occurrences can cause the printer to behave strangely, or even stop working. Turn off the printer by using the Power key on the front panel, wait until the electromagnetic environment has returned to normal, and then turn the printer on again. If the problems persist, contact your customer service representative.

- The graphic language setting might be incorrectly set.

- The correct printer driver might not have been installed in your computer.

- One of the following paper scenarios might exist:
  - The paper name that appears on the front panel does not reflect the paper that is loaded in the printer.
  - There is not a sufficient amount of paper on the loaded roll to print the entire job.

Under these conditions, one print job might be printed, while another print job is held in the print queue. To resolve this issue, unload the roll from the printer and load a new roll, using the front panel to guide you through the process.

- The nesting setting might be On and the printer is waiting for the nest timeout to expire. Under this condition, the front panel shows the remaining time.

- You might have requested a print preview in your printer driver. Under this condition, the preview appears in a Web browser.

The software program slows down or stalls while generating the print job

Large quantities of data might be necessary to generate a high-quality large-format print job. This can cause your software program to slow down significantly or stall. Lowering the print resolution may help to avoid this scenario, however, lowering the print resolution reduces image quality.

In the Windows HP-GL/2 driver, click the Advanced tab, select Document options > Printer features, and then set Max. Application resolution to 300.

The printer seems slow

Here are some possible explanations:

- Did you set the print quality to Best? Images printed with the Best print-quality setting require more time to print.

- Did you specify the correct paper type when loading the paper? Check that the paper type that appears on the front panel matches the paper that is loaded in the printer.
• Is your printer connected to a network? Check that all components used in the network (network interface cards, hubs, routers, switches, and cables) are capable of high-speed operation. Is there a lot of traffic from other devices on the network?

• Did you set the drying time to **Extended**? Try changing the drying time to **Automatic**. See *Change the drying time* on page 49.

• Are the printheads in good condition? Printing time might increase when a printhead needs cleaning. Check the printhead status on the front panel or through the Embedded Web Server. Clean or replace printheads if necessary.

• Do your image contain high-density, black fills? Printing time might increase for images containing high-density, black fills.

**Communication failures between computer and printer**

Some symptoms are:

• The front-panel display does not show the **Receiving** message when you have sent an image to the printer.

• Your computer shows an error message when you try to print.

• Your computer or printer stalls when transferring data.

• Your printed output shows random or inexplicable errors (misplaced lines, partial graphics, and so on).

To solve a communication problem:

• Make sure that you have selected the correct printer in your software program.

• Make sure that the printer works correctly when printing from other software programs.

• Remember that large images usually require more time to receive, process, and print.

• If the printer is connected to your computer by a USB cable, try disconnecting and reconnecting the cable.

• If the printer is connected to your computer through any other intermediate devices, such as switch boxes, buffer boxes, cable adapters, or cable converters, remove the intermediate device and try connecting the printer directly to your computer.

• Try another interface cable. See *Choose which connection method to use* on page 14.

• Make sure that the graphic language setting is correctly set.

**Cannot access the Embedded Web Server**

If you have not done so already, please read *Access the Embedded Web Server* on page 23.
**NOTE:** If you connect your printer directly to your computer with a USB cable, use the HP Utility.

1. Go to the front panel and select the Connectivity menu icon, then **Advanced > Embedded Web Server > Allow EWS > On.**

2. If you have a TCP/IP connection to your printer, go to the front panel and select the Connectivity menu icon.

3. Select the type of connection you are using.

4. Select **View Information.**

5. The information should read: **IP enabled: Yes.** If it does not, you might need to use a different connection.

If you still cannot access the Embedded Web Server, turn the printer off with the **Power** key on the front panel and then turn it on again.

If you experience very slow progress while trying to access the Embedded Web Server, the problem could be that you are using a proxy server. Try bypassing the proxy server and accessing the Embedded Web Server directly.

- In Internet Explorer 6 for Windows, go to **Tools > Internet Options > Connections > LAN Settings,** and select the **Bypass proxy server for local addresses** check box. You can also click the **Advanced** button to add the printer’s IP address to the list of exceptions, for which the proxy server is not used.

- In Safari for Mac OS, go to **Safari > Preferences > Advanced** and click the **Proxies: Change Settings** button. Add the printer’s IP address or its domain name to the list of exceptions, for which the proxy server is not used.

**“Out-of-memory” error message**

There is no direct relationship between the size of a file in your computer and the amount of memory needed to print the file. Because of file compression and other factors, it is difficult to estimate how much memory is needed to print a job. It is possible that the printer will lack sufficient memory to print a certain job, despite having printed larger jobs in the past. Adding memory to your printer is one solution.

If you are using the Windows HP-GL/2 driver, printer memory problems can often be resolved by clicking the **Advanced** tab, selecting **Document options,** selecting **Printer features,** and then selecting **Print job as raster.**

**NOTE:** If you select this option, the time needed to process the job in your computer might be considerably longer.

**The platen rollers squeak**

It might be necessary to oil the rollers. Locate the oil bottle in the maintenance kit that came with your printer.

1. Turn off the printer by using the **Power** key on the front panel.
2. Open the printer window.

3. Locate the small holes in the platen near some of the rollers.

4. Put three drops of oil into each hole in the platen.

**NOTE:** Be careful not to spill oil onto the platen.
5. If oil spills onto the platen, wipe the platen clean with a cloth.

6. Lower the printer window.

Cannot access the HP Utility

If you have not done so already, please read Access the HP Utility on page 24.

1. Go to the front panel and select the Connectivity menu icon then Advanced > Web services > HP Utility Software > Enable.

2. If you have a TCP/IP connection to your printer, go to the front panel and select the Connectivity menu icon again.

3. Select the type of connection you are using.

4. Select View Information.

If you still cannot connect, turn the printer off by using the Power key on the front panel and then turn it on again.

Print job canceled and purged when held for preview

The printer can store up to 64 pages for preview. If the job that you selected for preview contains more than 64 pages, the job will be canceled and purged without notification when the printer starts to process the sixty-fifth page. If you want to preview a job that has more than 64 pages, press the Continue button before the printer starts to process the sixty-fifth page. Because the preview image is ready as soon as the first page is processed, you should have enough time to check the preview image.
Printer alerts

Your printer can communicate two types of alerts:

- **Errors:** Mainly alerting you to the fact that the printer is unable to print. However, in the driver, errors can also alert you to conditions that could ruin the print, such as clipping, even if the printer is able to print.

- **Warnings:** Alert you when the printer needs attention either for an adjustment, such as a calibration or for a possible unprintable situation, such as a preventive maintenance or low ink.

There are four different alert communicators within your printer’s system.

- **Front-panel display:** The front panel shows only the most relevant alert at a time. It generally requires the user to press the OK key for confirmation, but in the case of a warning, it disappears after a timeout. There are permanent alerts, such as "ink cartridge low on ink", that reappear when the printer becomes idle and there is not another more severe alert.

- **Embedded Web Server:** The upper-right corner of the Embedded Web Server window shows the printer status. If there is an alert in the printer, the status shows the alert text.

- **Driver:** The driver shows alerts. The driver warns about job configuration settings that may produce a problem in the final output. If the printer is not ready to print, it displays a warning.

- **HP Utility:** To see alerts, go to the Overview tab and review the Items needing attention list on the right-hand side.

By default, alerts are displayed only when you are printing and there are printing problems, for example: cartridge low or out of ink or printer out of paper. If alerts are enabled and there is a problem that prevents printing, you see a pop-up window, which explains why the printer is not going to print. Follow the instructions to achieve your required result.

**NOTE:** There are environments that do not support bidirectional communication, for example: a Windows computer connected to the printer with USB. In those cases, alerts do not reach the job owner.
17 HP Customer Care

- Introduction
- HP Professional Services
- HP Instant Support
- HP Proactive Support
- Customer Self Repair
- Contact HP Support
**Introduction**

HP Customer Care offers award-winning support to ensure you get the most from your HP Designjet, providing comprehensive, proven support expertise and new technologies to give you unique end-to-end support. Services include setup and installation, troubleshooting tools, warranty upgrades, repair and exchange services, phone and Web support, software updates and self-maintenance services. To find out more about HP Customer Care, please visit us at:

http://www.hp.com/go/graphic-arts/

or call us on the telephone (see Contact HP Support on page 179). To register your warranty:

http://register.hp.com/

**HP Professional Services**

**Knowledge Center**

Enjoy a world of dedicated services and resources to ensure you always get the best performance from your HP Designjet products and solutions.

Join the HP community at the Knowledge Center, your large-format printing community, for 24×7 access to:

- Multimedia tutorials
- Step-by-step how-to guides
- Downloads — the latest product firmware, drivers, software, paper presets, etc.
- Technical support — online troubleshooting, customer care contacts and more
- Workflows and detailed advice for completing various printing tasks from particular software applications
- Forums for direct contact with the experts, both HP and your colleagues
- Warranty tracking online, for your peace of mind
- Latest product information — products, supplies, accessories, software, etc.
- Supplies Center for all you need to know about ink and paper

The Knowledge Center can be found at the following locations, depending on your product:

- http://www.hp.com/go/T2300ps/knowledgecenter/

By customizing your registration for the products you have purchased and your type of business, and by setting your communication preferences, you decide the information you need.

**HP Start-up Kit**

The HP Start-up Kit is the DVD that comes with your product; it contains the product’s software and documentation.
HP Care Packs and Warranty Extensions

HP Care Packs and Warranty Extensions allow you to extend your product's warranty beyond the standard period.

They include remote support. On-site service is also provided if necessary, with two alternative response-time options.

- Next business day
- Same business day, within four hours (may not be available in all countries)

For more information on HP Care Packs, please visit [http://www.hp.com/go/printservices/](http://www.hp.com/go/printservices/).

HP Installation

The HP Installation service unpacks, sets up and connects the product for you.

This is one of the HP Care Pack services; for more information, please visit [http://www.hp.com/go/printservices/](http://www.hp.com/go/printservices/).

HP Instant Support

HP Instant Support Professional Edition is HP's suite of troubleshooting tools that collect diagnostic information from your product and match it with intelligent solutions from HP's knowledge bases, allowing you to resolve problems as quickly as possible.

You can start an HP Instant Support session by clicking on the link provided on the Troubleshooting page of your product's Embedded Web Server. See Access the Embedded Web Server on page 23.

To be able to use HP Instant Support:

- You must have a TCP/IP connection to your product, because HP Instant Support is accessible only through the Embedded Web Server.
- You must have access to the World Wide Web, because HP Instant Support is a Web-based service.

HP Instant Support is currently available in English, Korean, Simplified Chinese and Traditional Chinese.


HP Proactive Support

HP Proactive Support helps reduce costly product downtime by preemptively identifying, diagnosing and resolving product issues before they become problems for you. HP's Proactive Support tool is designed to help businesses of all sizes reduce support costs and maximize productivity—all with the click of a mouse.

A component of the HP Imaging and Printing suite of services, Proactive Support helps you gain control of your printing environment—with a clear focus on maximizing the value of your investment, increasing product uptime and reducing product management costs.

HP recommends that you enable Proactive Support right away to save you time and prevent problems before they occur, reducing costly downtime. Proactive Support runs diagnostics and checks for software and firmware updates.
You can enable Proactive Support in the HP Utility for Windows or the HP Printer Monitor for Mac OS, where you can specify the frequency of connections between your computer and HP’s Web server, and the frequency of diagnostic checks. You can also choose to run the diagnostic checks at any time. To change these settings:

- In the HP Utility for Windows, select the **Tools** menu, then **HP Proactive Support**.
- In the HP Printer Monitor for Mac OS, select **Preferences > Monitoring > HP Proactive Support**.

If Proactive Support finds any potential problem, it notifies you with an alert, which will explain the problem and recommend a solution. In some cases, the solution may be applied automatically; in other cases, you may be asked to perform some procedure to solve the problem.

### Customer Self Repair

HP’s Customer Self Repair program offers our customers the fastest service under either warranty or contract. It enables HP to ship replacement parts directly to you (the end user) so that you can replace them. Using this program, you can replace parts at your own convenience.

#### Convenient, easy to use

- An HP Support Specialist will diagnose and assess whether a replacement part is required to address a defective hardware component.
- Replacement parts are express-shipped; most in-stock parts are shipped the very same day you contact HP.
- Available for most HP products currently under warranty or contract.
- Available in most countries.


### Contact HP Support

HP Support is available to you by telephone. What to do before you call:

- Review the troubleshooting suggestions in this guide.
- Review the relevant driver documentation.
- If you have installed third-party software drivers and RIPs, see their documentation.
- If you call one of the Hewlett-Packard offices, please have the following information available to help us answer your questions more quickly:
  - The product you are using: the product number, the serial number and the service ID, which you can find by using the Information icon on the front panel
  - If there is an error code on the front panel, note it down; see Front-panel error messages on page 199
  - The computer you are using
  - Any special equipment or software you are using (for example, spoolers, networks, switchboxes, modems or special software drivers)
• The cable you are using (by part number) and where you purchased it
• The type of interface used on your product (USB or network)
• The software name and version you are currently using
• Print out the service information prints. You may be asked to fax them to the support center helping you.

On the front panel: select the icon, then **Service information prints > Print all pages**.

Through the Embedded Web Server: go to the **Service support** page in the **Support** tab, and then select **Printer information > Print all pages**.

**Telephone number**

A Overnight job scenario

In this scenario, the print service provider (PSP) is nearing the end of the business day and receives a new order which requires delivery early the next day. The printer is currently printing and there are jobs in the queue which must also be delivered the next day. The best solution is to queue the new job and print it overnight.

The following information describes the necessary tasks to ensure worry-free overnight printing.

Task 1: Handle the digital content

The following steps will help you to successfully handle the digital content.

1. Open the PDF file in Adobe Acrobat.
2. Ensure you have all the necessary information to submit the job, including fonts and high-resolution images.
3. Check the orientation, margins, typography, color and resolution to ensure that there are no printing or finishing inconsistencies.
4. Print a draft copy of the work on a small printer as a proof for validation.
5. Generate the PDF for the RIP.
6. Move the PDF file to the RIP station.

**NOTE:** Ensure the job can be completed and delivered on time given the current workload and the paper and ink supplies.

Task 2: Handle the paper

Ensure that there is enough paper left in the current roll to accommodate all of the queued jobs and the new order. If there is not enough paper left, pause the print queue and load a new roll.

The table below identifies sections of this user’s guide which will help you to quickly find information on handling paper.

<table>
<thead>
<tr>
<th>Task Elements</th>
<th>See this section of the user’s guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unload paper</td>
<td>See <a href="#">Unload a roll from the printer on page 37</a></td>
</tr>
<tr>
<td>Load paper</td>
<td>See <a href="#">Load a roll onto the spindle on page 33</a></td>
</tr>
<tr>
<td>Load a roll onto the take-up reel</td>
<td>See <a href="#">Load a roll onto the take-up reel on page 38</a></td>
</tr>
<tr>
<td>Check the paper preset</td>
<td>See <a href="#">View information about the paper on page 46</a></td>
</tr>
</tbody>
</table>
Table A-1  Handle the paper (continued)

<table>
<thead>
<tr>
<th>Task Elements</th>
<th>See this section of the user’s guide</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Troubleshooting</strong></td>
<td></td>
</tr>
<tr>
<td>I can’t load the paper</td>
<td>See The paper cannot be loaded successfully on page 160</td>
</tr>
<tr>
<td>I can’t find the paper preset for my paper</td>
<td>See Download paper presets on page 47 and Update the printer firmware on page 138</td>
</tr>
<tr>
<td>I don’t have HP paper</td>
<td>See Use non-HP paper on page 48 and Supported paper types on page 31</td>
</tr>
<tr>
<td>The paper has jammed</td>
<td>See The paper has jammed on page 160</td>
</tr>
<tr>
<td>The take-up reel paper has jammed</td>
<td>See Take-up reel paper jammed on page 162</td>
</tr>
<tr>
<td>The take-up reel does not wind</td>
<td>See Take-up reel does not wind on page 162</td>
</tr>
</tbody>
</table>

**NOTE:**  For additional information about paper, see Handle the paper on page 29.

Task 3: Handle the ink system

Ensure that your printheads are healthy and that ink levels are enough to print all queued jobs. If the ink levels are too low, pause the print queue and replace and align the components as necessary.

The table below identifies sections of this user’s guide which will help you to quickly find information on handling the ink system.

Table A-2  Handle the ink system

<table>
<thead>
<tr>
<th>Task Elements</th>
<th>See this section of the user’s guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check ink cartridge information</td>
<td>See View ink cartridge information on page 77</td>
</tr>
<tr>
<td>Remove an ink cartridge</td>
<td>See Remove an ink cartridge on page 60</td>
</tr>
<tr>
<td>Insert an ink cartridge</td>
<td>See Insert an ink cartridge on page 62</td>
</tr>
<tr>
<td>Check printhead information</td>
<td>See View printhead information on page 78</td>
</tr>
<tr>
<td>Remove a printhead</td>
<td>See Remove a printhead on page 63</td>
</tr>
<tr>
<td>Insert a printhead</td>
<td>See Insert a printhead on page 66</td>
</tr>
<tr>
<td>Align printheads</td>
<td>See Align the printheads on page 71</td>
</tr>
<tr>
<td>Remove the maintenance cartridge</td>
<td>See Remove the maintenance cartridge on page 74</td>
</tr>
<tr>
<td>Insert the maintenance cartridge</td>
<td>See Insert the maintenance cartridge on page 76</td>
</tr>
<tr>
<td><strong>Troubleshooting</strong></td>
<td></td>
</tr>
<tr>
<td>I cannot access the Embedded Web Server</td>
<td>See Cannot access the Embedded Web Server on page 171</td>
</tr>
<tr>
<td>I cannot insert an ink cartridge</td>
<td>See Cannot insert an ink cartridge on page 165</td>
</tr>
<tr>
<td>I cannot insert a printhead</td>
<td>See Cannot insert a printhead on page 165</td>
</tr>
<tr>
<td>The printer will not recognize the printhead</td>
<td>See Clean the electrical connections on a printhead on page 68</td>
</tr>
</tbody>
</table>
NOTE: For additional information about the ink system, see Handle the ink system on page 57.

**Task 4: Handle print jobs**

After checking ink consumables and paper levels, you can send the job to the printer. On the screen preview, make adjustments for paper type, print size, number of copies and nesting as necessary. You can then move the job to the RIP queue.

The table below identifies sections of this user’s guide which will help you to quickly find information on handling print jobs.

<table>
<thead>
<tr>
<th>Table A-3  Handle print jobs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Elements</td>
</tr>
<tr>
<td>Submit a job</td>
</tr>
<tr>
<td>Check ink and paper usage for a job</td>
</tr>
<tr>
<td>Cancel a job</td>
</tr>
<tr>
<td>Manage the print queue</td>
</tr>
</tbody>
</table>

**NOTE:** To improve color consistency between prints or from one printer to another, consider performing a color calibration. For more information on color calibration, see Color calibration on page 101.

**Task 5: Adjust printed images**

Check the quality of the prints. The table below identifies sections of this user’s guide which will help you to quickly find information on adjusting printed images.

<table>
<thead>
<tr>
<th>Table A-4  Handle the ink system</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Elements</td>
</tr>
<tr>
<td>Select print quality</td>
</tr>
<tr>
<td>Select paper size</td>
</tr>
<tr>
<td>Select margins options</td>
</tr>
<tr>
<td>Rescale a print</td>
</tr>
<tr>
<td>Change the treatment of overlapping lines</td>
</tr>
<tr>
<td>Print in grayscale</td>
</tr>
<tr>
<td>Print crop lines</td>
</tr>
<tr>
<td>Rotate or autorotate an image</td>
</tr>
<tr>
<td>Select the color emulation mode</td>
</tr>
</tbody>
</table>
**Table A-4  Handle the ink system (continued)**

<table>
<thead>
<tr>
<th>Task Elements</th>
<th>See this section of the user’s guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>Troubleshooting</td>
<td>See this section of the guide</td>
</tr>
</tbody>
</table>

I am experiencing print quality problems  See **Troubleshoot print-quality issues on page 144**.

**NOTE:** For additional information about adjusting printed images, see **Print options on page 80**.

**NOTE:** For additional information about unloading a roll from the take-up reel after printing, see **Unload a roll from the take-up reel on page 43**.
In this scenario, the print service provider (PSP) receives an urgent walk-in order which requires delivery in less than two hours. The printer is currently printing and there are jobs in the queue, however, the new job has the highest priority. It also requires different paper than what is currently in the printer.

**NOTE:** The new job is a repeat order for which the digital content already exists within the ripped files storage.

The following information describes the necessary tasks to successfully execute an urgent walk-in job.

### Task 1: Handle the digital content

The following steps will help you to successfully handle the digital content.

1. Find the digital content on the RIP workstation.
2. Open the PDF file in Adobe Acrobat.
3. Ensure you have all the necessary information to submit the job, including fonts and high-resolution images.
4. Check the orientation, margins, typography, color and resolution to ensure that there are no printing or finishing inconsistencies.

**NOTE:** Ensure the job can be completed and delivered on time given the current workload and the paper and ink supplies.

### Task 2: Handle print jobs

Due to the urgent nature of the new walk-in job, you are required to interrupt the current jobs in the print queue. The following steps will help you to handle the print jobs.

1. Pause the queue. See *Pause the job queue on page 114*.
2. Move the new job to the top of the queue.
3. Adjust the new job settings for productivity, paper type, print size, number of copies and nesting as necessary.
4. Cancel the job currently in the printer when the last image is completed.

**NOTE:** Resume the queue only after handling the paper and ink system. Once the new job is done, remember to pause the queue again to avoid printing the queued jobs on the wrong paper.

The table below identifies sections of this user’s guide which will help you to quickly find information on handling print jobs.
Table B-1  Handle print jobs

<table>
<thead>
<tr>
<th>Task Elements</th>
<th>See this section of the user’s guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>Submit a job</td>
<td>See <a href="#">Create a print job on page 81</a></td>
</tr>
<tr>
<td>Cancel a job</td>
<td>See <a href="#">Delete a job from the queue on page 115</a></td>
</tr>
<tr>
<td>Manage the print queue</td>
<td>See <a href="#">Job queue management on page 112</a></td>
</tr>
<tr>
<td><strong>Troubleshooting</strong></td>
<td><strong>See this section of the guide</strong></td>
</tr>
<tr>
<td>I can’t access the Embedded Web Server</td>
<td><a href="#">Cannot access the Embedded Web Server on page 171</a></td>
</tr>
</tbody>
</table>

**NOTE:** To improve color consistency between prints or from one printer to another, consider performing a color calibration. For more information on color calibration, see [Color calibration](#) on page 101.

Task 3: Handle the paper

The new job requires different paper than the job that was interrupted. The following steps will help you to handle the paper.

1. Remove the printed output from the printer and annotate what the remainder of the job.
2. Unload the currently loaded paper.
3. Load the correct paper for the new job.

**NOTE:** To improve color consistency between prints, or from one printer to another, consider performing a color calibration. For more information on color calibration, see [Color calibration](#) on page 101.

The table below identifies sections of this user’s guide which will help you to quickly find information on handling paper.

Table B-2  Handle the paper

<table>
<thead>
<tr>
<th>Task Elements</th>
<th>See this section of the user’s guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unload paper</td>
<td>See <a href="#">Unload a roll from the printer on page 37</a></td>
</tr>
<tr>
<td>Unload a roll from the take-up reel</td>
<td><a href="#">Unload a roll from the take-up reel on page 43</a></td>
</tr>
<tr>
<td>Load paper</td>
<td>See <a href="#">Load a roll onto the spindle on page 33</a></td>
</tr>
<tr>
<td>Load a roll onto the take-up reel</td>
<td><a href="#">Load a roll onto the take-up reel on page 38</a></td>
</tr>
<tr>
<td>Check the paper preset</td>
<td>See <a href="#">View information about the paper on page 46</a></td>
</tr>
<tr>
<td>Perform color calibration</td>
<td>See <a href="#">Color calibration on page 101</a></td>
</tr>
<tr>
<td><strong>Troubleshooting</strong></td>
<td><strong>See this section of the guide</strong></td>
</tr>
<tr>
<td>I can’t load the paper</td>
<td>See <a href="#">The paper cannot be loaded successfully on page 160</a></td>
</tr>
<tr>
<td>I can’t find the paper preset for my paper</td>
<td><a href="#">Download paper presets on page 47</a> and <a href="#">Update the printer firmware on page 138</a></td>
</tr>
<tr>
<td>I don’t have HP paper</td>
<td>See <a href="#">Use non-HP paper on page 48</a> and <a href="#">Supported paper types on page 31</a></td>
</tr>
<tr>
<td>The paper has jammed</td>
<td>See <a href="#">The paper has jammed on page 160</a></td>
</tr>
</tbody>
</table>
Table B-2  Handle the paper (continued)

<table>
<thead>
<tr>
<th>Task Elements</th>
<th>See this section of the user’s guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>The take-up reel paper has jammed</td>
<td>See Take-up reel paper jammed on page 162</td>
</tr>
<tr>
<td>The take-up reel does not wind</td>
<td>See Take-up reel does not wind on page 162</td>
</tr>
</tbody>
</table>

**NOTE:** For additional information about paper, see Handle the paper on page 29.

Task 4: Handle the ink system

Ensure that your printheads are healthy and that ink levels are enough to print all queued jobs. If the ink levels are too low, pause the print queue and replace and align the components as necessary.

The table below identifies sections of this user’s guide which will help you to quickly find information on handling the ink system.

Table B-3  Handle the ink system

<table>
<thead>
<tr>
<th>Task Elements</th>
<th>See this section of the user’s guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check ink cartridge information</td>
<td>See View ink cartridge information on page 77</td>
</tr>
<tr>
<td>Remove an ink cartridge</td>
<td>See Remove an ink cartridge on page 60</td>
</tr>
<tr>
<td>Insert an ink cartridge</td>
<td>See Insert an ink cartridge on page 62</td>
</tr>
<tr>
<td>Check printhead information</td>
<td>See View printhead information on page 78</td>
</tr>
<tr>
<td>Remove a printhead</td>
<td>See Remove a printhead on page 63</td>
</tr>
<tr>
<td>Insert a printhead</td>
<td>See Insert a printhead on page 66</td>
</tr>
<tr>
<td>Align printheads</td>
<td>See Align the printheads on page 71</td>
</tr>
<tr>
<td>Remove the maintenance cartridge</td>
<td>See Remove the maintenance cartridge on page 74</td>
</tr>
<tr>
<td>Insert the maintenance cartridge</td>
<td>See Insert the maintenance cartridge on page 76</td>
</tr>
</tbody>
</table>

**Troubleshooting**

<table>
<thead>
<tr>
<th>See this section of the guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>I cannot access the Embedded Web Server</td>
</tr>
<tr>
<td>I cannot insert an ink cartridge</td>
</tr>
<tr>
<td>I cannot insert a printhead</td>
</tr>
<tr>
<td>The printer will not recognize the printhead</td>
</tr>
</tbody>
</table>

**NOTE:** For additional information about the ink system, see Handle the ink system on page 57.

Task 5: Adjust printed images

Check the quality of the prints. The table below identifies sections of this user’s guide which will help you to quickly find information on adjusting printed images.
## Table B-4 Handle the ink system

<table>
<thead>
<tr>
<th>Task Elements</th>
<th>See this section of the user’s guide</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select print quality</td>
<td>See <a href="#">Select print quality on page 82</a></td>
</tr>
<tr>
<td>Select paper size</td>
<td>See <a href="#">Select paper size on page 84</a></td>
</tr>
<tr>
<td>Select margins options</td>
<td>See <a href="#">Select margins options on page 85</a></td>
</tr>
<tr>
<td>Rescale a print</td>
<td>See <a href="#">Rescale a print on page 86</a></td>
</tr>
<tr>
<td>Change the treatment of overlapping lines</td>
<td>See <a href="#">Change the treatment of overlapping lines on page 88</a></td>
</tr>
<tr>
<td>Print in grayscale</td>
<td>See <a href="#">Print in gray shades on page 91</a></td>
</tr>
<tr>
<td>Print crop lines</td>
<td>See <a href="#">Print crop lines on page 89</a></td>
</tr>
<tr>
<td>Rotate or autorotate an image</td>
<td>See <a href="#">Rotate an image on page 89</a> and <a href="#">Autorotate on page 90</a></td>
</tr>
<tr>
<td>Select the color emulation mode</td>
<td>See <a href="#">Color emulation modes on page 108</a></td>
</tr>
<tr>
<td><strong>Troubleshooting</strong></td>
<td><strong>See this section of the guide</strong></td>
</tr>
<tr>
<td>I am experiencing print quality problems</td>
<td>See <a href="#">Troubleshoot print-quality issues on page 144</a></td>
</tr>
</tbody>
</table>

**NOTE:** For additional information about adjusting printed images, see [Print options on page 80](#).
This appendix lists and explains the options in the front-panel menu system.

**NOTE:** Firmware updates may introduce changes to the menu system, in which case this appendix will become out of date in some respects.

To print a more graphical and up-to-date diagram of the front-panel menus, go to the front panel and select the icon, then **User information prints > Print menu map**.

- **Paper menu**
- **Job management menu**
- **Ink menu**
- **Setup menu**
- **Image quality maintenance menu**
- **Connectivity menu**
- **Internal prints menu**
- **Information menu**

**Key to table notations**

[E] available also in the Embedded Web Server

[J] depends on the state of the job queue or of the selected job

[P] available only with the PostScript/PDF upgrade
Paper menu

<table>
<thead>
<tr>
<th>Paper load</th>
<th>Load roll</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Load take-up reel</td>
</tr>
<tr>
<td></td>
<td>Learn how to load spindle</td>
</tr>
<tr>
<td>Paper unload</td>
<td>Unload roll</td>
</tr>
<tr>
<td></td>
<td>Unload take-up reel</td>
</tr>
<tr>
<td>View loaded paper</td>
<td></td>
</tr>
<tr>
<td>Change active paper type</td>
<td>(select paper category and type)</td>
</tr>
<tr>
<td>Paper types list</td>
<td>(select paper category and type)</td>
</tr>
<tr>
<td></td>
<td>View paper details</td>
</tr>
<tr>
<td>Move paper</td>
<td></td>
</tr>
<tr>
<td>Take-up reel</td>
<td>Enable take-up reel</td>
</tr>
<tr>
<td></td>
<td>View information</td>
</tr>
</tbody>
</table>

**Load roll** and **Load take-up reel** display illustrations of the loading process. These options are locked if paper is already loaded.

**Learn how to load spindle** displays an animation.

**Unload roll** and **Unload take-up reel** display illustrations of the unloading process. These options are locked if no paper is loaded.

**View loaded paper** shows information about the loaded paper. The information shown is Status, Paper vendor, Paper type, Width, Length, Color calibration.

**Change active paper type** displays a list of paper types from which you can choose. This option is locked if no paper is loaded.

**Paper types list** displays a list of installed paper types, grouped by category, each of which you can view or delete. **View paper details** will display the Paper type, Category, Vendor, Erasable status and Revision of the selected paper type.

**Move paper** displays an interactive dialogue for moving the paper backwards and forwards. This option is locked if no paper is loaded.
Job management menu

Reprint last job

Pause (or Resume) printing

Job queue

<table>
<thead>
<tr>
<th>Queue is empty [J]</th>
</tr>
</thead>
<tbody>
<tr>
<td>(select job) [J]</td>
</tr>
</tbody>
</table>

View information
Continue
Move to front
Copies
Reprint
Cancel
Delete

**Job queue** displays the jobs in the job queue. Jobs remain in the queue after being printed.

**View information** displays the following information about the selected job: Name, Status, Date, Printed copies and Pages.

**Continue** releases for printing a job that is on hold.

**Move to front** moves the selected job to the front of the queue, so that it will be printed as soon as the current job finishes.
## Ink menu

<table>
<thead>
<tr>
<th>Menu Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>View ink levels</td>
</tr>
<tr>
<td>View printhead status</td>
</tr>
<tr>
<td>Replace ink cartridges</td>
</tr>
<tr>
<td>Replace printheads</td>
</tr>
<tr>
<td>Replace maintenance ctg.</td>
</tr>
<tr>
<td>Replace ink absorber</td>
</tr>
<tr>
<td>Ink cartridge information</td>
</tr>
<tr>
<td>Printhead information</td>
</tr>
<tr>
<td>Maintenance cartridge information</td>
</tr>
<tr>
<td>Ink absorber information</td>
</tr>
<tr>
<td>Clean encoder strip</td>
</tr>
</tbody>
</table>

**View ink levels** displays the ink levels of all cartridges in the printer. A blinking cartridge in the display indicates warns you that the ink level is low.

**View printhead status** displays the warranty or health status of all printheads in the printer. If the printhead is still under warranty, the word WARRANTY is shown, otherwise the health status is shown.

**View (color) ink cartridge** displays the following information about the selected ink cartridge: Color, Product name, Product number, Serial number, Status, Ink level (ml), Capacity (ml), Expiration date, Manufacturer and Warranty status.

**View (colors) printhead** displays the following information about the selected printhead: Color, Product name, Product number, Serial number, Status, Ink fired (ml) and Warranty status.

**Maintenance cartridge information** displays the following information about the maintenance cartridge: Status, Level (%) and Product number.
## Setup menu

<table>
<thead>
<tr>
<th>Setting</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Printing preferences</strong></td>
<td></td>
</tr>
<tr>
<td>Select graphics language</td>
<td>[E]</td>
</tr>
<tr>
<td><strong>Print quality</strong></td>
<td></td>
</tr>
<tr>
<td>Select quality level</td>
<td></td>
</tr>
<tr>
<td>Enable maximum detail</td>
<td></td>
</tr>
<tr>
<td>Enable EconoMode</td>
<td></td>
</tr>
<tr>
<td><strong>Color options</strong></td>
<td></td>
</tr>
<tr>
<td>Color/Grayscale</td>
<td></td>
</tr>
<tr>
<td>Select RGB source profile</td>
<td></td>
</tr>
<tr>
<td>Emulate printer</td>
<td></td>
</tr>
<tr>
<td>Select CMYK source profile</td>
<td>[P]</td>
</tr>
<tr>
<td>Select rendering intent</td>
<td>[P]</td>
</tr>
<tr>
<td>Black point compensation</td>
<td>[P]</td>
</tr>
<tr>
<td>HP PANTONE® emulation</td>
<td>[P]</td>
</tr>
<tr>
<td><strong>Paper options</strong></td>
<td></td>
</tr>
<tr>
<td>Select paper size</td>
<td></td>
</tr>
<tr>
<td>Remove top/bottom blanks</td>
<td></td>
</tr>
<tr>
<td>Resize</td>
<td></td>
</tr>
<tr>
<td>Rotate</td>
<td></td>
</tr>
<tr>
<td>Enable mirror image</td>
<td></td>
</tr>
<tr>
<td>Enable crop lines</td>
<td></td>
</tr>
<tr>
<td>Enable printing paper info</td>
<td></td>
</tr>
<tr>
<td><strong>Margins</strong></td>
<td></td>
</tr>
<tr>
<td>Select margins</td>
<td></td>
</tr>
<tr>
<td>Select margins layout</td>
<td>[E]</td>
</tr>
<tr>
<td><strong>HP-GL/2 options</strong></td>
<td></td>
</tr>
<tr>
<td>Select palette</td>
<td></td>
</tr>
<tr>
<td>Define palette</td>
<td></td>
</tr>
<tr>
<td>Enable merge</td>
<td></td>
</tr>
<tr>
<td><strong>PS options</strong></td>
<td></td>
</tr>
<tr>
<td>Select encoding</td>
<td></td>
</tr>
<tr>
<td>Select altitude</td>
<td></td>
</tr>
<tr>
<td><strong>Print retrieval</strong></td>
<td></td>
</tr>
<tr>
<td>Select drying time</td>
<td></td>
</tr>
<tr>
<td>Enable cutter</td>
<td></td>
</tr>
<tr>
<td>Job management options</td>
<td>Enable queue [E]</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td></td>
<td>When to start printing [E]</td>
</tr>
<tr>
<td>Nest options</td>
<td>Enable nesting [E]</td>
</tr>
<tr>
<td></td>
<td>Select wait time</td>
</tr>
<tr>
<td></td>
<td>Enable crop lines [E]</td>
</tr>
<tr>
<td></td>
<td>Oversize nested job margin</td>
</tr>
<tr>
<td>Autorotate</td>
<td></td>
</tr>
<tr>
<td>Max. number of printed jobs [E]</td>
<td></td>
</tr>
<tr>
<td>Select job recovery mode</td>
<td></td>
</tr>
<tr>
<td>Paper mismatch action</td>
<td></td>
</tr>
<tr>
<td>Front panel options</td>
<td>Select language</td>
</tr>
<tr>
<td></td>
<td>Select display contrast</td>
</tr>
<tr>
<td></td>
<td>Enable buzzer</td>
</tr>
<tr>
<td></td>
<td>Select units [E]</td>
</tr>
<tr>
<td>Date and time options</td>
<td>View current device time [E]</td>
</tr>
<tr>
<td></td>
<td>Set date [E]</td>
</tr>
<tr>
<td></td>
<td>Set time [E]</td>
</tr>
<tr>
<td></td>
<td>Set time zone [E]</td>
</tr>
<tr>
<td>Enable sleep mode</td>
<td></td>
</tr>
<tr>
<td>Sleep mode wait time</td>
<td></td>
</tr>
<tr>
<td>Resets</td>
<td>Reset encoder cleaning</td>
</tr>
<tr>
<td></td>
<td>Restore factory settings</td>
</tr>
<tr>
<td>External hard disk</td>
<td>Install (or Uninstall) external hard disk</td>
</tr>
<tr>
<td>Accessories</td>
<td>Duplexer Install duplexer</td>
</tr>
<tr>
<td></td>
<td>Other accessories Install other accessories</td>
</tr>
</tbody>
</table>

Enable crop lines appears in two places in the menu: under Paper options (which applies to individual jobs) and under Nest options (which applies to nested jobs). The default value is Off in both cases.

Select palette allows you to choose between Software, Palette A, Palette B and Factory.

Define palette allows you to define the Palette A, Palette B and Factory palettes. To do so, select one of the pens, between 0 and 15, after which you can change the width or color of the pen. The width can vary from 0.13 mm (0.0051 in) to 12.0 mm (0.47 in) and the color can vary from 0 to 255.

Manual drying time allows you to choose a drying time from 1 to 1800 s. The default value is 100 s.

Enable nesting allows you to choose between Off, In order and Optimized order. In order to enable nesting, When to start printing has to be set to After processing.
# Image quality maintenance menu

<table>
<thead>
<tr>
<th>Optimization actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibrate color</td>
</tr>
<tr>
<td>Align printheads</td>
</tr>
<tr>
<td>Print diagnostic image</td>
</tr>
<tr>
<td>Paper advance calibration</td>
</tr>
<tr>
<td>Calibrate paper advance</td>
</tr>
<tr>
<td>Adjust paper advance</td>
</tr>
<tr>
<td>Reset paper advance</td>
</tr>
<tr>
<td>Clean printheads</td>
</tr>
<tr>
<td>Clean all</td>
</tr>
<tr>
<td>Clean (colors)</td>
</tr>
<tr>
<td>Enable color calibration</td>
</tr>
</tbody>
</table>
Connectivity menu

<table>
<thead>
<tr>
<th>Gigabit Ethernet</th>
<th>View information</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>View configuration</td>
</tr>
<tr>
<td></td>
<td>Modify configuration</td>
</tr>
<tr>
<td></td>
<td>Restore factory settings</td>
</tr>
<tr>
<td>USB</td>
<td>View information</td>
</tr>
<tr>
<td>Jetdirect EIO</td>
<td>View information</td>
</tr>
<tr>
<td></td>
<td>View configuration</td>
</tr>
<tr>
<td></td>
<td>Modify configuration</td>
</tr>
<tr>
<td></td>
<td>Restore factory settings</td>
</tr>
<tr>
<td>Advanced</td>
<td>Select I/O timeout</td>
</tr>
<tr>
<td></td>
<td>Allow SNMP</td>
</tr>
<tr>
<td></td>
<td>Embedded Web Server</td>
</tr>
<tr>
<td></td>
<td>Allow EWS</td>
</tr>
<tr>
<td></td>
<td>Reset EWS access control</td>
</tr>
<tr>
<td></td>
<td>Web Services</td>
</tr>
<tr>
<td></td>
<td>Printer utility software</td>
</tr>
<tr>
<td></td>
<td>Color and paper management</td>
</tr>
<tr>
<td></td>
<td>Restore factory settings</td>
</tr>
</tbody>
</table>

**View information** shows whether the interface is installed, whether the IP address is enabled and whether printing is enabled through this interface. It also displays the MAC address.

**View configuration** shows the following information: Link state, IP address, Configuration mode, Subnet mask, Default gateway, mDNS service name and the MAC address.

**Modify configuration** allows you to change the IP address, subnet mask, default gateway and idle timeout. You can also view the host name string and choose an IP address configuration method from BOOTP, DHCP, Auto IP and Manual.

**Printer utility software** allows you to enable or disable the use of the HP Utility.
## Internal prints menu

<table>
<thead>
<tr>
<th>Demo prints</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Print fine arts demo</td>
<td></td>
</tr>
<tr>
<td>Print B&amp;W photo 1</td>
<td></td>
</tr>
<tr>
<td>Print B&amp;W photo 2</td>
<td></td>
</tr>
<tr>
<td>Print Color photo 1</td>
<td></td>
</tr>
<tr>
<td>Print Color photo 2</td>
<td></td>
</tr>
<tr>
<td>Print retail demo 1</td>
<td></td>
</tr>
<tr>
<td>Print retail demo 2</td>
<td></td>
</tr>
<tr>
<td>Print GIS map</td>
<td></td>
</tr>
<tr>
<td>Print GIS aerial photo</td>
<td></td>
</tr>
<tr>
<td>Print drawing demo</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>User information prints</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Print menu map</td>
<td></td>
</tr>
<tr>
<td>Print configuration</td>
<td></td>
</tr>
<tr>
<td>Print usage report</td>
<td></td>
</tr>
<tr>
<td>Print HP-GL/2 palette</td>
<td></td>
</tr>
<tr>
<td>Print PS font list [P]</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Service information prints</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Print current information</td>
<td></td>
</tr>
<tr>
<td>Print usage information</td>
<td></td>
</tr>
<tr>
<td>Print event logs</td>
<td></td>
</tr>
<tr>
<td>Print calibration status</td>
<td></td>
</tr>
<tr>
<td>Print connectivity config.</td>
<td></td>
</tr>
<tr>
<td>Print all pages</td>
<td></td>
</tr>
</tbody>
</table>
Information menu

View printer information displays general printer information including Product name, Product number, Serial number, Service ID, Language, Memory, Disk capacity and Firmware version.
Front-panel error messages

Under certain circumstances, a front-panel error message appears. Follow the advice in the Recommendation column to resolve the error.

If an error message appears on the front panel that is not included in this list, and you are in doubt over the correct response, contact HP Support. See HP Customer Care on page 176.

Table D-1 Text messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Color] cartridge has expired</td>
<td>Replace the cartridge. See Remove an ink cartridge on page 60 and Insert an ink cartridge on page 62.</td>
</tr>
<tr>
<td>[Color] cartridge is missing</td>
<td>Insert a cartridge of the correct color. See Insert an ink cartridge on page 62.</td>
</tr>
<tr>
<td>[Color] printhead #[n] error: not present</td>
<td>Insert the correct printhead. See Insert a printhead on page 66.</td>
</tr>
<tr>
<td>[Color] printhead #[n] error: please remove</td>
<td>Remove the incorrect printhead and insert a new printhead of the correct type (color and number). See Remove a printhead on page 63 and Insert a printhead on page 66.</td>
</tr>
<tr>
<td>[Color] printhead #[n] error: reseat</td>
<td>Remove and reinsert the same printhead, or try cleaning the electrical connections. If necessary, insert a new printhead. See Front panel recommends reseating or replacing a printhead on page 165.</td>
</tr>
<tr>
<td>[Color] printhead #[n] out of warranty</td>
<td>The printhead’s warranty has ended, because of the length of time it has been in operation or because of the volume of ink used. See the Legal Information.</td>
</tr>
<tr>
<td>[Color] printhead #[n] warranty warning</td>
<td>The printhead’s warranty may be invalidated by the use of the wrong kind of ink. See the Legal Information.</td>
</tr>
<tr>
<td>[Warning] internal failure: Unable to create print</td>
<td>The internal print files are not available in the printer. Load the internal print files through the Embedded Web Server.</td>
</tr>
<tr>
<td>Faulty cartridge. Replace [color] cartridge</td>
<td>Replace the cartridge. See Remove an ink cartridge on page 60 and Insert an ink cartridge on page 62.</td>
</tr>
<tr>
<td>IO error</td>
<td>Restart the printer. If the problem persists, contact HP Support. See HP Customer Care on page 176.</td>
</tr>
<tr>
<td>IO warning</td>
<td>Try again; if the problem persists, contact HP Support. See HP Customer Care on page 176.</td>
</tr>
<tr>
<td>PDL Error: Ink system not ready</td>
<td>Clean the printheads. See Clean the printheads on page 165.</td>
</tr>
<tr>
<td>PDL Error: Job clipped</td>
<td>The image is too large for the paper or for the printer. Load larger paper if possible, or reduce the image size.</td>
</tr>
</tbody>
</table>
Table D-1  Text messages (continued)

<table>
<thead>
<tr>
<th>Message</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDL Error: memory full</td>
<td>Restart the printer and try resending the job; if necessary, reduce the complexity of the job.</td>
</tr>
<tr>
<td>PDL Error: out of paper</td>
<td>Load more paper.</td>
</tr>
<tr>
<td>PDL Error: parsing error</td>
<td>The print job is unintelligible to the printer. Try to recreate and resend it. Check your cable connections.</td>
</tr>
<tr>
<td>PDL Error: print mode error</td>
<td>The paper type or print quality specified for the job are incorrect. Change the loaded paper type or the print settings.</td>
</tr>
<tr>
<td>PDL Error: printing error</td>
<td>Try sending the job again.</td>
</tr>
<tr>
<td>PDL Error: virtual memory full</td>
<td>Restart the printer and try resending the job; if necessary, reduce the complexity of the job.</td>
</tr>
<tr>
<td>Replace [color] cartridge</td>
<td>Replace the cartridge. See Remove an ink cartridge on page 60 and Insert an ink cartridge on page 62.</td>
</tr>
<tr>
<td>Reseat [color] cartridge</td>
<td>Remove and reinsert the same cartridge. See Remove an ink cartridge on page 60 and Insert an ink cartridge on page 62.</td>
</tr>
<tr>
<td>Update: failed. Invalid file</td>
<td>Make sure that you have selected the correct firmware update file. Then try again to perform the update.</td>
</tr>
</tbody>
</table>

Under certain circumstances, a front-panel numeric error message appears. Follow the advice in the Recommendation column to resolve the error.

If an error message appears on the front panel that is not included in this list, turn off the printer and then turn it back on. If the problem persists, contact HP Support. See HP Customer Care on page 176.

Table D-2  Numeric error messages

<table>
<thead>
<tr>
<th>Error code</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>26:n.01 (where n = the subject ink cartridge number)</td>
<td>Remove the subject ink cartridge and reinstall it in the printer. If the error persists, replace the subject ink cartridge. If the problem persists, contact HP Support. See HP Customer Care on page 176.</td>
</tr>
<tr>
<td>29:01</td>
<td>The maintenance cartridge is not inserted correctly. Open the maintenance cartridge door on the right side of the printer, make sure that the maintenance cartridge is correctly seated, and then close the door. If the problem persists, replace the maintenance cartridge. If the problem persists, contact HP Support. See HP Customer Care on page 176.</td>
</tr>
<tr>
<td>32:1.01</td>
<td>A take-up reel error has occurred. Make sure that the paper is adequately taped to the take-up reel spindle core, and then make sure that the winding direction is correctly set.</td>
</tr>
<tr>
<td>32:2.01</td>
<td>The take-up reel can not be detected. Make sure that the take-up reel sensor cable is correctly connected.</td>
</tr>
<tr>
<td>Error code</td>
<td>Recommendation</td>
</tr>
<tr>
<td>------------</td>
<td>----------------</td>
</tr>
</tbody>
</table>
| 61:01      | Unsupported file format: the printer cannot process the job. Try the following remedies:  
  - Turn off the printer by using the Power key on the front panel and the power switch at the back of the printer; disconnect the power cord; then reconnect the power cord and turn on the printer.  
  - Make sure that the graphic language setting is correct. See Change the graphic language setting on page 26.  
  - Resubmit the file to the printer.  
  - Check that your printer firmware is up to date. See Update the printer firmware on page 138.  
  If the problem persists, contact HP Support. See HP Customer Care on page 176. |
| 61:04.1    | The PostScript fonts are missing. Install the latest firmware release to reinstall the fonts. See Update the printer firmware on page 138. |
| 61:04.2    | Unrecognized paper type identifier. Install the latest firmware release to reinstall the paper type identifiers. See Update the printer firmware on page 138. |
| 61:08      | The paper type has changed. Please resubmit the job. |
| 61:08.1    | The file cannot be printed because it is password-protected. Please resubmit the job without password protection. |
| 61:08.2    | The job contains format errors or incorrect setting values. Please resubmit the job. |
| 63:04      | An input/output problem has occurred with the network card. Try the following remedies:  
  - Make sure that the network cable is correctly connected to the network card.  
  - Check that your printer firmware is up to date. See Update the printer firmware on page 138.  
  If the problem persists, contact HP Support. See HP Customer Care on page 176. |
| 71:03      | An “out of memory” failure has occurred. Turn off the printer by using the Power key on the front panel and the power switch at the back of the printer; disconnect the power cord; then reconnect the power cord and turn on the printer. |
| 71:08      | Insufficient display list memory. Please resubmit the job with one or more of the following changes: reduce resolution to 300 dpi, select Econofast print mode, select ‘Send Job As Bitmap’ to have the main processing of the print job done by the computer rather than by the printer. |
| 74:01      | An error occurred when uploading the firmware update file. Try the following remedies:  
  - Turn off the printer by using the Power key on the front panel and the power switch at the back of the printer; disconnect the power cord; then reconnect the power cord and turn on the printer.  
  - Try again to upload the firmware update file to the printer. See Update the printer firmware on page 138.  
  If the problem persists, contact HP Support. See HP Customer Care on page 176. |
| 76:03      | The hard disk is full. Use the Embedded Web Server to remove unnecessary files from the printer’s hard disk.  
  If the problem persists, contact HP Support. See HP Customer Care on page 176. |
<table>
<thead>
<tr>
<th>Error code</th>
<th>Recommendation</th>
</tr>
</thead>
</table>
| 77:04      | An Embedded Web Server internal software error has occurred. Try the following remedies:  
  - Turn off the printer by using the Power key on the front panel and the power switch at the back of the printer; disconnect the power cord; then reconnect the power cord and turn on the printer.  
  - Check that your printer firmware is up to date. See Update the printer firmware on page 138.  
  If the problem persists, contact HP Support. See HP Customer Care on page 176. |
| 79         | Firmware error. Try the following remedies:  
  - Turn off the printer by using the Power key on the front panel and the power switch at the back of the printer; disconnect the power cord; then reconnect the power cord and turn on the printer.  
  - Check that your printer firmware is up to date. See Update the printer firmware on page 138.  
  If the problem persists, contact HP Support. See HP Customer Care on page 176. |
| 81:01, 81:03, 86:01 | Open the printer window and make sure that there are no obstacles restricting the movement of the drive roller. If the paper has jammed and is restricting the movement of the drive roller, lift the paper load lever and clear the obstruction. If the problem persists, contact HP Support. See HP Customer Care on page 176. |
E Printer specifications

- Functional specifications
- Physical specifications
- Memory specifications
- Power specifications
- Ecological specifications
- Environmental specifications
- Acoustic specifications
### Functional specifications

**Table E-1  HP 771 ink supplies**

<table>
<thead>
<tr>
<th>Printheads</th>
<th>Matte black/chromatic red, magenta/yellow, light magenta/light cyan, photo black/light gray</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maintenance cartridge</td>
<td>Non-color-specific</td>
</tr>
<tr>
<td>Ink cartridges</td>
<td>Matte black, chromatic red, magenta, yellow, light magenta, light cyan, photo black, light gray</td>
</tr>
</tbody>
</table>

**Table E-2  Paper sizes**

<table>
<thead>
<tr>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>610 mm (24 in)</td>
</tr>
<tr>
<td></td>
<td>1524 mm (60 in)</td>
</tr>
<tr>
<td>Length</td>
<td>420 mm (16.5 in)</td>
</tr>
<tr>
<td></td>
<td>Roll with maximum external diameter of 170 mm (6.7 in)</td>
</tr>
</tbody>
</table>

**Table E-3  Print resolution (using Windows HP-GL/2 driver)**

<table>
<thead>
<tr>
<th>Print quality</th>
<th>Maximum resolution for photo paper</th>
<th>Rendering resolution</th>
<th>Printing resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>1200×1200 (other)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1200×1200 (other)</td>
</tr>
<tr>
<td>Normal</td>
<td>n/a</td>
<td>600×600</td>
<td>600×1200 (HP Premium Instant-dry Photo Gloss, HP Premium Instant-dry Photo Satin, HP Universal Instant-dry Photo Gloss, HP Universal Instant-dry Photo Semi-Gloss, Photo Gloss Paper, Photo Semi-Gloss/Satin Paper, Photo Matte Paper)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1200×1200 (other)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1200×1200 (other)</td>
</tr>
</tbody>
</table>

**Table E-4  Margins**

<table>
<thead>
<tr>
<th>Side margins</th>
<th>5 mm (0.2 in)</th>
</tr>
</thead>
</table>
Table E-4 Margins (continued)

<table>
<thead>
<tr>
<th>Margin (leading edge)</th>
<th>Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top margin</td>
<td>5 mm (0.2 in)</td>
</tr>
<tr>
<td></td>
<td>11.5 mm (0.5 in) (glossy paper)</td>
</tr>
<tr>
<td>Bottom margin (trailing edge)</td>
<td>5 mm (0.2 in)</td>
</tr>
</tbody>
</table>

Table E-5 Mechanical accuracy

±0.1% of the specified vector length or ±0.1 mm (whichever greater) at 23°C (73°F), 50-60% relative humidity, on A0 printing material in Best or Normal mode with HP Matte Film.

Table E-6 Graphic languages supported

<table>
<thead>
<tr>
<th>Printer Model</th>
<th>Supported Languages</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Designjet Z6200 Printer</td>
<td>HP-GL/2, RTL, TIFF, JPEG, CALS G4</td>
</tr>
<tr>
<td>HP Designjet Z6200ps Printer only</td>
<td>Adobe PostScript level 3, PDF 1.5</td>
</tr>
</tbody>
</table>

Physical specifications

Table E-7 Printer physical specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Z6200 1.1m</th>
<th>Z6200 1.5m</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight (including stand)</td>
<td>&lt; 163 kg (359 lb)</td>
<td>&lt; 195 kg (430 lb)</td>
</tr>
<tr>
<td>Width</td>
<td>&lt; 1990 mm (78.3 in)</td>
<td>&lt; 2450 mm (96.5 in)</td>
</tr>
<tr>
<td>Depth (without take-up reel)</td>
<td>&lt; 700 mm (27.6 in)</td>
<td>&lt; 700 mm (27.6 in)</td>
</tr>
<tr>
<td>Height (with take-up reel)</td>
<td>&lt; 860 mm (33.9 in)</td>
<td>&lt; 860 mm (33.9 in)</td>
</tr>
<tr>
<td>Height</td>
<td>≈ 1370 mm (53.9 in)</td>
<td>≈ 1370 mm (53.9 in)</td>
</tr>
</tbody>
</table>

Memory specifications

Table E-8 Memory specifications

<table>
<thead>
<tr>
<th>Memory Type</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z6200 memory (DRAM)</td>
<td>1024MB</td>
</tr>
<tr>
<td>Z6200ps memory (DRAM)</td>
<td>1536MB</td>
</tr>
<tr>
<td>Hard disk</td>
<td>160GB</td>
</tr>
<tr>
<td>External hard disk accessory</td>
<td>160GB</td>
</tr>
</tbody>
</table>

Power specifications

Table E-9 Printer power specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>100 – 127 Vac / 220 – 240 Vac ±10%, autoranging</td>
</tr>
<tr>
<td>Frequency</td>
<td>50–60 Hz</td>
</tr>
</tbody>
</table>
Table E-9  Printer power specifications (continued)

<table>
<thead>
<tr>
<th>Current</th>
<th>&lt; 4 A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consumption</td>
<td>350W maximum</td>
</tr>
</tbody>
</table>

Ecological specifications

This product complies with European Union WEEE and RoHS Directives.

ENERGY STAR and the ENERGY STAR mark are registered U.S. marks To determine the ENERGY STAR® qualification status of these product models. See: http://www.hp.com/go/energystar.

For up-to-date ecological specifications of your printer, please go to http://www.hp.com/ and search for “ecological specifications”.

Environmental specifications

Table E-10  Printer environmental specifications

<table>
<thead>
<tr>
<th>Relative humidity range for best print quality</th>
<th>20–80%, depending on paper type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature range for best print quality</td>
<td>15 to 30°C (59 to 86°F), depending on paper type</td>
</tr>
<tr>
<td>Temperature range for printing</td>
<td>5 to 40°C (41 to 104°F)</td>
</tr>
<tr>
<td>Temperature range when not in operation</td>
<td>-20 to +55°C (-4 to +131°F)</td>
</tr>
<tr>
<td>Maximum altitude when printing</td>
<td>3000 m (9850 ft)</td>
</tr>
</tbody>
</table>

**Note:** If the printer or ink cartridges are moved from a cold location to a warm and humid location, water from the atmosphere can condensate on the printer parts and cartridges and can result in ink leaks and printer errors. In this case, HP recommends that you wait at least 3 hours before turning on the printer or installing the ink cartridges, to allow the condensate to evaporate.

Acoustic specifications

Table E-11  Printer acoustic specifications

<table>
<thead>
<tr>
<th>Idle sound power</th>
<th>≤ 5.8 B (A)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating sound power</td>
<td>≤ 7.0 B (A)</td>
</tr>
<tr>
<td>Idle sound pressure</td>
<td>≤ 41 dB (A)</td>
</tr>
<tr>
<td>Operating sound pressure</td>
<td>≤ 53 dB (A)</td>
</tr>
</tbody>
</table>
Bonjour
Apple Computer's trade name for its implementation of the IETF Zeroconf specification framework, a computer network technology that is used in Apple Mac OS X 10.2 and later. Use it to discover the services that are available on a local area network (LAN). It was originally known as Rendezvous.

Color accuracy
The ability to print colors that match the original image as closely as possible, given the fact that all devices have a limited color gamut and might not be able to match certain colors precisely.

Color consistency
The ability to print the same colors in a particular print job, from print to print and from printer to printer.

Color model
A system of representing colors by numbers. An example of such a system is RGB or CMYK.

Color space
A color model in which each color is represented by a specific set of numbers. Many different color spaces can use the same color model: for instance, monitors generally use the RGB color model, but they have different color spaces, because a particular set of RGB numbers results in different colors on different monitors.

Cutter
A printer component that slides back and forth across the platen to cut the paper.

ESD
ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the cling of clothing. Although controlled static electricity has some useful benefits, uncontrolled electrostatic discharges are one of the main hazards to the electronics products. Therefore, to prevent damage some precautions are needed when setting up the product, or handling ESD sensitive devices. This type of damage may reduce the life expectancy of the device. One way to minimize uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed grounded part of the product (mainly metal parts) before handling ESD sensitive devices (such as the printheads or ink cartridges). Additionally, to reduce the generation of electrostatic charge in your body try to avoid working in a carpeted area, and keep your body movements to a minimum when handling ESD sensitive devices. Also, avoid working in low-humidity environments.

Ethernet
A popular computer networking technology for local area networks.

Firmware
Software that controls your printer’s functionality and is stored semi-permanently in the printer (it can be updated).

Gamut
The range of colors and density values reproducible on an output device, such as a printer or monitor.

HP-GL/2
Hewlett-Packard Graphics Language 2: a language defined by HP to describe vector graphics.

I/O
Input/Output: this term describes the passing of data between one device and another.

ICC
The International Color Consortium, a group of companies that have agreed on a common standard for color profiles.

**Ink cartridge**  
A removable printer component that stores ink of a particular color and provides it to the printhead.

**IP address**  
A unique identifier that identifies a particular node on a TCP/IP network. It consists of four integers separated by dots.

**Jetdirect**  
HP's brand name for its series of print servers that allow a printer to be connected directly to a local area network.

**LED**  
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

**MAC address**  
Media Access Control address: a unique identifier used to identify a particular device on a network. It is a lower-level identifier than the IP address. Thus, a device may have both a MAC address and an IP address.

**Nozzle**  
One of many tiny holes in a printhead through which ink is deposited onto the paper.

**Paper**  
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are pulped, dried and pressed.

**Platen**  
The flat surface within the printer over which the paper passes while it is being printed on.

**Printer driver**  
Software that converts a print job in a generalized format into data suitable for a particular printer.

**Printhead**  
A removable printer component that takes ink of one or more colors from the corresponding ink cartridge(s) and deposits it on the paper, through a cluster of nozzles.

**Rendezvous**  
Apple Computer's original name for its networking software later known as Bonjour.

**Spindle**  
A rod that supports a roll of paper while it is being used for printing.

**TCP/IP**  
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.

**USB**  
Universal Serial Bus: a standard serial bus designed to connect devices to computers.
Symbols/Numerics
16-bit color images 88

A
accessories 143
accounting 118
acoustic specifications 206
adding paper types 48
alerts 175
errors 175
warnings 175
application hangs up 170
ArcGIS 129

B
banding problems 46
bin 162
black and white 91
blank page 155
blurred lines 148
buzzer on/off 24

C
calibration 101
color 101
cannot load paper 160
carriage lubrication 135
Clean the paper advance sensor window 135
clean the platen 133
clean the printer 133
cropped at bottom 155
cropped image 156
color 95
color accuracy 156
between printers 153
PANTONE 153
color adjustment options 105
color calibration 101
color emulation modes 108
color management 104
color management process 100
color profiling 102
communication problems 171
components of Embedded Web Server 10
components of printer 4
configure 25
connect the printer 14
choosing a method 14
Mac OS direct 18
Mac OS network 15
Windows direct 15
Windows networking 14
contrast in front panel 25
crop lines 89
Customer Care 177
Customer Self Repair 179
cutter doesn’t work 162

disk erase 141
distorted print 157
document organization 3
downloading paper presets 47
draft for revision, print 125
draft printing 83
drying time 49
canceling 49
changing 49
overview 31
e
ecological specifications 206
economize 93
on ink 93
on paper 91
Embedded Web Server access 23
cannot access 171
ink and paper usage 118
ink system status 77

job queue 113
job queue; job preview 113
language 23
main components 10
printer usage statistics 118
environmental specifications 206
erase disk 141

features of printer 4
firmware update 138
front panel contrast 25
language 23
units 25
front panel error messages all 199

front panel key
form feed and cut 9
paper loading 8
pause printing 9
view paper information 8

front panel option
adjust paper advance 47
align printheads 72, 167
allow EWS 172
autorotate 90
calibrate color 102
calibrate paper advance 47
can active paper type 31
clean printheads 68
define palette 157
disable printing paper info 50
eulate printer 109
enable buzzer 24
enable crop lines 89
enable merge 88
enable mirror image 157
enable queue 114
form feed and cut 50
ink cartridge information 77
job queue 115
load roll 36
load take-up reel 38
modify configuration 26
optimize print quality 145
optimize suggested actions 146
PANTONE emulation 107
pause printing 114
print diagnostic image 73
print quality 83
printhead information 78
replace ink absorber 139
replace ink cartridges 61
replace maintenance ctg. 75
replace printheads 63
reprint 115
reset paper advance 47
resize 87
rotate 90
select display contrast 25
select drying time 49
select graphics language 26
select I/O timeout 155, 157
select language 23
select palette 157
select paper mismatch action 28
select paper size 85
select units 25
select wait time 93
sleep mode wait time 24
unload roll 37
unload take-up reel 43
view configuration 16
view ink levels 58
view loaded paper 46, 101
view paper details 48
view printhead status 59
when to start printing 114
front view
1.1m printer 5
1.5m printer 6
functional specifications 204
G
glossary 207
graininess 150
graphic languages 205
gray shades 91
H
hard disk specification 205
hold for preview
print job canceled and purged 174
HP Care Packs 178
HP Customer Care 177
HP Installation 178
HP Instant Support 178
HP Professional PANTONE emulation 107
HP Start-Up Kit 177
HP Support 179
HP Utility
access 24
cannot access 174
graphic languages 205
main features 10
HP-GL/2 26
I
image diagnostics print 72
image problems
blank page 155
cropped at bottom 155
cropped image 156
distorted print 157
missing objects 147
overlapping images 157
pen settings ineffective 157
small image 156
unexpected mirror image 157
unexpected rotation 157
unintelligible print 157
ink
economical use of 93
usage 118
ink absorber
change 138
ink cartridge
about 58
cannot insert 165
information 77
inserting 62
maintenance 136
ordering 78
refilling 58
removing 60
specification 204
ink system status 77
ink system tips 60
Instant Support 178
internal prints 11
IP address 23
J
job
create 81
stored 82
submit 81
job queue
delete a job 115
Embedded Web Server 113
find a job 115
job preview; Embedded Web Server 113
pause 114
prioritize a job 115
print a job 115
status messages 116
turn off 114
when to start printing 114
job status 116
K
Knowledge Center 177
L
language 23
line thickness 146
loading paper problems 160
loading roll into printer 36
loading roll onto spindle 33
lubricate the carriage 135
lubricating the platen rollers 172
M
maintenance 136
maintenance cartridge
about 60
inserting 76
removing 74
margins
specification 204
max. resolution 84
mechanical accuracy 205
memory error 172
memory specifications 205
mirror image unexpected 157
misaligned colors 148
models, product 2
move the printer 137
N
nesting 92
network settings 25
O
on/off 11
order
accessories 143
ink cartridges 78
maintenance cartridges 79
paper 50
printheads 79
out-of-memory error 172
overlapping images 157
overlapping lines 88
overnight job scenario 181

P
page size 84
page advance 46, 50
cannot load 160
displaying information 46
economical use of 91
feed and cut 50
mismatch action 28
overview 30
personalize list 27
print on loaded paper 86
printing paper info 49
select type 86
size 84
tips 30, 50
usage 118
paper advance calibration 46
paper jam
take-up reel 162
paper not flat 151
paper presets
downloading 47
paper sizes (max & min) 204
paper types
front panel names 31
supported 31
pen settings ineffective 157
Photoshop
print 123
resize image 121
physical specifications 205
power on/off 11
power specifications 205
preventive maintenance 136
preview a print 87
print a photo with Photoshop 123
print file 81
print job
create 81
ink usage 118
nesting 92
paper usage 118
stored 82
submit 81
print on loaded paper 86
print preview 87
print quality
changing 82
print resolution 204
print-quality problems
banding 149
blurred lines 148
bronzing 150
colors inaccurate 153
general 145
graininess 150
horizontal lines 149
ink marks 151
line thickness 146
misaligned colors 148
paper not flat 151
smudging 151
stepped lines 147
top of print 152
troubleshooting tools 145
warped lines 149
wood-grain appearance 158
printer does not print 170
printer software
Mac OS uninstall 20
Windows direct install 15
Windows network install 14
Windows uninstall 15
printer's main components 4
printer's main features 4
printhead
about 59
align 71, 166
cannot insert 165
clean; purge 165
cleaning 68
cleaning connections 68
information 78
inserting 66
ordering 79
recovery 68
removing 63
reseat, reseat 165
specification 204
printhead cleaner
cannot insert 165
specification 204
printhead drop detector
clean 69
printing paper info 49
Proactive Support 178
product models 2

Q
quality, high 84

R
rear view
1.1m printer 6
1.5m printer 7
refilling ink cartridges 58
reprint a job 115
resize a print 86
resize image with Photoshop 121
resolution 204
roll paper
loading into the printer 36
loading onto the spindle 33
unloading 37
roller lubrication 172
rotating an image 89
rotation unexpected 157

S
safety precautions 2
scale a print 86
scenario
overnight job 181
urgent walk-in job 185
secure disk erase 141
sleep mode wait time 24
slow printing 170
small image 156
smudging 151
software 9
specifications
acoustic 206
ecological 206
environmental 206
functional 204
graphic languages 205
hard disk 205
ink supplies 204
margins 204
mechanical accuracy 205
memory 205
paper size 204
physical 205
power 205
print resolution 204
spectrophotometer 99
squeaky rollers 172
stacking problems in bin 162
statistics
ink cartridge 77
printer usage 118
status 116

ENWW Index 211
stepped lines 147
store the printer 137
stored job 82
submit job 81
support services
  HP Care Packs 178
  HP Customer Care 177
  HP Instant Support 178
  HP Proactive Support 178
  HP Start-up Kit 177
  HP Support 179
  Knowledge Center 177
  product installation 178
  warranty extensions 178
supported papers 31
switch on/off 11

T
take-up reel
doesn’t rewind 162
motor 7
using 37
telephone number 180
turn on/off 11

U
unintelligible print 157
unloading roll from printer 37
urgent walk-in job scenario 185
use the take-up reel 37

W
warped lines 149
warranty extensions 178